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โครงงานวิศวกรรมนีเ้ป็นการศกึษาเพ่ือปรับแก้คา่ความคลาดเคล่ือนของเคร่ืองมือวดัระดบันํา้แบบแรงดนั 

การดําเนินงาน ประกอบด้วย การปรับเทียบเคร่ืองวัดระดบันํา้แบบแรงดนั การศึกษาอิทธิพลของอุณหภูมิและ

ระดบัความลกึนํา้ท่ีมีผลกระทบตอ่ความแม่นยําของข้อมลูท่ีวดัได้จากเคร่ืองวดัระดบันํา้แบบแรงดนั  2 ย่ีห้อ คือ  

ย่ีห้อ SIEMENS  รุ่น  MPS  และ ย่ีห้อ OTT รุ่น CTD การทดสอบอิทธิพลของอณุหภมิูทําการทดลองกบั

ถงัอะคริลิคท่ีมีความสงู 0.5 เมตร ทําการเปล่ียนแปลงอณุหภมิูโดยการเติมนํา้ร้อนและนํา้เย็นและวดัท่ีระดบันํา้

คงท่ี สว่นการทดสอบอิทธิพลของระดบัความลกึนํา้ ทําการทดลองจากถงันํา้ท่ีมีความสงู 12 เมตร ทดสอบในช่วง

ความลกึ 0.5, 1.0, 1.5, 2.0, 2.5, 3.0, 3.5, 4.0, 4.5, 5.0, 5.5, 6.0 เมตร และวดัท่ีอณุหภมิูคงท่ีหรือช่วงเวลา

เดียวกนัหลาย ๆช่วงเวลา จะได้คา่ความลกึและอณุหภมิูท่ีแตกตา่งกนั จากนัน้นํามาวิเคราะห์เพ่ือหาสมการความ

คลาดเคล่ือน  

ผลการทดลองเปรียบเทียบเคร่ืองวดัระดบันํา้ ปรากฏว่า เคร่ืองวดัระดบันํา้แบบแรงดนั ย่ีห้อ SIEMENS  

รุ่น  MPS series  ความคลาดเคล่ือนของระดบันํา้ท่ีวดัได้มีแนวโน้มลดลงท่ีอณุหภมิูสงูขึน้และความคลาดเคล่ือน

มากขึน้เม่ือความลกึเพิ่มขึน้  แสดงให้เห็นว่าอณุหภมิู (T)  และความลกึของนํา้ (Y)   มีผลกระทบตอ่คา่ท่ีอ่านได้

จากตวัเคร่ืองวัดระดบันํา้ เม่ือได้ผลจากการทดลองแล้วจึงนําข้อมูลมาวิเคราะห์  ได้สมการความคลาดเคล่ือน    

คือ E = -0.08793+0.003324T+0.004673Y สว่นผลการทดสอบ เคร่ืองวดัระดบันํา้ ย่ีห้อ OTT  รุ่น  CTD  ระดบั

นํา้ท่ีวดัได้เม่ืออณุหภมิูเปล่ียนมีคา่คงท่ี แตมี่ความคลาดเคล่ือนมากขึน้เม่ือความลกึเพิ่มขึน้ แสดงให้เห็นว่าความ

ลกึของนํา้ (Y) มีผลตอ่คา่ท่ีอ่านได้จากตวัเคร่ือง เม่ือได้ผลการทดลองแล้วจึงนําข้อมลูมาวิเคราะห์ ได้สมการความ

คลาดเคล่ือน คือ E = 0.004Y-0.001 
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Abstract 
Title : Study of Correction of Temperature-Induced errors in Pressure-Type Water Level Gauge 

By : Mr.Panu Buathong 
  Miss.Ninlapat Buranacharern 

Project Advisor   : 

               ……………………………………... 

              (Asst Prof Dr.Ekasit  Kositsakulchai) 

                         ……./………/….…. 

 This senior project studied the correction of errors in pressure-type water level gauge. 
The methodology consisted of the calibration of water level gauge and the study of influence of  
temperature and water depth on accuracy of two  water level gauges: Siemens MPS and OTT CTD.   
The study of temperature influence was conducted on 0.5 m-height acrylic box. Temperature was  
changed by adding hot or cold water at constant water depth. The influence of water depth was  
tested on 12-m height tank, The observed water depth is 0.5,1.0, 1.5, 2.0, 2.5, 3.0, 3.5, 4.0, 4.5, 5.0,  
5.5 and 6.0 m. Temperature was also measured at the same time. Then all observations were  
analyzed in order to develop  the error correction equations.   
 The results show that measurement errors of Siemens MPS  decreased when temperature  
was high,and increased  with depth of water. Therefore, temperature and water depth had effects  
on measurement errors of Siemens MPS. The error correction equation for Siemens MPS was  
E = -0.08793+0.003324T+0.004673Y. For OTT, measurement errors were invariable with temperature,  
but increased with depth of water. Only water depth had effect on measurement errors of OTT.   
The error correction equation for OTT is E = 0.004Y-0.001 
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บทที่  1 

บทนํา 

1.1 บทนํา 

 ในระบบชลประทาน  ท่ีจําเป็นต้องมีการควบคมุระดบันํา้ด้านเหนือนํา้หรือด้านท้ายนํา้ จึงจําเป็นต้องมี
การติดตัง้เคร่ืองวดัระดบันํา้เพ่ือทําการหาค่าระดบันํา้ในแหล่งนํา้นัน้ แล้วนําค่าท่ีได้จากการวดัระดบันํา้นัน้มา
แปลงเป็นค่าปริมาณนํา้ซึ่งเคร่ืองวดัระดบันํา้แบ่งออกได้เป็น 2 ประเภท คือ เคร่ืองวดัระดบันํา้แบบธรรมดา    
และ เคร่ืองวดัระดบันํา้แบบอตัโนมตั ิ

 

 โดยทัง้นี  ้ได้มีการศึกษาและทดสอบขึน้ ซึ่งรวบรวมอยู่ในหนังสือ โครงงานวิศวกรรมชลประทาน       
เร่ือง การทดสอบอิทธิพลของอุณหภูมิต่อเคร่ืองวัดระดับนํา้แบบแรงดัน จากหนังสือเล่มนีทํ้าให้ศึกษาพบว่า      
ในการใช้เคร่ืองวัดระดับนํา้แบบอัตโนมัติ มีค่าท่ีวัดได้จากเคร่ือง กับค่าท่ีวัดได้จากระดับนํา้จริงมีความ
คลาดเคล่ือนเกิดขึน้ และยงัพบว่าบางช่วงเวลาข้อมูลท่ีอ่านได้จากเคร่ืองวัดนํา้แบบแรงดนัมีความไม่แน่นอน  
ทัง้นีห้นงัสือเลม่นีย้งัทําให้ทราบว่าอณุหภมิูอาจมีผลตอ่ข้อมลูจริง แตใ่นการทดสอบยงัมีความสงูของระดบันํา้ไม่
มากพอ ดังนัน้จึงต้องหาสาเหตุว่า อุณหภูมิของนํา้ มีผลต่อข้อมูลท่ีวัดได้ของเคร่ืองวัดระดับนํา้แบบแรงดัน
อย่างไรบ้าง โดยถ้าเรามีค่าความสูงต่างๆ มากพอก็จะทําให้ได้ข้อมูลท่ีมากตามไปด้วย และนําค่าความ  
คลาดเคล่ือนท่ีได้ดงักลา่วมาใช้เป็นข้อมลู เพ่ือหาคา่ในการปรับแก้เคร่ืองวดัระดบันํา้ 

 

 โครงงานวิศวกรรมนี  ้จึงได้ทําการทดสอบปรับเทียบเคร่ืองวัดระดับนํา้ โดยใช้เคร่ืองวัดระดับนํา้        
แบบแรงดนัท่ีมีความสามารถในการวัดอุณหภูมิได้ และทดสอบว่าอุณหภูมิของนํา้มีผลต่อข้อมูลท่ีวัดได้จาก
เคร่ืองวดัแบบแรงดนัอย่างไร เพ่ือหาค่าปรับแก้ในอุณหภูมิแต่ละช่วงของนํา้ท่ีแตกต่างกัน ของการใช้เคร่ืองวดั
ระดบันํา้แบบแรงดนั 

 
 
 
 
 
 
 
 
 
 

 



2 
 

 
1.2 วัตถุประสงค์ 

1. เพ่ือศกึษาวิธีการใช้เคร่ืองวดัระดบัแบบแรงดนั 
2. เพ่ือศกึษาวา่อณุหภมิูมีอิทธิพลตอ่คา่ความคลาดเคล่ือนของเคร่ืองวดัระดบันํา้แบบแรงดนั 
3. เพ่ือศกึษาวา่ระดบันํา้มีอิทธิพลตอ่คา่ความคลาดเคล่ือนของเคร่ืองวดัระดบันํา้แบบแรงดนั 
4. เพ่ือศกึษาคา่ปรับแก้ท่ีเกิดจากความคลาดเคล่ือนของเคร่ืองวดัระดบันํา้แบบแรงดนั    

 
1.3 ขอบเขตการศึกษา 

1. ศกึษาวิธีการใช้เคร่ืองวดัระดบันํา้แบบแรงดนัทัง้ย่ีห้อSIEMENS รุ่น MPS series และ ย่ีห้อ OTT รุ่น CTD 
2. ศกึษาผลกระทบเน่ืองจากอณุหภมิูตอ่เคร่ืองวดัระดบันํา้แบบแรงดนัทัง้สองย่ีห้อ 
3. ศกึษาผลกระทบเน่ืองจากระดบันํา้ตอ่เคร่ืองวดัระดบันํา้แบบแรงดนัทัง้สองย่ีห้อ 
4. ศกึษาหาคา่ปรับแก้คา่ความคลาดเคล่ือนของเคร่ืองวดัระดบันํา้แบบแรงดนัทัง้สองย่ีห้อเพ่ือให้คา่ใกล้ 
    เคียงคา่ระดบันํา้จริงให้มากท่ีสดุ 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



3 
 

บทที่ 2 

การตรวจเอกสาร 

2.1 การตรวจวัดระดับนํา้ในแม่นํา้ 

 การวัดระดับนํา้ในแม่นํา้สามารถวัดได้โดยเทียบกับระดับอ้างอิงท่ีใดท่ีหนึ่ง เช่น การเทียบกับ
ระดบันํา้ทะเลปานกลาง (mean sea level) หรือ เทียบกบัระดบัท้องนํา้ เป็นต้น   
 เคร่ืองมือในการทําการวดัระดบันํา้ มีด้วยกันทัง้หมด 3 ลกัษณะ โดยแบ่งจากหน้าท่ีการใช้งานและ
วิธีการใช้งานของตวัเคร่ือง ซึง่ประกอบไปด้วย 1. เคร่ืองมือวดัระดบันํา้แบบธรรมดา 2. เคร่ืองมือวดัระดบันํา้แบบ
อตัโนมตั ิ3. เคร่ืองมือวดัระดบันํา้สงูสดุ 
 

2.1.1 เคร่ืองมือวัดระดับนํา้แบบธรรมดา เป็นเคร่ืองมือวดัระดบันํา้ท่ีติดตัง้อยู่กบัท่ี หรือนําไปตรวจวดั
เป็นครัง้คราว เพ่ือต้องการทราบค่าสงู-ต่ําของระดบันํา้เปรียบเทียบกับจุดคงท่ีใดๆ ขณะท่ีทําการตรวจวดั
โดยปกติจะเปรียบเทียบกบัคา่ระดบันํา้ทะเลปานกลาง (Mean Sea Level : MSL) หรือคา่ รทก. หรือระดบั
สมมติของสถานีนัน้ๆ เคร่ืองมือในการสํารวจระดบันํา้แบบธรรมดา ได้แก่ 1.เคร่ืองวดัระดบันํา้แบบตัง้  
(Vertical  staff gauge) 2. เคร่ืองวดัระดบันํา้แบบเอียง (Slope  gage) 3. เคร่ืองมือวดัระดบันํา้แบบใช้เส้น
ลวดและลกูตุ้มนํา้หนกั (Wire – Weight gauge) 

 
 1) เคร่ืองวดัระดบันํา้แบบตัง้ (Vertical  staff gauge) 

เป็นแผ่นวดัระดบันํา้ชนิดท่ีใช้วดัระดบันํา้ในแนวดิ่ง หรือแนวตัง้ นิยมทําด้วยแผ่นโลหะหรือ
แผ่นเหล็กเคลือบ (Enamel) ขนาดความยาวแผ่นละ 1.00 เมตร กว้าง 0.15 เมตร แบ่ง Scale  
สําหรับอ่านคา่ทกุๆ 1 หรือ 2 ซม. และเน้นระยะอ่านทกุๆ 10  ซม. และให้สีพืน้ของแผ่นแตกตา่ง
จากสีขาวของ Scale โดยเด่นชัดของแผ่นเจาะรูสําหรับติดแผ่นตวัเลขบอกระดบันํา้เป็นเมตร  
ขนาดแผ่นตวัเลขประมาณ 3 ซม. × 10 ซม. ทําด้วยแผ่นโลหะหรือเหล็กเคลือบชนิดเดียวกบัแผ่น
วดัระดบั  

การใช้งาน   

อ่านค่าระดบัในแนวดิ่งท่ีแน่นอน เม่ือเปรียบเทียบกบัคา่ MSL หรือระดบัสมมติของสถานี
นัน้ๆ ทําได้โดยปักเสาบนตลิ่งแม่นํา้ อาจมีคํา้ยนัด้วนถ้าจําเป็นและอ่านคา่ระดบันํา้ได้โดยตรงจาก
แผน่ระดบัท่ีตดิไว้กบัเสา หากไม่สามารถอ่านระดบันํา้ตัง้แตร่ะดบันํา้ต่ําสดุ จนถึงระดบันํา้สงูสดุได้
และในขณะเดียวกนัท่ีระดบันํา้ขึน้สงูยากต่อการอ่าน จะทําการติดตัง้เคร่ืองวดัไว้ ณ จดุตา่งๆ ของ
ลํานํา้ โดยให้เหล่ือมกนัแผน่ละประมาณ 50 เซนตเิมตร ในแนวรูปตดัขวางเดียวกนั  

 

 



4 
 

 

 

 

 

 

 

 
 
 
 
 
 

 
             ภาพที่ 1 เคร่ืองวดัระดบันํา้แบบตัง้ (Vertical  staff gauge) 

 
2) เคร่ืองวดัระดบันํา้แบบเอียง (Slope gauge) 

เป็นแผน่วดัระดบันํา้ท่ีทําการตดิตัง้ตามความลาดของแม่นํา้ลําคลอง โดยเฉพาะท่ีมีความ
ลาดเอียง 1:1.5 จะวดัความสงูของระดบันํา้ ในแนวตัง้ได้ 0.50 เมตร ฉะนัน้จึงต้องติดตัง้ 2 แผ่น 
ต่อกันจึงจะอ่านค่า Scale ในแนวตัง้ได้ 1.00 เมตร ส่วน Scale ท่ีเห็นจะใช้มาตราส่วน 1:1.5     
การใช้งานอ่านค่าระดบัในแนวดิ่งท่ีแน่นอน เม่ือเปรียบเทียบกับค่า MSL หรือระดบัสมมติของ
สถานีนัน้ๆ 

การใช้งาน 

อ่านคา่ระดบัในแนวดิ่งท่ีแน่นอน เม่ือเปรียบเทียบกบัคา่ MSL หรือระดบัสมมติของสถานี
นัน้ๆ เสาระดบันํา้ต้องใช้คนอ่านค่าระดบันํา้ ใช้กบัสถานีในลํานํา้ขนาดใหญ่พอสมควร มีการ
เปล่ียนแปลงของระดบันํา้แต่ละวนัไม่มากนกั มีสภาพลํานํา้ท่ีสามารถจะติดตัง้เสาระดบัได้ และ
ต้องมีคนอยู่อ่านคา่ได้วนัละหลายครัง้ แตม่าตรฐานท่ีใช้อ่านกนั คือ วนัละ 2, 3, 5, 16 และ 24 
เวลา ขึน้กบัวตัถปุระสงค์   
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ภาพที่ 2 เคร่ืองวดัระดบันํา้แบบตัง้ (Slope gauge) 
 

3) เคร่ืองมือวดัระดบันํา้แบบใช้เส้นลวดและลกูตุ้มนํา้หนกั (Wire – Weight gauge)   
เคร่ืองมือวดัระดบันํา้แบบใช้เส้นลวดและลกูตุ้มนํา้หนกั ประกอบด้วยเส้นลวดท่ีมีขีดบอก

ระยะพนัอยูร่อบเพลาหมนุ โดยท่ีปลายเส้นลวดจะมีตุ้มนํา้หนกั เม่ือต้องการวดัระดบันํา้ก็ปลอ่ยตุ้ม
นํา้หนกัลงมาจากระดบัอ้างอิง เช่น ระดบัสะพาน ระดบัตลิง่ หรือ ระดบัอาคาร ท่ีย่ืนเข้าไปในแม่นํา้
ลงมาสัมผัสผิวนํา้ จะสามารถอ่านระยะหย่อนตุ้มนํา้หนักได้ เม่ือนําระดับอ้างอิงลบด้วยระยะ
หยอ่นตุ้มนํา้หนกั จะได้ระดบันํา้ตามต้องการ 

 
 
 
 
 
 
 
 
 
 
 

   
 

 ภาพที่ 3 เคร่ืองมือวดัระดบันํา้แบบใช้เส้นลวดและลกูตุ้มนํา้หนกั (Wire – Weight gauge) 
 

2.1.2 เคร่ืองมือวัดระดับนํา้แบบอัตโนมัติ เป็นเคร่ืองมือท่ีสามารถบนัทกึข้อมลูระดบันํา้ท่ีเปล่ียนแปลง
ตามเวลาได้อย่างตอ่เน่ือง เคร่ืองมือวดัระดบันํา้แบบอตัโนมตัิ ได้แก่ 1. เคร่ืองมือวดัระดบันํา้แบบลกูลอย  
(Floating – gauge recorder) 2. เคร่ืองมือวดัระดบันํา้แบบใช้ฟองอากาศ (Bubble gauge)                     
3. เคร่ืองมือวดัระดบันํา้แบบแรงดนั (Pressure gauge) 
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1) เคร่ืองมือวดัระดบันํา้แบบลกูลอย (Floating – gauge recorder) 
เคร่ืองมือวดัระดบันํา้แบบลกูลอย มกัจะติดตัง้อยู่ในอาคารวดัระดบันํา้ ซึง่มีท่อนํา้เข้าจาก

แม่นํา้เข้ามายงับ่อนํา้น่ิงท่ีมีลกูลอยของเคร่ืองบนัทึกระดบันํา้ลอยตามการขึน้ลงของระดบันํา้ท่ีทํา
การตรวจวดั   

เคร่ืองมือวดัระดบันํา้อตัโนมตัแิบบใช้ทุน่ลอยแบง่ออกเป็นดงันี ้

1.แบบ Richard ’s Type แบบนีมี้กลไกซึ่งการเปล่ียนแปลงของระดบันํา้จะถกูเขียน หรือ

บันทึกลงกระดาษท่ีพันไว้รอบแท่งทรงกระบอกท่ีมีแกนทําให้ทรงกระบอกหมุนในแนวตัง้ด้วย

นาฬิกา โดยการเปล่ียนแปลงของระดบันํา้จะถกูเปล่ียนเป็นการหมุนรอบแกนปากกาท่ีใช้บนัทึก

ระดบันํา้ 

2. แบบ Fuss ’s Type แบบนีมี้กลไกซึ่งการเปล่ียนแปลงของระดบันํา้จะถกูเขียน หรือ

บันทึกลงกระดาษท่ีพันไว้รอบแท่งทรงกระบอกโดยกระดาษท่ีใช้บันทึกระดับนํา้ ถูกยึดติดกับ

ลกูกรอก ซึ่งเคล่ือนท่ีเป็นอัตราส่วนกับการเปล่ียนแปลงของระดบันํา้ เม่ือเปรียบเทียบแบบนีก้ับ 

Richard ‘s Type แล้วจะบนัทกึระดบันํา้ในทิศทางเดียวกนักบัการขึน้ลงของระดบันํา้ ซึง่ทําให้อ่าน

ได้งา่ย และสามารถเลือกช่วงท่ีจะบนัทกึระดบันํา้ได้ 

3. แบบ Roll ’s Type แบบนีมี้กลไกซึ่งการเปล่ียนแปลงของระดบันํา้ท่ีทําให้ลกูรอก
หมนุรอบแกนนัน้ จะถกูสง่ไปโดยเฟืองตวัหนอน โดยปากาจะเคล่ือนท่ีไปในแนวราบและบนัทกึการ
เปล่ียนแปลงของระดับนํา้ ลงบนกระดาษท่ีพันไว้รอบแท่งทรงกระบอกท่ีมีแกนอยู่ในแนวราบ 
Suikin Type ก็รวมอยู่ในแบบนีมี้ปากกา 2 ตวั ตวัหนึ่งมีช่วงบนัทกึระดบันํา้ โดยย่อเหลือ 1 เมตร 
และสามารถบนัทกึกลบัไปกลบัมาได้ในช่วงเวลา 1 เมตร โดยไม่จํากดั ปากกาตวัท่ีสองมีช่วงบนัทกึ
นํา้ถึง 10 เมตร เน่ืองจากการเปล่ียนแปลงของระดบันํา้ถกูบนัทกึไว้ด้วยปากกา 2 ครัง้ จึงสามารถ
บนัทกึระดบันํา้ท่ีมีการเปล่ียนแปลงมากและมีความแม่นยํามากอีกด้วย                                                       

 
 
 
 
 
 

 
 

 

 
ภาพที่ 4 เคร่ืองมือวดัระดบันํา้แบบลกูลอย (Floating – gauge recorder) 
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2) เคร่ืองมือวดัระดบันํา้แบบใช้ฟองอากาศ (Bubble gauge) 
เป็นเคร่ืองมือวัดระดับนํา้สําหรับบางพืน้ท่ีท่ีมีปัญหาตะกอนท่ีไหลปนมากับนํา้ ซึ่งไม่

เหมาะท่ีจะใช้เคร่ืองมือวดัระดบันํา้แบบทุ่นลอยเพราะตะกอนจะไหลเข้าไปอดุตนัในท่อท่ีตอ่เข้าใน
อาคารวดันํา้ จึงใช้เคร่ืองมือวดัระดบันํา้แบบใช้ฟองอากาศ ซึ่งจะใช้ถังบรรจุก๊าซไนโตรเจนแห้ง  
(dry nitrogen) ปล่อยเป็นแรงดนัผ่านท่อท่ีมีปลายใต้ผิวนํา้ ซึ่งความดนัท่ีปลายท่อท่ีปล่อย
ฟองอากาศออกมาจะสามารถแปลงเป็นความสงูนํา้ ทําให้ทราบระดบันํา้ในเคร่ืองบนัทกึได้ 

 
 
 
 

 
 
 

 
 
 
 
 
 
 

 

ภาพที่ 5 เคร่ืองมือวดัระดบันํา้แบบใช้ฟองอากาศ (Bubble gauge) 
 

3) เคร่ืองมือวดัระดบันํา้แบบแรงดนั (Pressure gauge) 
เป็นเคร่ืองมือท่ีอาศยัหลกัการท่ีเม่ือระดบันํา้เปล่ียนแปลง จะทําให้ความกดดนัของนํา้

เปล่ียนแปลง ทําให้ Transducer เปล่ียนแปลงคา่สญัญาณทางไฟฟ้า ของสถานีท่ีทําการตรวจวดั  
จากหลกัการนีทํ้าให้มีการนําไปทํา Transducer ท่ีแตกต่างกนัได้หลายแบบแต่ก็จะมีหลกัการท่ี
นําเอาความกดดนัของนํา้นีม้าแปลงเป็นสญัญาณไฟฟ้า Transducer ของค่าความกดดนัทาง
ไฟฟ้าจะมีหลกัการทํางานท่ีสําคญัอยู่ 2 ประการ คือ ความกดดนัซึ่งจะผนัแปรกับค่าระดบันํา้   
และการแปลงคา่ความกดดนัเป็นคา่สญัญาณทางไฟฟ้า ซึง่คา่สญัญาณทางไฟฟ้านีจ้ะนําไปตอ่เข้า
กับเคร่ืองบันทึกข้อมูลอีกทีหนึ่ง เคร่ืองมือวัดระดับนํา้แบบแรงดัน มีด้วยกันหลายรูปแบบ             
จะแตกตา่งกนัออกไปตามรูปแบบการใช้งานและการออกแบบของบริษัทท่ีทําการผลติ 
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ภาพที่ 6 เคร่ืองมือวดัระดบันํา้แบบแรงดนั (Pressure gauge)                             
ย่ีห้อ  SIEMENS  รุ่น  MPS series (ก), ย่ีห้อ OTT รุ่น CTD (ข) 

 

2.1.3  เคร่ืองมือวัดระดับนํา้สูงสุด (Crest – Stage gauge) 
เคร่ืองมือวดัระดบันํา้สงูสดุประกอบด้วยไม้วดัระดบันํา้ทัว่ไป (Ordinary staff gauge) ท่ีมี

ความกว้างและความยาวท่ีพอเหมาะในการตรวจวัดระดับนํา้สูงสุดในท่อเหล็กอาบสังกะสี ขนาด
เส้นผ่าศนูย์กลางภายใน 2 นิว้ โดยท่อเหล็กอาบสงักะสีจะมีหน้าแปลนท่อท่ีปลายทัง้ 2 ด้าน และมีการ
เจาะรูเลก็ๆ ขนาดเส้นผา่ศนูย์กลาง 0.25 นิว้ หลายๆ รูรอบปลายทอ่ด้านลา่ง 

การติดตัง้เคร่ืองมือวดัระดบันํา้สงูสดุจะเร่ิมจากการนําท่อเหล็กอาบสงักะสีไปติดตัง้ในลํานํา้  
โดยด้านล่างอยู่ท่ีระดบัอ้างอิงของลํานํา้ (Stream datum) หรือระดบัท่ีเทียบกบัระดงัอ้างอิงของลํานํา้
จากนัน้ก็นําไม้วดัระดบันํา้ใส่ลงไปในท่อ แล้วจึงนําเศษไม้ก๊อก (Cork) หรือผงไม้ใส่เข้าไปในท่อเม่ือมี
เหตุการณ์นํา้หลากไหลผ่าน นํา้ในลํานํา้จะไหลเข้าตามรูเล็กๆ ทําให้เศษไม้ก๊อกหรือผงไม้ลอยขึน้      
และไปเกาะท่ีไม้วดัระดบันํา้ ทําให้สามารถอ่านระดบันํา้สงูสดุได้ตามต้องการ และเม่ือต้องการตรวจวดั
ในครัง้ต่อไป ก็ทําได้โดยล้างไม้วดัระดบันํา้ให้สะอาด แล้วนําไม้วดัระดบันํา้และเศษไม้ก๊อกหรือผงไม้   
ใสล่งไปในทอ่เหลก็อาบสงักะสีเพ่ือวดัระดบันํา้สงูสดุตอ่ไปได้ 

 
 
 
 
 
 
 
 
 

 

 

 

 

 

        (ก)             (ข) 



9 
 

 
 
 
 
 
 
 
 
 
 
 

 
 

 

ภาพที่ 7 เคร่ืองมือวดัระดบันํา้สงูสดุ (Crest – Stage gauge) 
 
 
2.2 การเลือกที่ตัง้สถานีวัดนํา้  (Gauging station) 

ข้อมูลอัตราการไหลและระดบันํา้เป็นสิ่งจําเป็นในการทํางานอุทกวิทยา ซึ่งสถานีวดันํา้ท่ีดีต้องมี
ลกัษณะดงัตอ่ไปนี ้

1. การเข้าถึง (accessibility) สถานีวดันํา้ท่ีดีควรมีความสะดวกในการตรวจวดัข้อมลูระดบันํา้  
และอตัราการไหลได้ในทกุสภาพอากาศ ไม่วา่จะเกิดฝนตกหนกั หรือเกิดนํา้ท่วมก็สามารถท่ีจะ
เข้าวดัระดบันํา้ได้โดยไม่มีความขดัข้องเกิดขึน้ 

2. ความเพียงพอ (adequacy) สถานีวดันํา้ควรจะสามารถวดัระดบันํา้และอัตราการไหลได้ท่ี
ระดบัความสงูนํา้ตา่งๆ   

3. การมีเสถียรภาพ (stability) สถานีวัดนํา้ควรจะอยู่ในบริเวณหน้าตัดทางนํา้ท่ีมั่นคง                
มีเสถียรภาพ และไม่เกิดการกดัเซาะหรือการตกตะกอนในลํานํา้ มีความสมัพนัธ์ระหว่างอตัรา
การไหลกบัระดบันํา้คงท่ี หรือไม่เปล่ียนแปลงได้งา่ย และควรจะอยูบ่ริเวณลํานํา้ท่ีไหลตรง 

4. ความถาวร (permanency) สถานีวดันํา้ควรตัง้อยู่ในบริเวณท่ีไม่ถูกรบกวนจากสาเหตใุดๆ      
ท่ีจะมีผลทําให้ข้อมลูผิดพลาดหรือข้อมลูสญูหาย    
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2.3 ข้อมูลเคร่ืองวัดระดับนํา้ใต้ดนิ ย่ีห้อ OTT รุ่น CTD    
 
การตรวจวัดข้อมูลระดับนํา้โดยใช้เคร่ืองวัดระดับนํา้ใต้ดนิ ย่ีห้อ OTT  รุ่น CTD 

 2.3.1 รายละเอียดของระบบการทาํงาน 
   เคร่ืองวดัระดบันํา้ใต้ดินและสภาพการนําไฟฟ้าของนํา้ใต้ดินแบบตอ่เน่ือง ย่ีห้อ OTT รุ่น CTD  

มีคณุสมบตัใิห้การวดัและการบนัทกึของระดบันํา้ใต้ดินท่ีแม่นยํา พร้อมกบัคา่อณุหภมิูและสภาพการนํา
ไฟฟ้า (Conductivity) ของนํา้ใต้ดิน ซึ่งยังสามารถคํานวณแปลงไปเป็นค่าความเค็ม (Salinity)         
และคา่ TDS (Total Dissolved Solids) ได้อีกด้วย โดยขึน้อยูก่บัข้อมลูเฉพาะท่ีต้องการ 

   หวัวดัใช้หลกัการวดัความดนัของคอลมัน์นํา้เหนือระดบัหวัวดั เพ่ือตรวจสอบและคํานวณแปร
ผลไปเป็นในรูปของคา่ระดบันํา้ โดยมีระบบการชดเชยความดนัท่ีถกูออกแบบให้มาพร้อมอยู่ภายในสาย
เคเบิลส่งสัญญาณ เพ่ือให้ค่าท่ีอ่านได้นัน้ สามารถชดเชยความดันอากาศให้กับหัววัดแรงดันนํา้          
ณ เวลาปัจจุบนั จึงช่วยทําให้ลดค่าผิดพลาดจากผลการวดัได้ เน่ืองจากความผนัผวนของความดนัชัน้
บรรยากาศ 

   OTT CTD มีการวดัค่าสภาพการนําไฟฟ้า โดยใช้หวัวดัการนําไฟฟ้าท่ีทําจากกราไฟท์จํานวน    
4  ขัว้อิเลคโทรด พร้อมด้วยหวัวดัคา่อณุหภมิูเพ่ือการชดเชยคา่สภาพนําไฟฟ้าท่ีวดัได้ 

  ขัน้ตอนการ ชดเชยอณุหภมิูในการวดัค่าการนําไฟฟ้า หรือความเค็ม OTT CTD และท่ีใช้อ้างอิงเพ่ือ
การชดเชย วิธีการคํานวณระดบันํา้ สามารถใช้ได้กบัการวดัระดบันํา้ใน 5 ช่วงการวดั ได้แก่ 

 0…4  ม.   คอลมัน์ – นํา้  (0…0.4 บาร์)   

 0…10  ม.   คอลมัน์ – นํา้  (0…1.0 บาร์)   

 0…20  ม.   คอลมัน์ – นํา้  (0…2.0 บาร์)   

 0…40  ม.   คอลมัน์ – นํา้  (0…4.0 บาร์)   

 0…100  ม.   คอลมัน์ – นํา้  (0…10 บาร์)   
OTT CTD  สามารถกําหนดคา่อ้างอิง เพ่ือให้ผลการวดัสามารถออกมาในรูปแบบของคา่ความ

ลกึจากจดุอ้างอิง หรือหากไม่ระบคุา่อ้างอิง คา่ท่ีวดัได้ก็สามารถอ่านเป็นคา่ระดบัของแรงดนัของช่วงการ
วดัได้ 

“OTT CTD Operating program” สําหรับกําหนดการตัง้คา่ระบบการทํางานของ OTT CTD    
ช่วยอํานวยความสะดวก และมีความยืดหยุ่นปรับให้เหมาะสมกับความต้องการท่ีหลากหลายของการ
วดั 

ซอฟต์แวร์นีย้งัสามารถตัง้ค่าขัน้พืน้ฐาน เพ่ือควบคมุการติดต่อส่งผ่านข้อมูล และช่วยให้การ 
ตัง้คา่ทัง้หมดมีการปรับเปล่ียน เพียงภายในหน้าตา่งของโปรแกรมเดียว สามารถควบคมุช่วงการวดัของ
ตวัอยา่ง และยงัสนบัสนนุการทํางานของการทดสอบเคร่ืองสบูนํา้ได้อีกด้วย 
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การเก็บบันทึกค่า ท่ีวัดได้  โดยสามารถดาวน์โหลดผ่านทางอินฟาเรด  อินเตอร์เฟซ             
(IrDA Interface) สําหรับการอ่านข้อมลูแบบไร้สายกบัเคร่ืองคอมพิวเตอร์ด้วยโปรแกรมการดําเนินงาน  
OTT CTD หรือ OTT Hydras 3 หรือ พีดีเอ กบั OTT Hydras 3 พ็อกเก็ต  ร่วมกบัฝาด้านบน OTT ITC  
(อปุกรณ์เสริม) 

การถ่ายโอนข้อมูล จากระยะไกลและกําหนดพารามิเตอร์ท่ีเป็นไปได้ จากระยะไกลผ่านทาง
เครือข่ายโทรศพัท์มือถือ GSM (GSM = ระบบการส่ือสารระดบัโลกสําหรับมือถือ) การถ่ายโอนข้อมลู
จากระยะไกลสามารถเลือกท่ีจะดําเนินการโดยข้อความ SMS หรือการใช้แพ็คเก็ตท่ีมุ่งเน้นบริการ  
GPRS สง่คล่ืนสญัญาณมือถือ (ตามแพ็คเก็ตบริการทัว่ไป) 

OTT CTD มีลกัษณะการติดตัง้โดยวิธีการแขวนไว้ในบ่อสงัเกตการณ์ขนาดเส้นผ่าศนูย์กลาง
ภายในตัง้แต ่1 นิว้ขึน้ไป 

กรณีใช้พลงังานจากแบตเตอร่ีประเภทลเิธียม 1.5 V (ชนิด  AA) จะมีอายกุารใช้งานได้นานกว่า  
5 ปี หรือหากใช้แบตเตอร่ีประเภทอัลคาไลน์จะมีอายุการใช้งานได้ประมาณ 1.5 ปี                     
(ช่วงเวลาเก็บตวัอยา่งทกุๆ 1 ชัว่โมง, ความยาวสายเคเบิล 50 m)   
2.3.2 การเตรียมการตดิตัง้ 

1.  ข้อควรระวงั 
- ควรใช้ประเภทแบตเตอร่ีตามท่ีระบใุนการสัง่ซือ้มา 
- ควรจะใช้แบตเตอร่ีใหม่ทัง้ชดุ ไม่ควรใช้แบตเตอร่ีย่ีห้ออ่ืนๆ ผสมกนั 
- ห้ามใช้แบตเตอร่ีตา่งผู้ผลติมาใช้ร่วมกนั 
- ห้ามใช้แบตเตอร่ีประเภทลเิธียมและอลัคาไลน์ร่วมกนั 
- ควรกําจดั / ทิง้แบตเตอร่ีท่ีเส่ือมแล้วอยา่งถกูวิธี (ไม่ควรรวมไว้ในขยะครัวเรือน) 

2.  แบตเตอร่ีชนิดท่ีเหมาะสม 
ได้แก่ แบตเตอร่ีประเภทลิเธียม หรืออัลคาไลน์ alkaline or lithium design 
(LiFeS;Energizer L91) จํานวน 3 ก้อน ขนาด 1.5 V AA cells (LR6/FR6) 

3.  วิธีการใสแ่บตเตอร่ี ดงัตอ่ไปนี ้
- Slide ท่อครอบของส่วน Communication unit ลงประมาณ 30 ซม. ลงไปใน

ทิศทางของสายเคเบิลด้านหวัวดัแรงดนั โดยยดึสว่นหวั IrDA-Interface ไว้   
- ใสแ่บตเตอร่ี (LR6/FR AA) จํานวน 3 ก้อน ในช่องใสแ่บตเตอร่ี   
- ตรวจสอบให้แน่ใจวา่ใสตํ่าแหน่งขัว้ไฟฟ้าถกูต้อง 
- จากนัน้ให้ใสส่ว่นทอ่ Communication unit กลบัคืนเหมือนเดมิ 
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ข้อแนะนํา 
- การเร่ิมต้นการทํางานของ OTT CTD จะเร่ิมภายหลงัจากใสแ่บตเตอร่ีไม่ก่ีวินาที  

(ไม่มีสวิทซ์เปิด/ปิด โดยตรง) 
- หากจะทําการปิดการทํางานของ OTT CTD ให้ถอดแบตเตอร่ีออก ซึ่งจะช่วย

ป้องกนัแบตเตอร่ีจ่ายพลงังานออกไปโดยสิน้เปลือง และเคร่ืองจะหยดุการบนัทกึ
ข้อมลูใดๆ ท่ีไม่ต้องการตรวจวดั 

- ระบบบนัทกึของ OTT CTD เป็นชนิด non-volatile memory ซึง่จะช่วยป้องกนั
การสญูหายของข้อมูลในขณะเปล่ียนแบตเตอร่ีใหม่ นอกจากนีย้งัสามารถเก็บ
รักษาข้อมลูในช่วงเวลายาวนาน เม่ือทําการถอดแบตเตอร่ีออกเม่ือไม่ใช้งานได้
ด้วย 

- แต่หากมีการใช้เวลานานประมาณ 10 นาที ในการเปล่ียนแบตเตอร่ี เวลาและ
วนัท่ี อาจจําเป็นจะต้องทําการป้อนใหม่อีกครัง้   

- ขอแนะนําให้ทําการเปล่ียนแคปซูล “สารดดูความชืน้” พร้อมทําการเปล่ียน
แบตเตอร่ีใหม่ 

4.   อายกุารใช้งานของแบตเตอร่ี 
กรณีเก็บบนัทกึทกุๆ 1 ชัว่โมง ด้วยความยาวเคเบิล 50 ม. (กรณีไม่ใช้ร่วมกบัOTT  
ITC) 
- แบตเตอร่ีลเิธียม : อยา่งน้อย 5 ปีขึน้ไป 
- แบตเตอร่ีอลัคาไลน์ : อยา่งน้อย 1.5 ปี ขึน้ไป (ประเภทแบตเตอร่ีท่ีมีคณุภาพสงู) 
ข้อแนะนํา 
โปรแกรมการดําเนินงาน OTT CTD มีฟังก์ชัน่การคํานวณ ท่ีกําหนดการแสดงค่า
ระดบัพลงังานท่ีเหลือ (โดยประมาณ) ของแบตเตอร่ีและแสดงประเภทแบตเตอร่ีใน
โปรแกรมด้วย 

5.   วิธีตรวจสอบระดบัแรงดนัไฟฟ้าของแบตเตอร่ี (Battery Life Time) 
- ให้ทําการตัง้คา่เคร่ืองคอมพิวเตอร์ / เช่ือมโยง การส่ือสาร OTT CTD   
- เลือกเมน ู“OTT CTD”, “View Instantaneous Values” ฟังก์ชนั” เพ่ือให้ OTT 

CTD เร่ิมต้นการวดัคา่ ณ ปัจจบุนัทนัที จากนัน้ไปท่ี “The Observer” หน้าจอ
โปรแกรมหลกัจะแสดงคา่กระแสและระดบัพลงังานของแบตเตอร่ี 

- ถ้าหากว่าแรงดนัไฟฟ้าแบตเตอร่ีในปัจจบุนัน้อยกว่า 3.6 - 3.7 โวลต์ ควรทําการ
เปล่ียนแบตเตอร่ีใหม่ 

- จากนัน้คลกิท่ีปุ่ ม “Exit” และปิดโปรแกรมการดําเนินงาน 
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2.3.3 วธีิการตดิตัง้ OTT CTD 
1. กรณีระบบ ความยาว ถึง 100 เมตร 
 การติดตัง้ OTT CTD จะสามารถดําเนินการได้นัน้ จําเป็นจะต้องทราบถึงรูปแบบและปัจจยั

หลกัๆ ของระบบการทํางานก่อน ได้แก่ รูปแบบการวดั อปุกรณ์เสริมท่ีจําเป็น และรูปแบบของ
การติดตัง้ ซึ่งมีความแตกต่างกนัออกไป โดยขึน้อยู่กบัขนาดเส้นผ่าศนูย์กลางของบ่อนํา้ใต้ดิน  
และลกัษณะการออกแบบของฝาปิดด้านบนปากบอ่   

 2. กรณีการตดิตัง้ในบอ่ขนาดเส้นผา่นศนูย์กลาง 1, 2, 3, 4, 5 หรือ 6 นิว้ (โดยใช้แผน่รองอะแดปเตอร์) 
อปุกรณ์ท่ีต้องการ ได้แก่ แหวนอะแดปเตอร์ สําหรับบอ่ขนาดเส้นผา่นศนูย์กลาง 1 นิว้ 

- ติดตัง้แบตเตอร่ีชดุใหม่ พร้อมตรวจสอบสภาพหวัวดั และCalibration ค่าสภาพนํา
ไฟฟ้า 

- เปิดผาครอบบอ่ออก (ถ้ามี) 
- ติดตัง้แผ่นอะแดปเตอร์เข้ากบัปากบ่อขนาด 1 นิว้ โดยมีแหวน O-ring รองด้านใต้

ขอบอะแดปเตอร์กัน้กบัขอบบอ่ไว้ 
- ตรวจสอบความลึกของบ่อและระดบันํา้ ณ ปัจจุบนั ด้วยเคร่ืองวดัระดบันํา้ใต้ดิน

แบบ Contact gauge และทําการจดบนัทกึ เพ่ือตรวจสอบระดบัท่ีต้องการตดิตัง้ 
- จบัสายเคเบิล้แล้วค่อยๆ หย่อนหวัวดัลงในบ่อด้วยความระมดัระวงัป้องกนัมิให้เกิด

การกระแทกของ Pressure probe กบัขอบผิวของบอ่ด้านลา่ง 
- หย่อนสายเคเบิล้ลงไปจนใกล้ถึง Communication unit แล้วให้ทําการยกและปลอ่ย

สายขึน้ – ลง ประมาณ 30 ซม. อย่างเร็วตอ่เน่ืองกนัสกัพกั เพ่ือกําจดัฟองอากาศท่ี
อาจเกาะท่ีหวัวดัได้ 

- จากนัน้ให้หย่อนสายลงไปตอ่จนถึง Communication unit และให้ทําการสอดล็อค
เข้ากบัช่องอะแดปเตอร์ และให้แน่ใจวา่มีการยดึตวัอยา่งพอดีกบัแผน่อะแดปเตอร์ 

- ตรวจสอบคา่ความลกึท่ีวดัได้ ณ ปัจจบุนั และจดบนัทกึ 
- ทําการกําหนดตัง้คา่การทํางานเก็บข้อมลู OTT CTD ใน Operating Program 
- ปิดฝาครอบบอ่ตรวจวดัลงตามเดิมให้มิดชิด (ข้อควรระวงั:  ควรเว้นระยะห่างของฝา

ด้านในกับอินเตอร์เฟส IrDA ไว้เล็กน้อย เพ่ือป้องกันการกระแทกกันขณะปิดฝา
ครอบ) 

  3. การตดิตัง้ในบอ่ขนาดเส้นผา่นศนูย์กลาง 2 นิว้ขึน้ไป (โดยไม่ใช้แผน่รองอะแดปเตอร์) 
อปุกรณ์เสริมท่ีจําเป็น ได้แก่ ฝาครอบด้านบนแบบมีรูเจาะสกรูได้ และตวัยดึชนิดกนัสะเทือน 
คําเตือน: จะต้องมีพืน้ท่ีระยะห่างเพียงพอ ฝาครอบด้านในกับตวัอินเตอร์เฟซ อินฟราเรด IrDA                   

เพ่ือป้องกนัความเสียหาย เม่ือจะทําการปิดของฝาด้านบน 
- ติดตัง้แบตเตอร่ีชดุใหม่ พร้อมตรวจสอบสภาพหวัวดั และCalibration ค่าสภาพนํา

ไฟฟ้า 
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- เปิดฝาครอบบอ่ออก (ถ้ามี) 
- ติดตัง้ฝาครอบพิเศษแบบมีรูเจาะสกรูด้านบนโดยมีแหวน O-ring รองกบัขอบปาก

บอ่ไว้ 
- จากนัน้ตดิตัง้ตวัยดึชนิดกนัสะเทือน โดยสกรูขัน้เข้ากบัฝาครอบพิเศษท่ีขอบปากบอ่ 
- ตรวจสอบความลึกของบ่อและระดบันํา้ ณ ปัจจุบัน ด้วยเคร่ืองวัดระดบันํา้ใต้ดิน

แบบ Contact gauge และทําการจดบนัทกึ เพ่ือตรวจสอบระดบัท่ีต้องการตดิตัง้ 
- จับสายเคเบิล้แล้วค่อยๆ หย่อนหัววัดลงในบ่อ ผ่านช่องของตัวยึดด้วยความ

ระมดัระวงัป้องกนั มิให้เกิดการกระแทกของ Pressure probe กบัขอบผิวของบ่อ
ด้านลา่ง 

- หย่อนสายเคเบิล้ลงไปจนใกล้ถึง Communication unit แล้วให้ทําการยกและปลอ่ย
สายขึน้  - ลง ประมาณ 30 ซม. อย่างเร็วตอ่เน่ืองกนัสกัพกั เพ่ือกําจดัฟองอากาศท่ี
อาจเกาะท่ีหวัวดัได้ 

- จากนัน้ให้หย่อนสายลงไปตอ่จนถึง Communication unit และให้ทําการสอดล็อค
เข้ากบัช่องอะแดปเตอร์ และให้แน่ใจวา่มีการยดึตวัอยา่งพอดีกบัแผน่อะแดปเตอร์ 

- ตรวจสอบคา่ความลกึท่ีวดัได้ ณ ปัจจบุนัและจดบนัทกึ 
- ทําการกําหนดตัง้คา่การทํางานเก็บข้อมลู OTT CTD ใน Operating Program 
- ปิดฝาครอบบอ่ตรวจวดัลงตามเดิมให้มิดชิด (ข้อควรระวงั:  ควรเว้นระยะห่างของฝา

ด้านในกับอินเตอร์เฟส IrDA ไว้เล็กน้อย เพ่ือป้องกันการกระแทกกันขณะปิดฝา
ครอบ) 

- ตรวจสอบความลกึในปัจจบุนั การตดิตอ่ กบัวดั และจดบนัทกึของเคร่ือง 
- กําหนดคา่สําหรับการดําเนินงานด้วย Operating Program 
- ปิดฝาครอบด้านบน 
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2.4 ข้อมูลเคร่ืองวัดระดับนํา้ใต้ดนิ ย่ีห้อ OTT รุ่น Orpheus Mini 
การตรวจวัดข้อมูลระดับนํา้โดยใช้เคร่ืองวัดระดับนํา้ใต้ดนิ ย่ีห้อ OTT รุ่น Orpheus Mini 
2.4.1 รายละเอียดของระบบการทาํงาน 

   เคร่ืองวัดระดบันํา้ใต้ดินและสภาพการนําไฟฟ้าของนํา้ใต้ดินแบบต่อเน่ือง ย่ีห้อ OTT รุ่น  
Orpheus Mini มีคณุสมบตัิให้การวดัและการบนัทกึของระดบันํา้ใต้ดินท่ีแม่นยํา พร้อมกบัคา่อณุหภมิู
ของนํา้ใต้ดนิ   

   หวัวดัใช้หลกัการวดัความดนัของคอลมัน์นํา้เหนือระดบัหวัวดั เพ่ือตรวจสอบและคํานวณแปร
ผลไปเป็นในรูปของคา่ระดบันํา้ โดยมีระบบการชดเชยความดนัท่ีถกูออกแบบให้มาพร้อมอยู่ภายในสาย
เคเบิลส่งสัญญาณ เพ่ือให้ค่าท่ีอ่านได้นัน้สามารถชดเชยความดันอากาศให้กับหัววัดแรงดันนํา้           
ณ เวลาปัจจบุนั จึงช่วยทําให้ลดค่าผิดพลาดจากผลการวดัได้ เน่ืองจากความผนัผวนของ ความดนัชัน้
บรรยากาศ 

   OTT Orpheus Mini สามารถใช้ได้กบัการวดัระดบันํา้ใน 5 ช่วงการวดั ได้แก่ 

 0…4  ม.   คอลมัน์ – นํา้  (0…0.4 บาร์)   

 0…10  ม.   คอลมัน์ – นํา้  (0…1.0 บาร์)   

 0…20  ม.   คอลมัน์ – นํา้  (0…2.0 บาร์)   

 0…40  ม.   คอลมัน์ – นํา้  (0…4.0 บาร์)   

 0…100  ม.   คอลมัน์ – นํา้  (0…10 บาร์)   
OTT Orpheus Mini สามารถกําหนดคา่อ้างอิง เพ่ือให้ผลการวดัสามารถออกมาในรูปแบบของ

ค่าความลึกจากจุดอ้างอิง หรือหากไม่ระบุค่าอ้างอิงค่าท่ีวดัได้ก็สามารถอ่านเป็นค่าระดบัของแรงดนั
ของช่วงการวดัได้ 

“OTT Orpheus Mini Operating program” สําหรับกําหนดตัง้คา่ระบบการทํางานของ OTT 
Orpheus Mini ช่วยให้อํานวยความสะดวก และมีความยืดหยุ่นปรับให้เหมาะสมกบัความต้องการท่ี
หลากหลายของการวดั 

ซอฟต์แวร์นีย้งัสามารถตัง้คา่ขัน้พืน้ฐาน เพ่ือควบคมุการติดตอ่สง่ผ่านข้อมลู และช่วยให้การตัง้
ค่าทัง้หมดมีการปรับเปล่ียน เพียงภายในหน้าต่างของโปรแกรมเดียว สามารถควบคมุช่วงการวดัของ
ตวัอยา่ง และยงัสนบัสนนุการทํางานของการทดสอบเคร่ืองสบูนํา้ได้อีกด้วย 

การเก็บบันทึกค่า ท่ีวัดได้  โดยสามารถดาวน์โหลดผ่านทางอินฟาเรด  อินเตอร์เฟซ                     
(IrDA  Interface) สําหรับการอ่านข้อมลูแบบไร้สายกบัเคร่ืองคอมพิวเตอร์ด้วยโปรแกรมการดําเนินงาน  
OTT Orpheus Mini หรือ OTT Hydras 3 หรือ พีดีเอ กบั OTT Hydras 3 พ็อกเก็ตร่วมกบัฝาด้านบน  
OTT ITC  (อปุกรณ์เสริม) 

การถ่ายโอนข้อมูลจากระยะไกลและกําหนดพารามิเตอร์ท่ีเป็นไปได้จากระยะไกลผ่านทาง
เครือข่ายโทรศพัท์มือถือ GSM (GSM = ระบบการส่ือสารระดบัโลกสําหรับมือถือ) การถ่ายโอนข้อมลู
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จากระยะไกลสามารถเลือกท่ีจะดําเนินการโดยข้อความ SMS หรือการใช้แพ็คเก็ตท่ีมุ่งเน้นบริการ  
GPRS สง่คล่ืนสญัญาณมือถือ (ตามแพ็คเก็ตบริการทัว่ไป) 

OTT Orpheus มีลักษณะการติดตัง้โดยวิธีการแขวนไว้ในบ่อสังเกตการณ์ขนาด
เส้นผา่ศนูย์กลางภายในตัง้แต ่1 นิว้ขึน้ไป 

กรณีใช้พลงังานจากแบตเตอร่ีประเภทลิเธียม 1.5 V (ชนิด AA) จะมีอายกุารใช้งานได้นานกว่า  
5 ปี หรือหากใช้แบตเตอร่ีประเภทอัลคาไลน์จะมีอายุการใช้งานได้ประมาณ 1.5 ปี                     
(ช่วงเวลาเก็บตวัอยา่งทกุๆ : 1  ชัว่โมง , ความยาวสายเคเบิล  50  m)   
2.4.2 การเตรียมการตดิตัง้ 

1.  ข้อควรระวงั 
- ควรใช้ประเภทแบตเตอร่ีตามท่ีระบใุนการสัง่ซือ้มา 
- ควรจะใช้แบตเตอร่ีใหม่ทัง้ชดุ  ไม่ควรใช้แบตเตอร่ีย่ีห้ออ่ืนๆ  ผสมกนั 
- ห้ามใช้แบตเตอร่ีตา่งผู้ผลติมาใช้ร่วมกนั 
- ห้ามใช้แบตเตอร่ีประเภทลเิธียมและอลัคาไลน์ร่วมกนั 
- ควรกําจดั / ทิง้แบตเตอร่ีท่ีเส่ือมแล้วอยา่งถกูวิธี  (ไม่ควรรวมไว้ในขยะครัวเรือน) 

2.  แบตเตอร่ี ชนิด ท่ีเหมาะสม 
ได้แก่ แบตเตอร่ีประเภทลิเธียม หรืออัลคาไลน์ alkaline or lithium design 
(LiFeS;Energizer L91) จํานวน 3 ก้อน ขนาด 1.5 V AA cells (LR6/FR6) 

3.  วิธีการใสแ่บตเตอร่ี ดงัตอ่ไปนี ้
- Slide ท่อครอบของส่วน Communication unit ลงประมาณ 30 ซม. ลงไปใน

ทิศทางของสายเคเบิลด้านหวัวดัแรงดนั โดยยดึสว่นหวั IrDA-Interface ไว้   
- ใสแ่บตเตอร่ี (LR6/FR AA) จํานวน 3 ก้อน ในช่องใสแ่บตเตอร่ี   
- ตรวจสอบให้แน่ใจวา่ใสตํ่าแหน่งขัว้ไฟฟ้าถกูต้อง 
- จากนัน้ให้ใสส่ว่นทอ่ Communication unit กลบัคืนเหมือนเดมิ 
ข้อแนะนํา 
- การเร่ิมต้นการทํางานของ OTT Orpheus Mini จะเร่ิมภายหลงัจากใสแ่บตเตอร่ี

ไม่ก่ีวินาที (ไม่มีสวิทซ์เปิด/ปิด โดยตรง) 
- หากจะทําการปิดการทํางานของ OTT Orpheus Mini ให้ถอดแบตเตอร่ีออก    

ซึง่จะช่วยป้องกนัแบตเตอร่ีจ่ายพลงังานออกไปโดยสิน้เปลือง และเคร่ืองจะหยดุ
การบนัทกึข้อมลูใดๆ ท่ีไม่ต้องการตรวจวดั 

- แต่หากมีการใช้เวลานานประมาณ 10 นาที ในการเปล่ียนแบตเตอร่ี เวลาและ
วนัท่ี อาจจําเป็นจะต้องทําการป้อนใหม่อีกครัง้ 
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4.   อายกุารใช้งานของแบตเตอร่ี 
กรณีเก็บบนัทกึทกุๆ 1ชัว่โมง ด้วยความยาวเคเบิล50 ม.(กรณีไม่ใช้ร่วมกบัOTT  ITC) 
- แบตเตอร่ีลเิธียม: อยา่งน้อย 5 ปี ขึน้ไป 
- แบตเตอร่ีอลัคาไลน์: อยา่งน้อย 1.5 ปี ขึน้ไป (ประเภทแบตเตอร่ีท่ีมีคณุภาพสงู) 

5.   วิธีตรวจสอบระดบัแรงดนัไฟฟ้าของแบตเตอร่ี (Battery Life Time) 
- ให้ทําการตัง้คา่เคร่ืองคอมพิวเตอร์ / เช่ือมโยง การส่ือสาร OTT Orpheus Mini   
- เลือกเมน ู“OTT Orpheus Mini”, “View Instantaneous Values” ฟังก์ชนั”  

เพ่ือให้ OTT Orpheus เร่ิมต้นการวัดค่า ณ ปัจจุบันทันที จากนัน้ไปท่ี           
“The Observer” หน้าจอโปรแกรมหลกัจะแสดงคา่กระแสและระดบัพลงังานของ
แบตเตอร่ี 

- ถ้าหากว่าแรงดนัไฟฟ้าแบตเตอร่ีในปัจจบุนัน้อยกว่า 3.6 - 3.7 โวลต์ ควรทําการ
เปล่ียนแบตเตอร่ีใหม่ 

- จากนัน้คลกิท่ีปุ่ ม “Exit” และปิดโปรแกรมการดําเนินงาน 
2.4.3 วธีิการตดิตัง้ OTT Orpheus Mini 

1. กรณีระบบ ความยาว ถึง 100 เมตร 
 การตดิตัง้ OTT Orpheus Mini จะสามารถดําเนินการได้นัน้ จําเป็นจะต้องทราบถึงรูปแบบและ

ปัจจัยหลักๆ ของระบบการทํางานก่อน ได้แก่ รูปแบบการวัด อุปกรณ์เสริมท่ีจําเป็น และ
รูปแบบของการติดตัง้ ซึ่งมีความแตกต่างกนัออกไป โดยขึน้อยู่กบัขนาดเส้นผ่าศนูย์กลางของ
บอ่นํา้ใต้ดนิ และลกัษณะการออกแบบของฝาปิดด้านบนปากบอ่   

 2. กรณีการติดตัง้ในบ่อขนาดเส้นผ่านศนูย์กลาง 1, 2, 3, 4, 5 หรือ 6 นิว้                     
(โดยใช้แผน่รองอะแดปเตอร์) 
อปุกรณ์ท่ีต้องการ ได้แก่ แหวนอะแดปเตอร์ สําหรับบอ่ขนาดเส้นผา่นศนูย์กลาง 1 นิว้ 

- ติดตั ง้ แบต เตอ ร่ี ชุ ด ใหม่  พ ร้อมตรวจสอบสภาพหัว วัด  และCalibration                  
คา่สภาพนําไฟฟ้า 

- เปิดผาครอบบอ่ออก (ถ้ามี) 
- ติดตัง้แผ่นอะแดปเตอร์เข้ากบัปากบ่อขนาด 1 นิว้ โดยมีแหวน O-ring รองด้านใต้

ขอบอะแดปเตอร์กัน้กบัขอบบอ่ไว้ 
- ตรวจสอบความลึกของบ่อและระดบันํา้ ณ ปัจจุบนั ด้วยเคร่ืองวดัระดบันํา้ใต้ดิน

แบบ Contact gauge และทําการจดบนัทกึ เพ่ือตรวจสอบระดบัท่ีต้องการตดิตัง้ 
- จบัสายเคเบิล้แล้วค่อยๆ หย่อนหวัวดัลงในบ่อด้วยความระมดัระวงัป้องกนัมิให้เกิด

การกระแทกของ Pressure probe กบัขอบผิวของบอ่ด้านลา่ง 
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- หย่อนสายเคเบิล้ลงไปจนใกล้ถึง Communication unit แล้วให้ทําการยกและปลอ่ย
สายขึน้ – ลง ประมาณ 30 ซม. อย่างเร็วตอ่เน่ืองกนัสกัพกั เพ่ือกําจดัฟองอากาศท่ี
อาจเกาะท่ีหวัวดัได้ 

- จากนัน้ให้หย่อนสายลงไปตอ่จนถึง Communication unit และให้ทําการสอดล็อค
เข้ากบัช่องอะแดปเตอร์ และให้แน่ใจวา่มีการยดึตวัอยา่งพอดีกบัแผน่อะแดปเตอร์ 

- ตรวจสอบคา่ความลกึท่ีวดัได้ ณ ปัจจบุนั และจดบนัทกึ 
- ทําการกําหนดตัง้ค่าการทํางานเก็บข้อมลู OTT Orpheus Mini ใน Operating  

Program 
- ปิดฝาครอบบ่อตรวจวดัลงตามเดิมให้มิดชิด (ข้อควรระวงั: ควรเว้นระยะห่างของฝา

ด้านในกับอินเตอร์เฟส IrDA ไว้เล็กน้อย เพ่ือป้องกันการกระแทกกันขณะปิดฝา
ครอบ) 

  3. การตดิตัง้ในบอ่ขนาดเส้นผา่นศนูย์กลาง 2 นิว้ขึน้ไป (โดยไม่ใช้แผน่รองอะแดปเตอร์) 
อปุกรณ์เสริมท่ีจําเป็น ได้แก่ ฝาครอบด้านบนแบบมีรูเจาะสกรูได้ และตวัยดึชนิดกนัสะเทือน 
คําเตือน: จะต้องมีพืน้ท่ีระยะห่างเพียงพอ ฝาครอบด้านในกับตวัอินเตอร์เฟซ อินฟราเรด IrDA     

เพ่ือป้องกนัความเสียหาย เม่ือจะทําการปิดของฝาด้านบน 
- ติดตัง้แบตเตอร่ีชดุใหม่ พร้อมตรวจสอบสภาพหวัวดั และCalibration ค่าสภาพนํา

ไฟฟ้า 
- เปิดฝาครอบบอ่ออก (ถ้ามี) 
- ติดตัง้ฝาครอบพิเศษแบบมีรูเจาะสกรูด้านบนโดยมีแหวน O-ring รองกบัขอบปาก

บอ่ไว้ 
- จากนัน้ตดิตัง้ตวัยดึชนิดกนัสะเทือน โดยสกรูขัน้เข้ากบัฝาครอบพิเศษท่ีขอบปากบอ่ 
- ตรวจสอบความลึกของบ่อและระดบันํา้ ณ ปัจจุบัน ด้วยเคร่ืองวัดระดบันํา้ใต้ดิน

แบบ Contact gauge และทําการจดบนัทกึ เพ่ือตรวจสอบระดบัท่ีต้องการตดิตัง้ 
- จับสายเคเบิล้แล้วค่อยๆ หย่อนหัววัดลงในบ่อ ผ่านช่องของตัวยึดด้วยความ

ระมดัระวงัป้องกนั มิให้เกิดการกระแทกของ Pressure probe กบัขอบผิวของบ่อ
ด้านลา่ง 

- หย่อนสายเคเบิล้ลงไปจนใกล้ถึง Communication unit แล้วให้ทําการยกและปลอ่ย
สายขึน้  - ลง ประมาณ 30 ซม. อย่างเร็วตอ่เน่ืองกนัสกัพกั เพ่ือกําจดัฟองอากาศท่ี
อาจเกาะท่ีหวัวดัได้ 

- จากนัน้ให้หย่อนสายลงไปตอ่จนถึง Communication unit และให้ทําการสอดล็อค
เข้ากบัช่องอะแดปเตอร์ และให้แน่ใจวา่มีการยดึตวัอยา่งพอดีกบัแผน่อะแดปเตอร์ 

- ตรวจสอบคา่ความลกึท่ีวดัได้ ณ ปัจจบุนัและจดบนัทกึ 
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- ทําการกําหนดตัง้คา่การทํางาน เก็บข้อมลู OTT Orpheus ใน Operating Program 
- ปิดฝาครอบบ่อตรวจวดัลงตามเดิมให้มิดชิด (ข้อควรระวงั: ควรเว้นระยะห่างของฝา

ด้านในกับอินเตอร์เฟส IrDA ไว้เล็กน้อย เพ่ือป้องกันการกระแทกกันขณะปิดฝา
ครอบ) 

- ตรวจสอบความลกึในปัจจบุนั การตดิตอ่ กบัวดั และจดบนัทกึของเคร่ือง 
- กําหนดคา่สําหรับการดําเนินงานด้วย Operating Program 
- ปิดฝาครอบ ด้านบน 
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บทที่ 3 

อุปกรณ์และวธีิการ 

3.1 อุปกรณ์ที่ใช้ในการทดสอบ 

 ในการทดลองการศกึษาการปรับแก้ค่าความคลาดเคล่ือนเน่ืองจากอณุหภมิูของเคร่ืองวดัระดบันํา้แบบ

แรงดนัมีอปุกรณ์ท่ีใช้ดงันี ้

1. เคร่ืองวดัระดบันํา้แบบแรงดนั ย่ีห้อ SIEMENS รุ่น MPS series (ภาพท่ี 8) 

2. เคร่ืองวดัระดบันํา้แบบแรงดนั ย่ีห้อ OTT รุ่น CTD (ภาพท่ี 9) 

3. เคร่ือง RTU (Remote Terminal Unit) ย่ีห้อ EMBES รุ่น RTU 800 (ภาพท่ี 10) 

4. แหลง่จ่ายไฟตรง (Power Supply) ย่ีห้อ INTAW รุ่น S-50-12 (ภาพท่ี 11) 

5. OTT CTD Software เม่ือตดิตัง้จะได้โปรแกรม OTT Water Logger Operating Program  

(ภาพท่ี 12) 

6. OTT IrDA Link USB Software และสายเช่ือมตอ่ IrDA  Link USB (ภาพท่ี 13) 

7. กลอ่งอะครีลคิสงู 0.5 เมตร (ภาพท่ี 14) 

8. ถงันํา้สงู 12 เมตร (ภาพท่ี 15) 

9. ไม้บรรทดั (ภาพท่ี 16) 

10. เทอร์โมมิเตอร์ (ภาพท่ี 17) 

11. ปลัก๊ไฟ (ภาพท่ี 18) 

12. แบตเตอร่ี ขนาด AA จํานวน 3 ก้อน (ภาพท่ี 19) 

13. เทปกาว (ภาพท่ี 20) 

14. คอมพิวเตอร์ (ภาพท่ี 21) 
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ภาพที่ 8 เคร่ืองวดัระดบันํา้แบบแรงดนั ย่ีห้อ SIEMENS รุ่น MPS series 

 

 

 
 

ภาพที่ 9 เคร่ืองวดัระดบันํา้แบบแรงดนั ย่ีห้อ OTT รุ่น CTD 
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ภาพที่ 10 เคร่ือง RTU (Remote Terminal Unit) ย่ีห้อ EMBES รุ่น RTU 800 
 

 

ภาพที่ 11 แหลง่จ่ายไฟตรง (Power Supply) ย่ีห้อ INTAW รุ่น S-50-12 
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ภาพที่ 12 โปรแกรม OTT Water Logger Operating Program 

 

 

 

ภาพที่ 13 IrDA Link USB 
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ภาพที่ 14 กลอ่งอะครีลคิสงู 0.5 เมตร 

 

 

 

ภาพที่ 15 ถงันํา้สงู 12 เมตร 

 

 



ภ

ภาพที่ 16 ไ

 

 

ภาพที่ 17 เทอ

 

 

 

ม้บรรทดั 

อร์โมมิเตอร์ 

 

 

255 
 



 

ภาพที่ 19 แ

ภาพที่ 18 

 

 

แบตเตอร่ี ขนา

 

ปลัก๊ไฟ 

าด AA จํานวน

 

น 3 ก้อน 

 

 

266 
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ภาพที่ 20 เทปกาว 

 

 

ภาพที่ 21 คอมพิวเตอร์ 
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3.2 วธีิการทดลอง 

1. นําโพรบทัง้สองย่ีห้อมดัตดิกนัโดยใช้แผน่โฟมคัน่กลาง แล้วใช้เทปกาวพนัโดยรอบ 

2. เช่ือมต่อเคร่ืองวดัระดบันํา้แบบแรงดนั ย่ีห้อ SIEMENS รุ่น MPS series กบัเคร่ือง RTU (Remote 

Terminal Unit) ย่ีห้อ EMBES รุ่น RTU 800 (เม่ือทําการวดัระดบัท่ีมีความลกึตัง้แต ่3 เมตร ขึน้ไปให้

เปล่ียนตวัจ่ายไฟเป็นแหลง่จ่ายไฟตรง (Power Supply) ย่ีห้อ INTAW รุ่น S-50-12) 

 
 

ภาพที่ 22 ตอ่ไฟตรงจากแหลง่จ่ายไฟตรง (Power Supply) ย่ีห้อ INTAW รุ่น S-50-12 เพ่ือจ่ายไฟให้แก่เคร่ือง 
RTU และเคร่ืองวดัระดบันํา้แบบแรงดนัย่ีห้อ SIEMENS รุ่น MPS series 

 

 
 

ภาพที่ 23 ตอ่สาย ACD เพ่ือนําข้อมลูจากเคร่ืองวดัระดบันํา้เข้าเคร่ือง RTU สําหรับอ่านคา่ 
****หมายเหตุ สาย สีฟ้า คือ สายADC , สีดาํ คือ สาย GND (ข้ัว –) และ สีน้ําตาล คือ สาย +12V (ข้ัว +) 
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3. เช่ือมตอ่เคร่ืองวดัระดบันํา้แบบแรงดนั ย่ีห้อ OTT รุ่น CTD กบั OTT IrDA Link USB Software โดย

ใช้ร่วมกบัสายเช่ือมตอ่ IrDA Link USB 

 

ภาพที่ 24 การเช่ือมตอ่สาย IrDA Link USB กบัคอมพิวเตอร์ 

4. ทดลองโดยใช้กลอ่งอะครีลิคสงู 0.5 เมตร หย่อนโพรบทัง้สองย่ีห้อลงในกลอ่งอะครีลิคสงู 0.5 เมตร 
โดยทําการทดลองท่ีความลกึนํา้ 0.3 เมตร (กําหนดระดบัโดยการนําไม้บรรทดัวดัท่ีระดบั 0.3 เมตร) 
และอณุหภมิูอยู่ในช่วงประมาณ 8 ถึง 41 องศาเซลเซียส (เปล่ียนอณุหภมิูโดยการนํานํา้แข็งและนํา้
ร้อนเตมิลงไปเพ่ือให้ได้อณุหภมิูท่ีแตกตา่ง) 
ทดลองโดยใช้ถงันํา้สงู 12 เมตร   (นําเทปกาวพบัรอบสายไฟเพ่ือกําหนดระดบัของโพรบทัง้สองย่ีห้อ
ทกุๆระยะ 0.5 เมตร จนครบ 6 เมตร) หย่อนโพรบทัง้สองย่ีห้อลงในถงันํา้สงู 12 เมตร โดยวดัท่ีระดบั
ความลกึ 0.5, 1.0, 1.5, 2.0, 2.5, 3.0, 3.5, 4.0, 4.5, 5.0, 5.5, 6.0 เมตร ตามลําดบั 

5. บนัทึกค่าของความลกึนํา้ท่ีวดัได้จากเคร่ืองวดัระดบันํา้แบบแรงดนัทัง้สองย่ีห้อ โดยย่ีห้อ SIEMENS 
รุ่น MPS series อ่านได้จากเคร่ือง RTU (Remote Terminal Unit) ย่ีห้อ EMBES รุ่น RTU 800 และ 
ย่ีห้อ OTT รุ่น CTD อ่านได้จากเคร่ืองคอมพิวเตอร์ท่ีทําการเช่ือมตอ่กบั IrDA Link USB โดยอ่านจาก
โปรแกรม OTT Water Logger Operating Program พร้อมทัง้บนัทึกอณุหภมิูท่ีวดัได้จากเคร่ือง 
OTT รุ่น CTD (นําเทอร์โมมิเตอร์มาวดัอุณหภูมิเพ่ือดวู่าค่าอุณหภูมิท่ีอ่านได้จากเคร่ืองมีความ
แม่นยําหรือไม่)  
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บทที่ 4 

ผลและวจิารณ์ 

4.1 การทดสอบอิทธิพลของอุณหภมูิต่อเคร่ืองวัดระดับนํา้แบบแรงดัน 

 การทดสอบเคร่ืองวดัระดบันํา้แบบแรงดนั เพ่ือศกึษาผลกระทบท่ีทําให้เกิดความคลาดเคล่ือน เน่ืองจาก
อณุหภมิูท่ีเปล่ียนแปลง จะทําให้ทราบว่าอณุหภมิูท่ีเปล่ียนแปลงนีเ้ป็นปัจจยัซึง่ทําให้เกิดความคลาดเคล่ือนจริง
หรือไม่ โดยจะทําการทดลองจากการวดัเคร่ืองวดัระดบันํา้แบบแรงดนัทัง้สองย่ีห้อ ท่ีระดบัความลกึนํา้ท่ี 0.3 เมตร 
และทําการเปล่ียนแปลงอุณหภูมิโดยการเติมนํา้แข็งและนํา้ร้อน พร้อมกับวดัอุณหภูมิโดยใช้เคร่ืองวดัระดบันํา้
ย่ีห้อ OTT รุ่น CTD ร่วมกบั เทอร์โมมิเตอร์ ในการเลือกระดบัความลกึนํา้ท่ีทําการทดสอบ 0.3 เมตร เน่ืองจาก
เป็นความลึกท่ีไม่มากนัก เพราะระดับความลึกนํา้ท่ีมากอาจเป็นปัจจัยอีกตัวหนึ่งซึ่งทําให้เกิดค่าความ
คลาดเคล่ือน และในการเปล่ียนแปลงอณุหภมิูโดยการเติมนํา้แข็งและนํา้ร้อนลงในนํา้ท่ีทําการทดสอบ เพ่ือให้คา่
อณุหภมิูท่ีสงูและต่ํามีช่วงความแตกต่างท่ีมากขึน้ ซึ่งจะทําให้เห็นความเปล่ียนแปลงของค่าความคลาดเคล่ือน
จากการวดัระดบันํา้โดยใช้เคร่ืองวดัระดบันํา้แบบแรงดนัทัง้สองย่ีห้อนีอ้ยา่งชดัเจน  

 จากการทดสอบเคร่ืองวดัระดบันํา้แบบแรงดนัทัง้สองย่ีห้อ ท่ีอณุหภมิูตัง้แต ่8 ถึง 41.15 องศาเซลเซียส 
โดยทดสอบท่ีความสงูคงท่ี 0.3 เมตร ได้ผลดงัตารางท่ี 1 นําผลการทดสอบอิทธิพลของอณุหภมิูต่อเคร่ืองวดั
ระดบันํา้แบบแรงดนัทัง้สองชนิดในตารางท่ี 1 มาสร้างกราฟ เพ่ือเปรียบเทียบผลการทดสอบระหว่างคา่ระดบันํา้
จริงกบัระดบันํา้ท่ีวดัได้จากเคร่ืองวดัระดบันํา้แบบแรงดนัทัง้สองย่ีห้อ ได้ผลดงัภาพท่ี 25 

การวเิคราะห์ผลการทดลอง 

 จากภาพท่ี 25 วิเคราะห์ผลการทดลองได้ว่าเคร่ืองวัดระดับนํา้แบบแรงดนัทัง้สองย่ีห้อ เม่ืออุณหภูมิ
เปล่ียนคา่ท่ีอ่านได้จากเคร่ืองวดัระดบันํา้ ย่ีห้อ SIEMENS  รุ่น  MPS series  มีความคลาดเคล่ือนเกิดขึน้อย่าง
เห็นได้ชดั โดยค่าท่ีอ่านได้จากเคร่ืองแปรผนักลบักบัอณุหภมิู นัน้คือ เม่ืออณุหภมิูต่ําค่าท่ีอ่านได้จะมากและเม่ือ
อุณหภูมิสูงค่าท่ีอ่านได้จะน้อยลง จึงสรุปได้ว่าอุณหภูมิมีผลกระทบต่อค่าท่ีวัดได้จากเคร่ืองวัดระดับนํา้แบบ
แรงดนั ย่ีห้อ SIEMENS  รุ่น  MPS series สว่นคา่ท่ีอ่านได้จากเคร่ืองวดัระดบันํา้แบบแรงดนัย่ีห้อ OTT  รุ่น  CTD  
สว่นใหญ่มีคา่ท่ีคงท่ีและใกล้เคียงหรือตรงกบัคา่ระดบันํา้จริงมาก เน่ืองจากเคร่ืองวดัระดบันํา้ย่ีห้อ OTT รุ่น CTD 
มี Sensor สําหรับวดัอณุหภมิูคา่ท่ีได้ก็จะเกิดการปรับแก้เน่ืองจากอณุหภมิูก่อนจะแปลผลออกมาเป็นข้อมลู ดงั
ตารางท่ี 1 และจากการทดลองวดัอณุหภมิูจากเทอร์โมมิเตอร์กบัคา่อณุหภมิูท่ีอ่านได้จากเคร่ืองวดัระดบันํา้แบบ
แรงดนัย่ีห้อ OTT  รุ่น  CTD มีคา่เทา่กนัจงึสรุปได้วา่ คา่ท่ีอ่านจากเคร่ืองมีความแม่นยํา 
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ตารางที่ 1 ผลการทดสอบอิทธิพลของอณุหภมิูตอ่เคร่ืองวดัระดบันํา้แบบแรงดนั 
 

ระดับนํา้ 
จริง (m) 

ระดับนํา้ที่วัดจาก
เคร่ือง (m) 

อุณหภมูินํา้
(˚C) 

ค่าความคลาดเคล่ือน 

Siemens OTT Siemens เปอร์เซ็นต์ OTT เปอร์เซ็นต์ 
0.30 0.280 0.300 41.15 0.020 6.67% 0.000 0.00% 
0.30 0.280 0.300 37.35 0.020 6.67% 0.000 0.00% 
0.30 0.280 0.301 36.98 0.020 6.67% -0.001 0.33% 
0.30 0.280 0.300 36.50 0.020 6.67% 0.000 0.00% 
0.30 0.287 0.302 36.00 0.013 4.33% -0.002 0.67% 
0.30 0.287 0.300 35.50 0.013 4.33% 0.000 0.00% 
0.30 0.287 0.301 35.00 0.013 4.33% -0.001 0.33% 
0.30 0.287 0.302 34.00 0.013 4.33% -0.002 0.67% 
0.30 0.287 0.302 33.00 0.013 4.33% -0.002 0.67% 
0.30 0.287 0.301 32.00 0.013 4.33% -0.001 0.33% 
0.30 0.287 0.301 31.00 0.013 4.33% -0.001 0.33% 
0.30 0.294 0.300 28.68 0.006 2.00% 0.000 0.00% 
0.30 0.294 0.300 27.35 0.006 2.00% 0.000 0.00% 
0.30 0.302 0.300 25.00 -0.002 0.67% 0.000 0.00% 
0.30 0.302 0.300 24.00 -0.002 0.67% 0.000 0.00% 
0.30 0.302 0.300 23.00 -0.002 0.67% 0.000 0.00% 
0.30 0.308 0.300 22.00 -0.008 2.67% 0.000 0.00% 
0.30 0.308 0.300 21.00 -0.008 2.67% 0.000 0.00% 
0.30 0.316 0.300 20.00 -0.016 5.33% 0.000 0.00% 
0.30 0.316 0.300 19.00 -0.016 5.33% 0.000 0.00% 
0.30 
0.30 

0.316 0.300 18.00 -0.016 5.33% 0.000 0.00% 
0.316 0.300 16.00 -0.016 5.33% 0.000 0.00% 

0.30 0.316 0.301 15.00 -0.016 5.33% -0.001 0.33% 
0.30 0.316 0.300 14.00 -0.016 5.33% 0.000 0.00% 
0.30 0.316 0.300 13.00 -0.016 5.33% 0.000 0.00% 
0.30 0.316 0.300 12.00 -0.016 5.33% 0.000 0.00% 
0.30 0.323 0.300 11.00 -0.023 7.67% 0.000 0.00% 
0.30 0.330 0.300 9.00 -0.030 10.00% 0.000 0.00% 
0.30 0.330 0.300 8.00 -0.030 10.00% 0.000 0.00% 

   
Average ±0.014 5.33% ±0.000 0.00% 

SD 0.0158  0.0018  
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ภาพที่ 25 เปรียบเทียบคา่ท่ีวดัได้จากเคร่ืองวดัระดบันํา้ทัง้สองย่ีห้อกบัระดบันํา้จริง ณ อณุหภมิูท่ีตา่งกนั 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

0.250

0.270

0.290

0.310

0.330

0.350

0.370

0.390

413631231813

ระดับนํา้ (m)

อุณหภมูินํา้ (ºC)

OTT

SIEMEN

ระดบันํา้จริง



33 
 

4.2 การทดสอบอิทธิพลของระดับนํา้ต่อเคร่ืองวัดระดับนํา้แบบแรงดัน 

 การทดสอบเคร่ืองวดัระดบันํา้แบบแรงดนั เพ่ือศกึษาผลกระทบท่ีทําให้เกิดความคลาดเคล่ือน เน่ืองจาก
ระดบัความลกึของนํา้ท่ีเปล่ียนแปลง จะทําให้ทราบว่าระดบัความลกึของนํา้ท่ีเปล่ียนแปลงนีเ้ป็นปัจจยัซึ่งทําให้
เกิดความคลาดเคล่ือนจริงหรือไม่ โดยจะทําการทดลองจากการวดัเคร่ืองวดัระดบันํา้แบบแรงดนัทัง้สองย่ีห้อ ท่ี
ระดบัความลกึนํา้ 0.5, 1.0, 1.5, 2.0, 2.5, 3.0, 3.5, 4.0, 4.5, 5.0, 5.5, 6.0 เมตร และทําการเปล่ียนแปลง
อณุหภมิูโดยอาศยัอณุหภมิูในแตล่ะช่วงเวลาของวนัทําการทดลอง พร้อมกบัวดัอณุหภมิูโดยใช้เคร่ืองวดัระดบันํา้
ย่ีห้อ OTT รุ่น CTD ร่วมกบั เทอร์โมมิเตอร์ ในการเลือกระดบัความลกึนํา้ท่ีทําการทดสอบ 0.5, 1.0, 1.5, 2.0, 
2.5, 3.0, 3.5, 4.0, 4.5, 5.0, 5.5, 6.0 เมตร เน่ืองจากคา่ระดบัความลกึของนํา้ท่ีตา่งกนัหลายๆ คา่จะทําให้เห็น
ความเปล่ียนแปลงของข้อมลูอยา่งชดัเจน และในการเปล่ียนแปลงอณุหภมิูโดยอาศยัอณุหภมิูแตล่ะช่วงเวลาของ
วันทําการทดลอง ซึ่งก็ขึน้อยู่กับอุณหภูมิอากาศในแต่ละวัน เพราะระดบันํา้มีความลึกมากการเปล่ียนแปลง
อณุหภมิู เช่น การเติมนํา้แข็งและนํา้ร้อน สามารถกระทําได้ยาก ในการทดสอบจึงจําเป็นต้องใช้อุณหภูมิแต่ละ
ช่วงเวลาของวนัเพ่ือใช้ในการทดสอบ  

 จากการทดสอบเคร่ืองวดัระดบันํา้แบบแรงดนัทัง้สองย่ีห้อ ท่ีความลกึ 0.5, 1.0, 1.5, 2.0, 2.5, 3.0, 3.5, 
4.0, 4.5, 5.0, 5.5, 6.0 เมตร โดยอณุหภมิูในแตล่ะช่วงเวลาของวนัท่ีทําการทดสอบอยู่ท่ีประมาณ 25 ถึง 34 
องศาเซลเซียส ได้ผลดงัตารางท่ี 2 

การวเิคราะห์ผลการทดลอง 

 จากตารางท่ี 2 วิเคราะห์ผลการทดลองได้ว่า ความลกึท่ีเปล่ียนมีผลตอ่เคร่ืองวดัระดบันํา้แบบแรงดนัทัง้
สองย่ีห้อ โดยย่ีห้อ SIEMENS รุ่น MPS series จะสงัเกตได้ว่าในอณุหภมิูท่ีใกล้เคียงกนัแตร่ะดบันํา้ตา่งกนัมีคา่
ความคลาดเคล่ือนมากขึน้เม่ือระดบันํา้สงูขึน้ และย่ีห้อ OTT รุ่น CTD มีคลาดเคล่ือนเกิดขึน้เพิ่มขึน้ตามระดบันํา้
ท่ีเพิ่มมากขึน้เช่นเดียวกนั 
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ตารางที่ 2 ผลการทดสอบอิทธิพลของระดบันํา้ตอ่เคร่ืองวดัระดบันํา้แบบแรงดนั 

อุณหภมูิ
นํา้(˚C) 

ระดับ
นํา้จริง 

(m) 

ระดับนํา้ที่วัดจาก
เคร่ือง (m) 

ค่าความคลาดเคล่ือน 

Siemens OTT Siemens เปอร์เซ็นต์ OTT เปอร์เซ็นต์ 
25.78 0.50 0.498 0.501 0.002 0.40% -0.001 0.20% 
27.91 0.50 0.498 0.498 0.002 0.40% 0.002 0.40% 
29.60 0.50 0.483 0.499 0.017 3.40% 0.001 0.20% 
30.17 0.50 0.491 0.498 0.009 1.80% 0.002 0.40% 
31.27 0.50 0.476 0.504 0.024 4.80% -0.004 0.80% 
32.79 0.50 0.476 0.501 0.024 4.80% -0.001 0.20% 
33.62 0.50 0.474 0.501 0.026 5.20% -0.001 0.20% 
25.78 1.00 0.993 0.998 0.007 0.70% 0.002 0.20% 
27.69 1.00 0.993 0.998 0.007 0.70% 0.002 0.20% 
29.60 1.00 0.993 0.999 0.007 0.70% 0.001 0.10% 
30.10 1.00 0.993 0.998 0.007 0.70% 0.002 0.20% 
30.71 1.00 0.978 0.999 0.022 2.20% 0.001 0.10% 
32.67 1.00 0.978 0.999 0.022 2.20% 0.001 0.10% 
33.65 1.00 0.971 0.996 0.029 2.90% 0.004 0.40% 
25.78 1.50 1.495 1.496 0.005 0.33% 0.004 0.27% 
27.50 1.50 1.488 1.494 0.012 0.80% 0.006 0.40% 
29.60 1.50 1.481 1.496 0.019 1.27% 0.004 0.27% 
29.95 1.50 1.481 1.494 0.019 1.27% 0.006 0.40% 
30.34 1.50 1.473 1.497 0.027 1.80% 0.003 0.20% 
32.54 1.50 1.466 1.496 0.034 2.27% 0.004 0.27% 
33.65 1.50 1.466 1.497 0.034 2.27% 0.003 0.20% 
25.75 2.00 1.991 1.990 0.009 0.45% 0.010 0.50% 
27.35 2.00 1.983 1.990 0.017 0.85% 0.010 0.50% 
29.60 2.00 1.976 1.993 0.024 1.20% 0.007 0.35% 
29.85 2.00 1.976 1.993 0.024 1.20% 0.007 0.35% 
30.22 2.00 1.976 1.993 0.024 1.20% 0.007 0.35% 
32.42 2.00 1.969 1.990 0.031 1.55% 0.010 0.50% 
33.74 2.00 1.969 1.991 0.031 1.55% 0.009 0.45% 
25.75 2.50 2.498 2.498 0.002 0.08% 0.002 0.08% 
27.25 2.50 2.493 2.487 0.007 0.28% 0.013 0.52% 
29.60 2.50 2.479 2.493 0.021 0.84% 0.007 0.28% 
29.78 2.50 2.479 2.490 0.021 0.84% 0.010 0.40% 
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ตารางที่ 2 (ต่อ) 

อุณหภมูิ
นํา้(˚C) 

ระดับ
นํา้จริง 

(m) 

ระดับนํา้ที่วัดจาก
เคร่ือง (m) 

ค่าความคลาดเคล่ือน 

Siemens OTT Siemens เปอร์เซ็นต์ OTT เปอร์เซ็นต์ 
32.30 2.50 2.471 2.493 0.029 1.16% 0.007 0.28% 
33.76 2.50 2.456 2.491 0.044 1.76% 0.009 0.36% 
25.71 3.00 2.995 2.987 0.005 0.17% 0.013 0.43% 
27.20 3.00 2.981 2.987 0.019 0.63% 0.013 0.43% 
29.56 3.00 2.974 2.987 0.026 0.87% 0.013 0.43% 
29.69 3.00 2.974 2.986 0.026 0.87% 0.014 0.47% 
30.11 3.00 2.974 2.988 0.026 0.87% 0.012 0.40% 
32.19 3.00 2.966 2.986 0.034 1.13% 0.014 0.47% 
33.80 3.00 2.959 2.986 0.041 1.37% 0.014 0.47% 
29.56 3.50 3.468 3.484 0.032 0.91% 0.016 0.46% 
30.05 3.50 3.469 3.484 0.031 0.89% 0.016 0.46% 
32.10 3.50 3.469 3.485 0.031 0.89% 0.015 0.43% 
29.56 4.00 3.961 3.980 0.039 0.98% 0.020 0.50% 
30.00 4.00 3.964 3.981 0.036 0.90% 0.019 0.48% 
31.97 4.00 3.971 3.981 0.029 0.72% 0.019 0.48% 
29.56 4.50 4.466 4.480 0.034 0.76% 0.020 0.44% 
29.97 4.50 4.466 4.478 0.034 0.76% 0.022 0.49% 
31.90 4.50 4.466 4.478 0.034 0.76% 0.022 0.49% 
29.56 5.00 4.961 4.982 0.039 0.78% 0.018 0.36% 
29.90 5.00 4.961 4.981 0.039 0.78% 0.019 0.38% 
31.78 5.00 4.961 4.982 0.039 0.78% 0.018 0.36% 
33.92 5.00 4.954 4.980 0.046 0.92% 0.020 0.40% 
29.56 5.50 5.464 5.480 0.036 0.65% 0.020 0.36% 
29.83 5.50 5.464 5.480 0.036 0.65% 0.020 0.36% 
31.66 5.50 5.464 5.480 0.036 0.65% 0.020 0.36% 
33.93 5.50 5.456 5.480 0.044 0.80% 0.020 0.36% 
29.56 6.00 - 5.977 - - 0.023 0.38% 
29.83 6.00 - 5.977 - - 0.023 0.38% 
31.66 6.00 - 5.977 - - 0.023 0.38% 
33.93 6.00 - 5.977 - - 0.023 0.38% 

Average ±0.025 1.26% ±0.011 0.36% 
SD 0.0276  0.0133  
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4.3 ปรับเทยีบเคร่ืองวัดระดับนํา้ ย่ีห้อ SIEMENS รุ่น MPS series 

จากการทดลองในหวัข้อ 4.1 และ 4.2 จะเห็นว่าปัจจยัท่ีทําให้เกิดความคลาดเคล่ือนจากข้อมลูท่ีวดัได้
จากเคร่ืองวดัระดบันํา้แบบแรงดนั ย่ีห้อ SIEMENS รุ่น MPS series มีสองอย่าง คือ  1. อณุหภมิูของนํา้ท่ีทําการ
ตรวจวดั 2. ระดบัความลกึของนํา้ท่ีทําการตรวจวดั ดงันัน้จึงใช้โปรแกรม MATLAB โดยนําข้อมลูท่ีได้มา Plot 
กราฟสามมิตจิาก เคร่ืองมือ SFTOOL โดยใช้ Degree X = 1 และ 2, Y = 1 และ 2  

4.3.1 การใช้โปรแกรม MATLAB 

1. เปิดโปรแกรม MATLAB 2010 (ภาพท่ี 26) 

 
 

ภาพที่ 26 หน้าตา่งของโปรแกรม MATLAB 2010 
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 2. ป้อนข้อมลู (DATA) 
 - พิมพ์ DATA=1; ในหน้าตา่ง Command Window   
 - Double Chick ท่ี DATA ในหน้าตา่ง Workspace จะได้ หน้าตา่ง Variable Editor – DATA  
 - ใสข้่อมลูท่ีต้องการวิเคราะห์ (ภาพท่ี 27) 

 
ภาพที่ 27 ป้อนข้อมลูท่ีต้องการวิเคราะห์  

 3. กําหนดข้อมลู  
 - Temperature = DATA(:,1) ในหน้าตา่ง Command Window 
 - SIEMENS = DATA(:,2) ในหน้าตา่ง Command Window 
 - ERROR=DATA(:,3) ในหน้าตา่ง Command Window  
 - SFTOOL และ Enter จะได้หน้าตา่ง Surface Fitting Tool 

 

ภาพที่ 28 หน้าตา่ง Surface Fitting Tool 
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 4. กําหนดตวัแปรในแกน X, Y, Z Surface Fitting Tool ให้ X=Temperature (◦C), Y= SIEMENS (m),  
Z=Error (m) เลือกใช้กราฟท่ีจะทําการวิเคราะห์โดยใช้ Interpolant (ภาพท่ี 29) และ Polynomial (ภาพท่ี 30) 

 
ภาพที่ 29 กราฟ Interpolant เม่ือกําหนดตวัแปร X, Y, Z 

 
ภาพที่ 30 กราฟ Polynomial เม่ือกําหนดตวัแปร X, Y, Z 
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4.3.2 การพจิารณาข้อมูลจากกราฟสามมิต ิ

สร้างกราฟสามมิต ิของช่วงอณุหภมิูท่ีได้จากการตรวจวดัคือ ประมาณ 25 ถึง 34 องศา และระดบัความ
ลกึของนํา้ ตัง้แต่ 0.5 ถึง 6 เมตร  จากนัน้ทําการวิเคราะห์กราฟสามมิติท่ีได้ ว่าค่าท่ีได้ไปในทิศทางเดียวกัน
หรือไม่ (ภาพท่ี 29, 30) 

การวเิคราะห์กราฟ  

 จากภาพท่ี 31 เม่ือพิจารณากราฟแล้ว จะเห็นว่าข้อมลูท่ีได้มีความผิดปกติในระดบัความลกึ 6 เมตร 
จากการท่ีข้อมลูเกิดความผิดปกตินี ้อาจจะเกิดมาจากข้อกําหนดของตวัเคร่ือง เน่ืองจากเคร่ืองวดัระดบันํา้แบบ
แรงดนัย่ีห้อ SIEMENS รุ่น MPS series ท่ีใช้ในการทดลอง มีข้อจํากดัในการวดัระดบันํา้สงูสดุเท่ากบั 6 เมตร จึง
ทําให้กราฟท่ีได้ไม่เป็นไปในทิศทางเดียวกนั ดงันัน้จึงต้องทําการตดัข้อมลูท่ีได้ทําการทดลอง ในระดบัความลกึ 6 
เมตร ออกเพราะหากไม่ทําการตดัข้อมลูชดุนีอ้อก สมการท่ีได้จะมีความคลาดเคล่ือนเกิดขึน้มาก จากนัน้ทําการ
พิจารณากราฟหลงัจากทําการตดัข้อมลูชดุนีอ้อกแล้ว โดยสร้างกราฟสามมิติ ขึน้ใหม่ และใช้ข้อมลูท่ีทําการ
ทดลองท่ีระดบัความลกึตัง้แต ่0.5 ถึง 5.5 เมตร 

การวเิคราะห์กราฟ 

 จากภาพท่ี 32 เม่ือพิจารณากราฟแล้ว จะเห็นได้วา่ข้อมลูท่ีได้ หลงัจากทําการตดัข้อมลูท่ีทําการวดัระดบั
นํา้ท่ีมีความลกึเท่ากบั 6 เมตร ออก กราฟท่ีได้เป็นไปในทิศทางเดียวกนั ดงันัน้จึงใช้ข้อมลูท่ีได้จากการทดลอง ท่ี
ช่วงอณุหภมิู 25 ถึง 34 องศา และความสงู 0.5 ถึง 5.5 เมตร 
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ภาพที่ 31 กราฟสามมิต ิแสดงความคลาดเคล่ือน จากอณุหภมิูและระดบันํา้ท่ี 0.5 ถึง 6 เมตร 

 
 

 
ภาพที่ 32 กราฟสามมิต ิแสดงความคลาดเคล่ือน จากอณุหภมิูและระดบันํา้ท่ี 0.5 ถึง 5.5 เมตร 
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ระดบันํา้ปรับเทียบ = ระดบัความลกึของนํา้ท่ีวดัได้ (Y) + คา่ความคลาดเคล่ือนท่ีเกิดขึน้ (E) 

4.3.3 การปรับเทยีบเคร่ืองวัดระดับนํา้ 

 นําข้อมลูท่ีได้จากในตารางท่ี 2 มาสร้างกราฟ Polynomial เพ่ือหาสมการความคลาดเคล่ือน โดยกําหนด
ตวัแปรดงัตอ่ไปนี ้

  T = อณุหภมิูนํา้ท่ีทําการตรวจวดั (องศาเซลเซียส) 
  Y = ระดบัความลกึของนํา้ท่ีวดัได้ (เมตร) 

  E = คา่ความคลาดเคล่ือนท่ีเกิดขึน้ (เมตร) 

หาสมการความคลาดเคล่ือน จากกราฟ Polynomial  
- ครัง้ท่ี 1 กําหนด Degree X=1, Y=1 
- ครัง้ท่ี 2 กําหนด Degree X=2, Y=1 
- ครัง้ท่ี 1 กําหนด Degree X=1, Y=2 

เม่ือได้สมการความคลาดเคล่ือนออกมาแล้ว นํามาแทนคา่อณุหภมิูนํา้ท่ีทําการตรวจวดั และระดบัความ
ลกึของนํา้ท่ีวดัได้จากเคร่ืองวดัระดบันํา้แบบแรงดนั ก็จะได้ค่าความคลาดเคล่ือน จากนัน้นําระดบัความลกึของ
นํา้ท่ีวดัได้จากเคร่ืองวดัระดบันํา้แบบแรงดนั มาบวกกบัความคลาดเคลื่อนท่ีคํานวณได้จากสมการ จะได้คา่ระดบั
นํา้ท่ีทําการตรวจวดัหลงัปรับแก้ ดงัตารางท่ี 3, 4, 5 

 
 

 

สร้างกราฟความสัมพันธ์ระหว่างเปอร์เซ็นต์ความคลาดเคลื่อนกับระดับนํา้จริงก่อนปรับเทียบจาก
สมการความคลาดเคล่ือน เปรียบเทียบกบักราฟความสมัพนัธ์ระหว่างเปอร์เซ็นต์ความคลาดเคลื่อนกบัระดบันํา้
จริงหลงัปรับเทียบจากสมการความคลาดเคล่ือนทัง้สามสมการ  (ภาพท่ี 33, 34, 35, 36) 

นําสมการความคลาดเคล่ือนท่ีได้จากกราฟ Polynomial ทัง้สามสมการมาวิเคราะห์ เพ่ือหาสมการท่ี
เหมาะสมในการนําไปใช้ในการปรับเทียบคา่ท่ีอ่านได้จากเคร่ือง 
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ภาพที่ 33 กราฟแสดงความสมัพนัธ์ระหวา่งเปอร์เซ็นต์ความคลาดเคล่ือนกบัระดบันํา้จริงก่อนปรับเทียบ 

 

 

ภาพที่ 34 กราฟแสดงความสมัพนัธ์ระหวา่งเปอร์เซ็นต์ความคลาดเคล่ือนกบัระดบันํา้จริง 
(หลงัปรับเทียบจากสมการท่ี 1) 
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 ภาพที่ 35 กราฟแสดงความสมัพนัธ์ระหวา่งเปอร์เซ็นต์ความคลาดเคล่ือนกบัระดบันํา้จริง 
(หลงัปรับเทียบจากสมการท่ี 2) 

 

 

ภาพที่ 36 กราฟแสดงความสมัพนัธ์ระหวา่งเปอร์เซ็นต์ความคลาดเคล่ือนกบัระดบันํา้จริง 
(หลงัปรับเทียบจากสมการท่ี 3) 
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E = -0.08793+0.003324T+0.004673Y…………………..สมการท่ี (1) 

ครัง้ที่ 1 จากกราฟ Polynomial Degree X=1,Y=1 (ภาพท่ี 33) 

 

ภาพที่ 37 กราฟ Polynomial Degree X=1,Y=1 

จากกราฟ Polynomial จะได้สมการความคลาดเคล่ือน คือ 
 

มีคา่  R – square = 0.847 

 นําสมการท่ีได้มาหาความคลาดเคล่ือนเพ่ือปรับแก้ค่าท่ีวัดได้จากเคร่ืองวัดระดับนํา้ย่ีห้อ SIEMENS 
ได้ผลการปรับเทียบดงัตารางท่ี 3 
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E = -0.2628+0.01455T+0.01212Y+0.0001784T2 -0.000246TY……………..สมการท่ี (2) 

ครัง้ที่ 2 จากกราฟ Polynomial Degree X=2,Y=1  
 

 
ภาพที่ 38 กราฟ Polynomial Degree X=2,Y=1 

 

จากกราฟ Polynomial จะได้สมการความคลาดเคล่ือน คือ 
 
 

มีคา่  R – square = 0.847 

นําสมการท่ีได้มาหาความคลาดเคล่ือนเพ่ือปรับแก้คา่ท่ีวดัได้จากเคร่ืองวดัระดบันํา้ย่ีห้อ SIEMENS 
ได้ผลการปรับเทียบดงัตารางท่ี 4 
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E = -0.1113+0.00401T+0.0161Y-0.0002836TY-0.0004718Y2………………..สมการท่ี (3) 

 ครัง้ที่ 3 จากกราฟ Polynomial Degree X=1,Y=2 

 

ภาพที่ 39 กราฟ Polynomial Degree X=1,Y=2 
 

จากกราฟ Polynomial จะได้สมการความคลาดเคล่ือน คือ 

มีคา่  R – square = 0.8614 

นําสมการท่ีได้มาหาความคลาดเคล่ือนเพ่ือปรับแก้คา่ท่ีวดัได้จากเคร่ืองวดัระดบันํา้ย่ีห้อ SIEMENS 
ได้ผลการปรับเทียบดงัตารางท่ี 5 
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วเิคราะห์ผลการทดลอง 

เม่ือพิจารณากราฟความสมัพนัธ์ระหวา่งเปอร์เซ็นต์คา่ความคลาดเคล่ือนกบัระดบันํา้จริงก่อนปรับเทียบ 
(ภาพท่ี 33) และหลงัปรับเทียบทัง้สามสมการ(ภาพท่ี 34, 35, 36) จะเห็นได้ว่าเปอร์เซ็นต์คา่ความคลาดเคล่ือนท่ี
ได้หลงัจากปรับเทียบทัง้สามสมการมีค่าน้อยลงอย่างเห็นได้ชัด ดงันัน้ทัง้สามสมการความคลาดเคล่ือนท่ีได้ 
สามารถนําไปใช้เพ่ือทําการปรับเทียบคา่ระดบันํา้ท่ีวดัได้จากเคร่ืองวดัระดบันํา้แบบแรงดนัย่ีห้อ SIEMENS รุ่น 
MPS series ได้ และจากตารางผลการทดลองปรับเทียบสมการความคลาดเคล่ือนทัง้สามสมการ (ตารางท่ี 3, 4, 
5) ก็จะเห็นได้ว่าคา่ท่ีได้หลงัจากการปรับเทียบมีคา่เข้าใกล้ระดบันํา้จริงมากย่ิงขึน้  สมการความคลาดเคล่ือนทัง้ 
3 สมการ ได้แก่  

สมการท่ี 1 E = -0.08793+0.003324T+0.004673Y 
สมการท่ี 2 E = -0.2628+0.01455T+0.01212Y+0.0001784T2 -0.000246TY  
สมการท่ี 3 E = -0.1113+0.00401T+0.0161Y-0.0002836TY-0.0004718Y2   
โดยทัง้สามสมการมีความคลาดเคล่ือนเฉล่ียอยู่ท่ี ±0.0036 ม. , ±0.0035 ม. และ ±0.0034 ม. 

ตามลําดบั ซึง่มีค่าน้อยกว่าคา่คลาดเคล่ือนเฉล่ียก่อนปรับเทียบ (ตารางท่ี 2) ซึง่มีคา่เท่ากบั ±0.0250 ม. และมี

ความคลาดเคล่ือนเฉล่ียต่างกันไม่มากนัก แต่สมการท่ีใช้ได้ง่ายและไม่ยุ่งยากมากนักคือ สมการท่ี 1 ดงันัน้

สมการท่ีเหมาะสมตอ่การนําไปใช้งานก็คือ สมการท่ี 1 E = -0.08793+0.003324T+0.004673Y 
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ตารางที่ 3 ผลการทดลองปรับเทียบเคร่ืองวดัระดบันํา้ จากกราฟ Polynomial Degree X=1, Y=1 

อุณหภมูิ
นํา้(˚C) 

ระดับนํา้
จริง (m) 

Siemens 
(m) 

ค่าความคลาด
เคล่ือนที่ได้จาก
สมการ (m) 

ระดับนํา้
ปรับเทยีบ (m) 

ค่าความคลาดเคล่ือน
หลังปรับแก้ 

เมตร เปอร์เซ็นต์ 

25.78 0.50 0.498 0.0007 0.4987 0.0013 0.26% 
27.91 0.50 0.498 0.0076 0.5056 -0.0056 1.12% 
29.60 0.50 0.483 0.0130 0.4960 0.0040 0.80% 
30.17 0.50 0.491 0.0149 0.5059 -0.0059 1.18% 
31.27 0.50 0.476 0.0184 0.4944 0.0056 1.12% 
32.79 0.50 0.476 0.0233 0.4993 0.0007 0.13% 
33.62 0.50 0.474 0.0260 0.5000 0.0000 0.01% 
25.78 1.00 0.993 0.0030 0.9960 0.0040 0.40% 
27.69 1.00 0.993 0.0092 1.0022 -0.0022 0.22% 
29.60 1.00 0.993 0.0154 1.0084 -0.0084 0.84% 
30.10 1.00 0.993 0.0170 1.0100 -0.0100 1.00% 
30.71 1.00 0.978 0.0189 0.9969 0.0031 0.31% 
32.67 1.00 0.978 0.0253 1.0033 -0.0033 0.33% 
33.65 1.00 0.971 0.0284 0.9994 0.0006 0.06% 
25.78 1.50 1.495 0.0053 1.5003 -0.0003 0.02% 
27.50 1.50 1.488 0.0109 1.4989 0.0011 0.08% 
29.60 1.50 1.481 0.0177 1.4987 0.0013 0.09% 
29.95 1.50 1.481 0.0188 1.4998 0.0002 0.01% 
30.34 1.50 1.473 0.0200 1.4930 0.0070 0.47% 
32.54 1.50 1.466 0.0271 1.4931 0.0069 0.46% 
33.65 1.50 1.466 0.0307 1.4967 0.0033 0.22% 
25.75 2.00 1.991 0.0075 1.9985 0.0015 0.07% 
27.35 2.00 1.983 0.0127 1.9957 0.0043 0.22% 
29.60 2.00 1.976 0.0200 1.9960 0.0040 0.20% 
29.85 2.00 1.976 0.0208 1.9968 0.0032 0.16% 
30.22 2.00 1.976 0.0220 1.9980 0.0020 0.10% 
32.42 2.00 1.969 0.0291 1.9981 0.0019 0.10% 
33.74 2.00 1.969 0.0334 2.0024 -0.0024 0.12% 
25.75 2.50 2.498 0.0099 2.5079 -0.0079 0.32% 
27.25 2.50 2.493 0.0147 2.5077 -0.0077 0.31% 
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ตารางที่ 3 (ต่อ) 

อุณหภมูิ
นํา้(˚C) 

ระดับนํา้
จริง (m) 

Siemens 
(m) 

ค่าความคลาด
เคล่ือนที่ได้จาก
สมการ (m) 

ระดับนํา้
ปรับเทยีบ (m) 

ค่าความคลาดเคล่ือน
หลังปรับแก้ 

เมตร เปอร์เซ็นต์ 

29.60 2.50 2.479 0.0223 2.5013 -0.0013 0.05% 
29.78 2.50 2.479 0.0229 2.5019 -0.0019 0.08% 
32.30 2.50 2.471 0.0310 2.5020 -0.0020 0.08% 
33.76 2.50 2.456 0.0357 2.4917 0.0083 0.33% 
25.71 3.00 2.995 0.0121 3.0071 -0.0071 0.24% 
27.20 3.00 2.981 0.0168 2.9978 0.0022 0.07% 
29.56 3.00 2.974 0.0245 2.9985 0.0015 0.05% 
29.69 3.00 2.974 0.0249 2.9989 0.0011 0.04% 
30.11 3.00 2.974 0.0263 3.0003 -0.0003 0.01% 
32.19 3.00 2.966 0.0330 2.9990 0.0010 0.03% 
33.80 3.00 2.959 0.0382 2.9972 0.0028 0.09% 
29.56 3.50 3.468 0.0268 3.4948 0.0052 0.15% 
30.05 3.50 3.469 0.0284 3.4974 0.0026 0.08% 
32.10 3.50 3.469 0.0350 3.5040 -0.0040 0.11% 
29.56 4.00 3.961 0.0291 3.9901 0.0099 0.25% 
30.00 4.00 3.964 0.0305 3.9945 0.0055 0.14% 
31.97 4.00 3.971 0.0369 4.0079 -0.0079 0.20% 
29.56 4.50 4.466 0.0314 4.4974 0.0026 0.06% 
29.97 4.50 4.466 0.0327 4.4987 0.0013 0.03% 
31.90 4.50 4.466 0.0390 4.5050 -0.0050 0.11% 
29.56 5.00 4.961 0.0337 4.9947 0.0053 0.11% 
29.90 5.00 4.961 0.0348 4.9958 0.0042 0.08% 
31.78 5.00 4.961 0.0409 5.0019 -0.0019 0.04% 
33.92 5.00 4.954 0.0478 5.0018 -0.0018 0.04% 
29.56 5.50 5.464 0.0360 5.5000 0.0000 0.00% 
29.83 5.50 5.464 0.0369 5.5009 -0.0009 0.02% 
31.66 5.50 5.464 0.0429 5.5069 -0.0069 0.12% 
33.93 5.50 5.456 0.0502 5.5062 -0.0062 0.11% 

Average ±0.0036 0.23% 
SD 0.0045  
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ตารางที่ 4 ผลการทดลองปรับเทียบเคร่ืองวดัระดบันํา้ จากกราฟ Polynomial Degree X=2,Y=1 
 

อุณหภมูิ
นํา้(˚C) 

ระดับนํา้
จริง (m) 

Siemens 
(m) 

ค่าความคลาด
เคล่ือนที่ได้จาก
สมการ (m) 

ระดับนํา้
ปรับเทยีบ (m) 

ค่าความคลาดเคล่ือน
หลังปรับแก้ 

เมตร เปอร์เซ็นต์ 

25.78 0.50 0.498 -0.0019 0.4961 0.0039 0.78% 
27.91 0.50 0.498 0.0071 0.5051 -0.0051 1.01% 
29.60 0.50 0.483 0.0134 0.4964 0.0036 0.72% 
30.17 0.50 0.491 0.0155 0.5065 -0.0065 1.30% 
31.27 0.50 0.476 0.0192 0.4952 0.0048 0.97% 
32.79 0.50 0.476 0.0239 0.4999 0.0001 0.02% 
33.62 0.50 0.474 0.0263 0.5003 -0.0003 0.06% 
25.78 1.00 0.993 0.0008 0.9938 0.0062 0.62% 
27.69 1.00 0.993 0.0087 1.0017 -0.0017 0.17% 
29.60 1.00 0.993 0.0159 1.0089 -0.0089 0.89% 
30.10 1.00 0.993 0.0176 1.0106 -0.0106 1.06% 
30.71 1.00 0.978 0.0196 0.9976 0.0024 0.24% 
32.67 1.00 0.978 0.0257 1.0037 -0.0037 0.37% 
33.65 1.00 0.971 0.0284 0.9994 0.0006 0.06% 
25.78 1.50 1.495 0.0036 1.4986 0.0014 0.09% 
27.50 1.50 1.488 0.0105 1.4985 0.0015 0.10% 
29.60 1.50 1.481 0.0182 1.4992 0.0008 0.05% 
29.95 1.50 1.481 0.0194 1.5004 -0.0004 0.03% 
30.34 1.50 1.473 0.0207 1.4937 0.0063 0.42% 
32.54 1.50 1.466 0.0274 1.4934 0.0066 0.44% 
33.65 1.50 1.466 0.0304 1.4964 0.0036 0.24% 
25.75 2.00 1.991 0.0062 1.9972 0.0028 0.14% 
27.35 2.00 1.983 0.0125 1.9955 0.0045 0.22% 
29.60 2.00 1.976 0.0206 1.9966 0.0034 0.17% 
29.85 2.00 1.976 0.0214 1.9974 0.0026 0.13% 
30.22 2.00 1.976 0.0226 1.9986 0.0014 0.07% 
32.42 2.00 1.969 0.0292 1.9982 0.0018 0.09% 
33.74 2.00 1.969 0.0326 2.0016 -0.0016 0.08% 
25.75 2.50 2.498 0.0090 2.5070 -0.0070 0.28% 
27.25 2.50 2.493 0.0148 2.5078 -0.0078 0.31% 



51 
 

ตารางที่ 4 (ต่อ) 

อุณหภมูิ
นํา้(˚C) 

ระดับนํา้
จริง (m) 

Siemens 
(m) 

ค่าความคลาด
เคล่ือนที่ได้จาก
สมการ (m) 

ระดับนํา้
ปรับเทยีบ (m) 

ค่าความคลาดเคล่ือน
หลังปรับแก้ 

เมตร เปอร์เซ็นต์ 

29.60 2.50 2.479 0.0230 2.5020 -0.0020 0.08% 
29.78 2.50 2.479 0.0236 2.5026 -0.0026 0.10% 
32.30 2.50 2.471 0.0310 2.5020 -0.0020 0.08% 
33.76 2.50 2.456 0.0346 2.4906 0.0094 0.38% 
25.71 3.00 2.995 0.0116 3.0066 -0.0066 0.22% 
27.20 3.00 2.981 0.0172 2.9982 0.0018 0.06% 
29.56 3.00 2.974 0.0252 2.9992 0.0008 0.03% 
29.69 3.00 2.974 0.0256 2.9996 0.0004 0.01% 
30.11 3.00 2.974 0.0269 3.0009 -0.0009 0.03% 
32.19 3.00 2.966 0.0328 2.9988 0.0012 0.04% 
33.80 3.00 2.959 0.0367 2.9957 0.0043 0.14% 
29.56 3.50 3.468 0.0276 3.4956 0.0044 0.13% 
30.05 3.50 3.469 0.0291 3.4981 0.0019 0.05% 
32.10 3.50 3.469 0.0347 3.5037 -0.0037 0.11% 
29.56 4.00 3.961 0.0300 3.9910 0.0090 0.23% 
30.00 4.00 3.964 0.0313 3.9953 0.0047 0.12% 
31.97 4.00 3.971 0.0366 4.0076 -0.0076 0.19% 
29.56 4.50 4.466 0.0324 4.4984 0.0016 0.04% 
29.97 4.50 4.466 0.0336 4.4996 0.0004 0.01% 
31.90 4.50 4.466 0.0386 4.5046 -0.0046 0.10% 
29.56 5.00 4.961 0.0348 4.9958 0.0042 0.08% 
29.90 5.00 4.961 0.0357 4.9967 0.0033 0.07% 
31.78 5.00 4.961 0.0404 5.0014 -0.0014 0.03% 
33.92 5.00 4.954 0.0449 4.9989 0.0011 0.02% 
29.56 5.50 5.464 0.0372 5.5012 -0.0012 0.02% 
29.83 5.50 5.464 0.0379 5.5019 -0.0019 0.03% 
31.66 5.50 5.464 0.0424 5.5064 -0.0064 0.12% 
33.93 5.50 5.456 0.0469 5.5029 -0.0029 0.05% 

Average ±0.0035 0.24% 
SD 0.0043  
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ตารางที่ 5 ผลการทดลองปรับเทียบเคร่ืองวดัระดบันํา้ จากกราฟ Polynomial Degree X=1, Y=2 

อุณหภมูิ
นํา้(˚C) 

ระดับนํา้
จริง (m) 

Siemens 
(m) 

ค่าความคลาด
เคล่ือนที่ได้จาก
สมการ (m) 

ระดับนํา้
ปรับเทยีบ (m) 

ค่าความคลาดเคล่ือน
หลังปรับแก้ 

เมตร เปอร์เซ็นต์ 

25.78 0.50 0.498 -0.0023 0.4957 0.0043 0.86% 
27.91 0.50 0.498 0.0054 0.5034 -0.0034 0.69% 
29.60 0.50 0.483 0.0115 0.4945 0.0055 1.11% 
30.17 0.50 0.491 0.0136 0.5046 -0.0046 0.91% 
31.27 0.50 0.476 0.0175 0.4935 0.0065 1.31% 
32.79 0.50 0.476 0.0230 0.4990 0.0010 0.21% 
33.62 0.50 0.474 0.0260 0.5000 0.0000 0.01% 
25.78 1.00 0.993 0.0013 0.9943 0.0057 0.57% 
27.69 1.00 0.993 0.0080 1.0010 -0.0010 0.10% 
29.60 1.00 0.993 0.0148 1.0078 -0.0078 0.78% 
30.10 1.00 0.993 0.0165 1.0095 -0.0095 0.95% 
30.71 1.00 0.978 0.0186 0.9966 0.0034 0.34% 
32.67 1.00 0.978 0.0255 1.0035 -0.0035 0.35% 
33.65 1.00 0.971 0.0289 0.9999 0.0001 0.01% 
25.78 1.50 1.495 0.0047 1.4997 0.0003 0.02% 
27.50 1.50 1.488 0.0106 1.4986 0.0014 0.09% 
29.60 1.50 1.481 0.0177 1.4987 0.0013 0.08% 
29.95 1.50 1.481 0.0189 1.4999 0.0001 0.00% 
30.34 1.50 1.473 0.0202 1.4932 0.0068 0.45% 
32.54 1.50 1.466 0.0277 1.4937 0.0063 0.42% 
33.65 1.50 1.466 0.0315 1.4975 0.0025 0.16% 
25.75 2.00 1.991 0.0078 1.9988 0.0012 0.06% 
27.35 2.00 1.983 0.0131 1.9961 0.0039 0.19% 
29.60 2.00 1.976 0.0206 1.9966 0.0034 0.17% 
29.85 2.00 1.976 0.0214 1.9974 0.0026 0.13% 
30.22 2.00 1.976 0.0226 1.9986 0.0014 0.07% 
32.42 2.00 1.969 0.0299 1.9989 0.0011 0.05% 
33.74 2.00 1.969 0.0343 2.0033 -0.0033 0.17% 
25.75 2.50 2.498 0.0109 2.5089 -0.0089 0.36% 
27.25 2.50 2.493 0.0158 2.5088 -0.0088 0.35% 
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ตารางที่ 5 (ต่อ) 

อุณหภมูิ
นํา้(˚C) 

ระดับนํา้
จริง (m) 

Siemens 
(m) 

ค่าความคลาด
เคล่ือนที่ได้จาก
สมการ (m) 

ระดับนํา้
ปรับเทยีบ (m) 

ค่าความคลาดเคล่ือน
หลังปรับแก้ 

เมตร เปอร์เซ็นต์ 

29.60 2.50 2.479 0.0233 2.5023 -0.0023 0.09% 
29.78 2.50 2.479 0.0238 2.5028 -0.0028 0.11% 
32.30 2.50 2.471 0.0319 2.5029 -0.0029 0.12% 
33.76 2.50 2.456 0.0366 2.4926 0.0074 0.30% 
25.71 3.00 2.995 0.0137 3.0087 -0.0087 0.29% 
27.20 3.00 2.981 0.0182 2.9992 0.0008 0.03% 
29.56 3.00 2.974 0.0256 2.9996 0.0004 0.01% 
29.69 3.00 2.974 0.0260 3.0000 0.0000 0.00% 
30.11 3.00 2.974 0.0273 3.0013 -0.0013 0.04% 
32.19 3.00 2.966 0.0338 2.9998 0.0002 0.01% 
33.80 3.00 2.959 0.0388 2.9978 0.0022 0.07% 
29.56 3.50 3.468 0.0279 3.4959 0.0041 0.12% 
30.05 3.50 3.469 0.0294 3.4984 0.0016 0.05% 
32.10 3.50 3.469 0.0356 3.5046 -0.0046 0.13% 
29.56 4.00 3.961 0.0300 3.9910 0.0090 0.23% 
30.00 4.00 3.964 0.0313 3.9953 0.0047 0.12% 
31.97 4.00 3.971 0.0371 4.0081 -0.0081 0.20% 
29.56 4.50 4.466 0.0319 4.4979 0.0021 0.05% 
29.97 4.50 4.466 0.0331 4.4991 0.0009 0.02% 
31.90 4.50 4.466 0.0386 4.5046 -0.0046 0.10% 
29.56 5.00 4.961 0.0337 4.9947 0.0053 0.11% 
29.90 5.00 4.961 0.0346 4.9956 0.0044 0.09% 
31.78 5.00 4.961 0.0397 5.0007 -0.0007 0.01% 
33.92 5.00 4.954 0.0456 4.9996 0.0004 0.01% 
29.56 5.50 5.464 0.0352 5.4992 0.0008 0.01% 
29.83 5.50 5.464 0.0359 5.4999 0.0001 0.00% 
31.66 5.50 5.464 0.0408 5.5048 -0.0048 0.09% 
33.93 5.50 5.456 0.0467 5.5027 -0.0027 0.05% 

Average ±0.0034 0.23% 
SD 0.0044  
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E = 0.004Y-0.001……………….……..สมการท่ี (4) 

4.4 ปรับเทยีบเคร่ืองวัดระดับนํา้ ย่ีห้อ OTT รุ่น CTD 

จากการทดลองในหวัข้อ 4.1 และ 4.2 จะเห็นได้ว่าอณุหภมิูท่ีเปล่ียนแปลงไม่มีผลกระทบต่อการวดั
ระดบันํา้ของเคร่ืองวดัระดบันํา้แบบแรงดนัย่ีห้อ OTT รุ่น CTD แต่มีปัจจยัท่ีทําให้เกิดคา่ความคลาดเคล่ือน คือ
ระดบัความลึกของนํา้ท่ีทําการตรวจวดั ดงันัน้จึงทําการปรับเทียบเคร่ืองวดัระดบันํา้แบบแรงดนัโดยการสร้าง
กราฟเพ่ือหาสมการคา่ความคลาดเคล่ือนเน่ืองจากระดบัความลกึของนํา้ท่ีทําการตรวจวดั ดงัภาพท่ี 40 

เม่ือสร้างกราฟความสมัพนัธ์ระหว่างค่าความคลาดเคล่ือนกับระดบันํา้จริงท่ีทําการตรวจวดัแล้วจะได้

สมการค่าความคลาดเคลื่อนออกมาซึ่งนํามาใช้ในการปรับเทียบเคร่ืองวดัระดบันํา้แบบแรงดนัย่ีห้อ OTT รุ่น 

CTD ได้สมการคา่ความคลาดเคล่ือนคือ  

 

 

 มีคา่ R-square = 0.915 

เม่ือ  E = คา่ความคลาดเคล่ือนท่ีเกิดขึน้ (เมตร) 
 Y = ระดบัความลกึของนํา้ท่ีวดัได้ (เมตร) 
 นําสมการท่ีได้มาทําการปรับเทียบเคร่ืองวดัระดบันํา้ย่ีห้อ OTT รุ่น CTD แล้วได้คา่ดงัตารางท่ี 6 

สร้างกราฟความสัมพันธ์ระหว่างเปอร์เซ็นต์ความคลาดเคลื่อนกับระดับนํา้จริงก่อนปรับเทียบจาก
สมการความคลาดเคล่ือน เปรียบเทียบกบักราฟความสมัพนัธ์ระหว่างเปอร์เซ็นต์ความคลาดเคลื่อนกบัระดบันํา้
จริงหลงัปรับเทียบจากสมการความคลาดเคล่ือนในสมการท่ี 4 (ภาพท่ี 41, 42) เพ่ือนํามาวิเคราะห์สมการ
ความคลาดเคล่ือนท่ีได้มีความเหมาะสมตอ่การนําไปใช้งานหรือไม่ 
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ภาพที่ 40 กราฟความสมัพนัธ์ระหวา่งคา่ความคลาดเคล่ือน (m) กบัระดบันํา้จริง (m) 

 
 

 

ภาพที่ 41 กราฟแสดงความสมัพนัธ์ระหวา่งเปอร์เซ็นต์ความคลาดเคล่ือนกบัระดบันํา้จริงก่อนปรับเทียบ 

E = 0.004Y ‐ 0.001
R² = 0.915
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ภาพที่ 42 กราฟแสดงความสมัพนัธ์ระหวา่งเปอร์เซ็นต์ความคลาดเคล่ือนกบัระดบันํา้จริง 
(หลงัปรับเทียบจากสมการท่ี 4) 

วเิคราะห์ผลการทดลอง 

 เม่ือพิจารณาจากกราฟความสมัพนัธ์ระหว่างเปอร์เซ็นต์ความคลาดเคลื่อนกับระดบันํา้จริงก่อนปรับเทียบ
และหลงัหรับเทียบ (ภาพท่ี 39 , 40) จะเห็นได้วา่เปอร์เซ็นต์ความคลาดเคล่ือนหลงัปรับเทียบจากสมการท่ี 4 มีคา่
น้อยลง ดงันัน้สมการค่าความคลาดเคล่ือนท่ีได้สามารถนํามาใช้ในการปรับเทียบค่าท่ีวดัได้จากการวดัระดบันํา้
ย่ีห้อ OTT รุ่น CTD ได้ และจากตารางผลการทดลองปรับเทียบเคร่ืองวดัระดบันํา้ OTT รุ่น CTD (ตารางท่ี 6) โดย
ใช้สมการ E = 0.004Y-0.001 จะเห็นว่าคา่ความคลาดเคล่ือนเฉล่ียมีคา่เท่ากบั ±0.0012 ม. ซึง่มีคา่น้อยกว่า คา่
ความคลาดเคล่ือนเฉล่ียก่อนปรับเทียบ (ตารางท่ี 2) ซึง่มีคา่เทา่กบั ±0.0110 ม. 
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ตารางที่ 6 ผลการทดลองปรับเทียบเคร่ืองวดัระดบันํา้ OTT รุ่น CTD 

ระดับนํา้
จริง (m) 

OTT 
ค่าความคลาด
เคล่ือนที่ได้จาก
สมการ (m) 

ระดับนํา้
ปรับเทยีบ (m) 

ค่าความคลาดเคล่ือน
หลังปรับแก้ 

เมตร เปอร์เซ็นต์ 

0.50 0.501 0.0010 0.5020 -0.0020 0.40% 
0.50 0.498 0.0010 0.4990 0.0010 0.20% 
0.50 0.499 0.0010 0.5000 0.0000 0.00% 
0.50 0.498 0.0010 0.4990 0.0010 0.20% 
0.50 0.504 0.0010 0.5050 -0.0050 1.00% 
0.50 0.501 0.0010 0.5020 -0.0020 0.40% 
0.50 0.501 0.0010 0.5020 -0.0020 0.40% 
1.00 0.998 0.0030 1.0010 -0.0010 0.10% 
1.00 0.998 0.0030 1.0010 -0.0010 0.10% 
1.00 0.999 0.0030 1.0020 -0.0020 0.20% 
1.00 0.998 0.0030 1.0010 -0.0010 0.10% 
1.00 0.999 0.0030 1.0020 -0.0020 0.20% 
1.00 0.999 0.0030 1.0020 -0.0020 0.20% 
1.00 0.996 0.0030 0.9990 0.0010 0.10% 
1.50 1.496 0.0050 1.5010 -0.0010 0.07% 
1.50 1.494 0.0050 1.4990 0.0010 0.07% 
1.50 1.496 0.0050 1.5010 -0.0010 0.07% 
1.50 1.494 0.0050 1.4990 0.0010 0.07% 
1.50 1.497 0.0050 1.5020 -0.0020 0.13% 
1.50 1.496 0.0050 1.5010 -0.0010 0.07% 
1.50 1.497 0.0050 1.5020 -0.0020 0.13% 
2.00 1.990 0.0070 1.9970 0.0030 0.15% 
2.00 1.990 0.0070 1.9970 0.0030 0.15% 
2.00 1.993 0.0070 2.0000 0.0000 0.00% 
2.00 1.993 0.0070 2.0000 0.0000 0.00% 
2.00 1.993 0.0070 2.0000 0.0000 0.00% 
2.00 1.990 0.0070 1.9970 0.0030 0.15% 
2.00 1.991 0.0070 1.9980 0.0020 0.10% 
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ตารางที่ 6 (ต่อ) 
  

ระดับนํา้
จริง (m) 

OTT 
ค่าความคลาด
เคล่ือนที่ได้จาก
สมการ (m) 

ระดับนํา้
ปรับเทยีบ (m) 

ค่าความคลาดเคล่ือน
หลังปรับแก้ 

เมตร เปอร์เซ็นต์ 

2.50 2.498 0.0090 2.5070 -0.0070 0.28% 
2.50 2.487 0.0089 2.4959 0.0041 0.16% 
2.50 2.493 0.0090 2.5020 -0.0020 0.08% 
2.50 2.490 0.0090 2.4990 0.0010 0.04% 
2.50 2.493 0.0090 2.5020 -0.0020 0.08% 
2.50 2.491 0.0090 2.5000 0.0000 0.00% 
3.00 2.987 0.0109 2.9979 0.0021 0.07% 
3.00 2.987 0.0109 2.9979 0.0021 0.07% 
3.00 2.987 0.0109 2.9979 0.0021 0.07% 
3.00 2.986 0.0109 2.9969 0.0031 0.10% 
3.00 2.988 0.0110 2.9990 0.0010 0.03% 
3.00 2.986 0.0109 2.9969 0.0031 0.10% 
3.00 2.986 0.0109 2.9969 0.0031 0.10% 
3.50 3.484 0.0129 3.4969 0.0031 0.09% 
3.50 3.484 0.0129 3.4969 0.0031 0.09% 
3.50 3.485 0.0129 3.4979 0.0021 0.06% 
4.00 3.980 0.0149 3.9949 0.0051 0.13% 
4.00 3.981 0.0149 3.9959 0.0041 0.10% 
4.00 3.981 0.0149 3.9959 0.0041 0.10% 
4.50 4.480 0.0169 4.4969 0.0031 0.07% 
4.50 4.478 0.0169 4.4949 0.0051 0.11% 
4.50 4.478 0.0169 4.4949 0.0051 0.11% 
5.00 4.982 0.0189 5.0009 -0.0009 0.02% 
5.00 4.981 0.0189 4.9999 0.0001 0.00% 
5.00 4.982 0.0189 5.0009 -0.0009 0.02% 
5.00 4.980 0.0189 4.9989 0.0011 0.02% 
5.50 5.480 0.0209 5.5009 -0.0009 0.02% 
5.50 5.480 0.0209 5.5009 -0.0009 0.02% 
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ตารางที่ 6 (ต่อ) 
  

ระดับนํา้
จริง (m) 

OTT 
ค่าความคลาด
เคล่ือนที่ได้จาก
สมการ (m) 

ระดับนํา้
ปรับเทยีบ (m) 

ค่าความคลาดเคล่ือน
หลังปรับแก้ 

เมตร เปอร์เซ็นต์ 

5.50 5.480 0.0209 5.5009 -0.0009 0.02% 
6.00 5.977 0.0229 5.9999 0.0001 0.00% 
6.00 5.977 0.0229 5.9999 0.0001 0.00% 
6.00 5.977 0.0229 5.9999 0.0001 0.00% 
6.00 5.977 0.0229 5.9999 0.0001 0.00% 

Average ±0.0012 0.11% 
SD 0.0025  
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บทที่ 5 

สรุปและข้อเสนอแนะ 

สรุป 

 การทดลองเคร่ืองมือวัดระดบันํา้แบบแรงดันทัง้สองย่ีห้อ ได้ทําการทดสอบเพ่ือหาปัจจัยท่ีทําให้เกิด
ความคลาดเคล่ือน ซึง่ได้แก่อณุหภมิูของนํา้ท่ีทําการตรวจวดัและระดบัความลกึของนํา้ท่ีทําการตรวจวดั โดยการ
ทดสอบปัจจยัท่ีเกิดจากอณุหภมิูของนํา้ท่ีทําการตรวจวดั ทําได้จากการเปล่ียนแปลงอณุหภมิูนํา้ท่ีทําการตรวจวดั
และกําหนดให้ระดบัความลกึของนํา้คงท่ี และการทดสอบปัจจยัท่ีเกิดจากระดบัความลกึของนํา้ท่ีทําการตรวจวดั 
ทําได้จากการวดัระดบันํา้ท่ี 0.5 , 1.0 , 1.5, 2.0 , 2.5 , 3.0 3.5 , 4.0 , 4.5 ,5.0 , 5.5 , 6.0 เมตร ตามลําดบั 
ในชว่งเวลาเดียวกนั จากนัน้นําผลท่ีได้มาวิเคราะห์เพ่ือหาสมการความคลาดเคล่ือนท่ีเกิดขึน้ 
  จากการปรับเทียบเคร่ืองวัดระดบันํา้แบบแรงดนัทัง้สองย่ีห้อ    ซึ่งประกอบไปด้วยเคร่ืองวัดระดบันํา้      
ย่ีห้อ SIEMENS รุ่น  MPS series และ ย่ีห้อ OTT รุ่น CTD  ซึง่ปัจจยัท่ีทําให้เกิดความคลาดเคล่ือนของคา่ระดบั
นํา้ท่ีวดัได้จากเคร่ืองวดัระดบันํา้แบบแรงดนั  ย่ีห้อ SIEMENS  รุ่น   MPS series  มีอยู่ด้วยกนัสองปัจจยั  คือ
อณุหภมิูนํา้ท่ีทําการตรวจวดั   กบัระดบัความลกึของนํา้ท่ีทําการตรวจวดั    ซึ่งหลงัจากท่ีทําการปรับเทียบแล้วมี
ค่าเข้าใกล้ค่าระดบันํา้จริง โดยสมการความคลาดเคล่ือนท่ีเหมาะสมต่อการใช้งาน คือสมการ E = -
0.08793+0.003324T+0.004673Y มีความคลาดเคล่ือนเฉล่ียเท่ากบั ±0.0036 ม. สว่นย่ีห้อ OTT รุ่น CTD ท่ีได้
ทําการทดสอบมีความคลาดเคลื่อนเฉล่ียเท่ากบั ±0.0110 ม. ซึง่เม่ือทําการปรับเทียบแล้วมีความคลาดเคลื่อน
เฉล่ียเทา่กบั ±0.0012 ม. ซึง่มีคา่เฉล่ียลดลงจึงถือว่าสมการท่ีได้จากการทดลองนําไปใช้ในการปรับเทียบข้อมลูท่ี
ได้จากการวดัระดบันํา้ ย่ีห้อ OTT รุ่น CTD ได้ โดยสมการคา่ความคลาดเคล่ือนท่ีได้ คือ E = 0.004Y-0.001 
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ข้อเสนอแนะ 

1. ในการใช้เคร่ืองมือวดัระดบันํา้แบบแรงดนัย่ีห้อ SIEMENS รุ่น  MPS series ในการวดัระดบันํา้ท่ีมีความ

ลกึตัง้แต่ 3 เมตร ขึน้ไปควรเลือกใช้แหล่งจ่ายไฟตรง ท่ีมีความสามารถในการจ่ายไฟให้แก่เคร่ืองอย่าง

เพียงพอ และควรใช้ความตา่งศกัย์ 12 V เทา่นัน้เพ่ือป้องกนัการเสียหายของเคร่ือง 

2. ระดบันํา้ปรับเทียบท่ีได้จากสมการท่ี 1, 2 , และ 3 ของการวดัระดบันํา้จากเคร่ืองมือวดัระดบันํา้ย่ีห้อ 

SIEMENS รุ่น  MPS series ควรใช้ปรับเทียบในช่วงอณุหภมิูระหว่าง 25 ถึง 34 องศาเซลเซียส และ

ระดบัความลกึของนํา้ ตัง้แต ่0.5 ถงึ 5.5 เมตร  

3. ระดบันํา้ปรับเทียบท่ีได้จากสมการท่ี 4 ของการวดัระดบันํา้จากเคร่ืองมือวดัระดบันํา้ย่ีห้อ OTT รุ่น CTD 

ควรใช้ปรับเทียบในช่วงระดบัความลกึของนํา้ตัง้แต ่0.5 ถึง 6 เมตร 

4. หากต้องการทําการปรับเทียบเคร่ืองวดัระดบันํา้ ควรมีการทดสอบในช่วงอณุหภมิูท่ีแตกตา่งกนัมากกว่า

นี ้หรืออยูใ่นช่วงประมาณ 18 ถึง 40 องศาเซลเซียส เพ่ือให้ครอบคลมุทัง้หน้าหนาวและหน้าร้อน 
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■ Overview

 

SITRANS P MPS pressure transmitters are submersible sensors 
for hydrostatic level measurements.

The SITRANS P MPS pressure transmitters are available for var-
ious measuring ranges and with explosion protection as an op-
tion. 

A junction box and a cable hanger are available as accessories 
for simple installation.

■ Benefits

• Compact design
• Simple installation
• Small error in measurement (0,3 %)
• Degree of protection IP 68

■ Application

SITRANS P MPS pressure transmitters are used in the following 
branches for example:
• Oil and gas industries
• Shipbuilding
• Water supply

■ Design

SITRANS P MPS pressure transmitters have a front-flush piezo-
resistive sensor with stainless steel diaphragm.

These pressure transmitters are equipped with an electronic cir-
cuit fitted together with the sensor in a stainless steel housing. 
The cable also contains a strength cord and vent pipe.

The diaphragm is protected against external influences by a 
protective cap.

The sensor, electronic circuit and cable are sealed in a common 
housing of small dimensions. 

The pressure transmitter is temperature-compensated for a wide 
temperature range.

■ Function

SITRANS P MPS pressure transmitters are for measuring the liq-
uid levels in wells, tanks, channels and dams.

 

SITRANS P MPS pressure transmitter, mode of operation and wiring dia-
gram

On one side of the sensor, the diaphragm is exposed to the hy-
drostatic pressure which is proportional to the submersion 
depth. This pressure is compared with atmospheric pressure. 
Pressure compensation is carried out using the vent pipe in the 
connection cable.

The hydrostatic pressure of the liquid column acts on the sensor 
diaphragm, and transmits the pressure to the piezo-resistive 
bridge in the sensor.

The output voltage of the sensor is applied to the electronic cir-
cuit where it is converted into an output current of 4 to 20 mA.

The cable of the 7MF1570 transmitter must always be connected 
in the supplied junction box. The junction box has to be installed 
near the measuring point.

If the medium is anything other than water, it is also necessary to 
check compatibility with the specified materials of the transmit-
ter.

■ Integration

 

Junction box 7MF1570-8AA, opened

Diaphragm

Sensor

U
const.

+2 (brown)
 -1 (blue)

Vent pipe
Screen

p
U

I EM I0, UB

To trans-
mitter
7MF1570

To measured-
value
processing

Venting pipe

© Siemens AG 2011



Pressure Measurement
Transmitters for basic requirements
SITRANS P MPS (submersible sensor)
Transmitter for hydrostatic level

2/16 Siemens FI01 · 2011 US Edition

2

 

Measuring point setup, in principle

■ Technical specifications

SITRANS P MPS pressure measurement transmitter 
(submersible sensor) 

Mode of operation 

Measuring principle piezo-resistive

Input 

Measured variable Hydrostatic level

Measuring range Maximum operating pressure

• 0 ... 6 ftH2O (0 ... 2 mH2O) • 20.3 psi (1.4 bar) (corresponds 
to 42 ftH2O (14 mH2O))

• 0 ... 12 ftH2O (0 ... 4 mH2O) • 20.3 psi (1.4 bar) (corresponds 
to 42 ftH2O (14 mH2O))

• 0 ... 15 ftH2O (0 ... 5 mH2O) • 20.3 psi (1.4 bar) (corresponds 
to 42 ftH2O (14 mH2O))

• 0 ... 18 ftH2O (0 ... 6 mH2O) • 43.5 psi (3.0 bar) (corresponds 
to 90 ftH2O (30 mH2O))

• 0 ... 30 ftH2O (0 ... 10 mH2O) • 43.5 psi (3.0 bar) (corresponds 
to 90 ftH2O (30 mH2O))

• 0 ... 60 ftH2O (0 ... 20 mH2O) • 87.0 psi (6.0 bar) (corresponds 
to 180 ftH2O (60 mH2O))

Output

Output signal 4 ... 20 mA

Measuring accuracy Acc. to EN 60770-1

Error in measurement (including 
non-linearity, hysteresis and repeat-
ability, at 25 °C (77 °F))

0.3% of full-scale value (typical)

Influence of ambient temperature 

Zero and span

• 1 ... 6 mH2O (3 ... 18 ftH2O) 0.45 %/10 K of full-scale value

• � 6 mH2O (� 18 ftH2O) 0.3 %/10 K of full-scale value

Long-term stability 

Zero and span

• 1 ... 6 mH2O (3 ...18 ftH2O) 0.25 % of full-scale value/year

• � 6 mH2O (� 18 ftH2O) 0.2 % of full-scale value/year

Rated conditions

Ambient conditions

• Process temperature -10 ... +80 °C (14 ... 176 °F)

• Storage temperature -40 ... +100 °C (-40 ... +212 °F)

Degree of protection to 
DIN EN 60529

IP68

Design 

Weight

• Pressure transmitter � 0.4 kg (� 0.88 lb)

• Cable 0.08 kg/m (� 0.054 lb/ft)

Electrical connection Cable with 2 conductors with 
screen and vent pipe, strength 
cord (max. 300 N (67.44 lbf)

Material

• Seal diaphragm Stainless steel, mat. no. 316L/
316 Ti

• Enclosure Stainless steel, mat. no. 316L/
316 Ti

• Gasket Viton

• Connecting cable Either
PE/HFFR sheath (non-halogen) or
FEP sheath

Power supply 

Terminal voltage on pressure trans-
mitter UB

10 ... 36 V DC

Certificates and approvals 

The transmitter is not subject to the 
pressure equipment directive 
(PED 97/23/EC)

Explosion protection

• Intrinsic safety "i" TÜV 03 ATEX 2004X

- Marking Ex II 1 G EEx ia IIC T4

Junction box

Application for connecting the transmitter 
cable

Design

Weight 0.2 kg (0.44 lb)

Electrical connection 2 x 3-way (28 to 18 AWG)

Cable entry 2 x M20 x 1.5

Enclosure material polycarbonate

Vent pipe for atmospheric pressure

Screw for cable strength cord

Rated conditions

Degree of protection to 
DIN EN 60529

IP54

Cable hanger

Application for mounting the transmitter

Design

Weight 0.16 kg (0.35 lb)

Material Galvanized steel, polyamide

© Siemens AG 2011
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■ Dimensional drawings

 

SITRANS P MPS pressure transmitters, dimensions in mm (inch)

 

Junction box, dimensions in mm (inch)

 

Cable hanger, dimensions in mm (inch)

Selection and Ordering data Order No. Order code

SITRANS P MPS pressure transmit-
ter for gauge pressure (submersible 
sensor)

C) 7 M F 1 5 7 0 - 77A 0 7 777

2-wire system

Note: Junction box and cable hanger 
included in delivery

Connection cable material
PE 1
FEP 5

Measuring range Cable length L
0 ... 2 mH2O 10 m C
0 ... 4 mH2O 10 m D
0 ... 5 mH2O
(with PE cable only)

25 m B

0 ... 6 mH2O 25 m E
0 ... 10 mH2O 25 m F
0 ... 20 mH2O 25 m G

0 ... 6 ftH2O 32 ft K
0 ... 12 ftH2O 32 ft L
0 ... 18 ftH2O 82 ft M
0 ... 30 ftH2O 82 ft N
0 ... 60 ftH2O 82 ft P

Special measuring range/ special 
cable length) 
Specify measuring range and cable 
length in plain text1)

1) Special measuring ranges of between 0 ... 1 mH2O (0 ... 3 ftH2O)
and 0 ... 200 mH2O (0 ... 656 ftH2O) and special cable lengths of up to 
1000 m (3281 ft) are possible. With Ex versions the max. custom cable 
length is 50 m (150 (ft). The length of free-hanging cable should not 
exceed 375 m (1230 ft).

C) Subject to export regulations AL: N, ECCN: EAR99.

Z J 1 Y

Explosion protection

• None 1
• with type of protection "intrinsic 

safety" (Ex II 1 G EEx ia IIC T4)
2

Further designs Order code

Factory calibration certificate, add Z to 
order no.  and add order code.

C11

Order No.

Quality inspection certificate (factory 
calibration) to IEC 60770-2 supplied 
later, in this case state manufacturing 
number of transmitter.

7MF1564-8CC11

Accessories (as spare part)

Junction box 7MF1570-8AA
for connecting the transmitter cable

Cable hanger 7MF1570-8AB
For attachment of transmitter

Power supply units see Chap. 8 "Supplementary Components".

Cable sheath 8.3 (0.33) diam. (black or blue, PE/HFFR)
Flexible cable with 0.5 mm2  (0.00078 inch2) cross-section
Vent pipe 1 (0.04) diam. (inner diameter)
Protective cap with 4 x 3 diam. (4 x 0.12 diam.) holes (black, PA)

+ (brown)

- (blue)

Screen

Vent pipe

Protective cap Cable sheath

Strength
cord (white)

Ø
 2

7
(1

.1
di

am
.)

L158 (6.2)

Venting
valve

Mounting
hole

57 (2.25)50 (1.97)
79

 (3
.1

)

30 (1
.2

)
94

 (3
.7

)

65 (2.56)

M20x1,5
22

(0.87)

M20x1,5

22
(0.87)

30 (1
.2

)

© Siemens AG 2011
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■ More information

Determination of the measuring range in case of media with 
a density � 1000 kg/m3 (medium � water)

 

Calculation of the measuring range:

p = � x g x H 

with:

� = density of medium

g = local acceleration due to gravity

H = maximum level

Example:

Medium: Diesel fuel, � = 850 kg/m3

Acceleration due to gravity: 9.81 m/s2

Start-of-scale: 0 m

Maximum level: 6.2 m

Calculation:

p = 850 kg/m3 x 9.81 m/s2 x 6.2 m

p = 51698.7 N/m2

p = 517 mbar

Transmitter to be ordered:

7MF1570-5ZA02-Z 

J1Y: 0 ... 517 mbar; cable length e.g. 8 m

H ρ

© Siemens AG 2011
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These operating instructions (version "01-1009") cover the OTT CTD software
versions

� OTT CTD firmware from V 1.00.0
� OTT CTD operating program from V 1.50.0

The OTT CTD firmware version can be found in the "Advanced operation" mode,
"OTT CTD" window of the operating program. The version of the operating
 program can be found via the "Info" function in the "Help" menu.

We reserve the right to make technical changes and improvements without notice.



Table of contents

1 Scope of supply 4

2 Order numbers 4

3 Safety information 5

4 Introduction 6

5 Installing, checking, and exchanging batteries 8

6 Installing the OTT CTD 10

6.1 Installing in 1" observation wells 12
6.2 Installing in 2", 3", 4", 5" or 6" observation wells,

top cap with adapter plate recess 13
6.3 Installing in observation wells beginning at 2" diameter,

top cap without adapter plate recess 15
6.4 Installing in observation wells beginning at 2" diameter without a top cap 17

7 Setting OTT CTD operating parameters 18

7.1 Installing the OTT CTD operating program 18
7.2 Establishing a communication link from PC to OTT CTD 18
7.3 Setting OTT CTD operating parameters 20
7.4 Saving/loading OTT CTD configuration 24
7.5 Importing/exporting OTT CTD configuration 24

8 Determining and displaying instantaneous values (observer function) 26

9 Reading out data 28

10 Exporting data 29

11 Displaying data 30

12 Protecting the OTT CTD and OTT CTD operating program with a password 31

13 Date and time settings 33

14 Deleting the data memory 34

15 Installing new OTT CTD firmware 34

16 Maintenance work 35

16.1 Cleaning the pressure probe 35
16.2 Replacing the desiccant capsules 36
16.3 Checking/replacing the batteries 36
16.4 Calibrating the conductivity sensor 36

17 Error messages 38

18 Troubleshooting/fault correction 38

19 Repair 40

20 Notes about the disposal of old units 40

21 Technical data 41

Appendix A – Declaration of conformity for OTT CTD 43

3



4

1 Scope of supply

� OTT CTD – 1 groundwater datalogger consisting of a communication unit with installed
O-ring, pressure probe cable with pressure compensation capillary and
Kevlar core for longitudinal stabilization, 2 desiccant capsules, pressure probe
with integrated conductivity sensor and datalogger

– 3 x 1.5 V batteries, alkaline (LR6 · AA) or lithium design (FR6 · AA)
– 1 brief Instructions
– 1 factory acceptance test certificate (FAT)

2 Order numbers

� OTT CTD Groundwater datalogger 55.445.001.9.0
Information needed for order
– Measuring range:0 … 4 m;

0 … 10 m;
0 … 20 m;
0 … 40 m;
0 … 100 m

– System length: 1,5 … 200 m (±1 % ±5 cm)
– Battery type: alkaline, lithium

� Accessories Installation kit 55.440.025.9.2
consisting of: adapter ring 1", adapter
plates 2", 4", 6", suspension bracket

Adapter plates 3" and 5" 55.440.444.4.1

Suspension brackets 55.440.450.4.1
for top caps starting at 2" without recess
and for universal installation

Cable suspension unit on request 
for OTT CTD system lengths of > 100 m

CD-ROM „OTT CTD Software“ 56.571.000.9.7
OTT CTD operating program for PC

Top cap
with integrated fastening hook
– for 2" observation wells 24.220.052.9.5
– for 4" observation wells 24.220.054.9.5
– for 6" observation wells 24.220.057.9.5

Intelligent top cap OTT ITC 55.530.0xx.3.2
for GSM remote data transfer

5-sided key 20.250.095.4.1
to lock OTT top caps

Optical OTT Duolink reading head 55.520.017.4.2

Optical OTT IrDA link USB reading head 55.520.026.9.2

Calibration container 55.445.025.9.2
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� Alkaline battery 96.800.004.9.5
LR6 · AA; 3 units required

Lithium battery 97.800.008.9.5
FR6 · AA; 3 units required

Desiccant capsules 97.100.280.9.5
2 in aluminum bags

Conductivity calibration solution
– 0,1 mS/cm; 1000 ml 55.495.350.9.5
– 0,5 mS/cm; 946 ml 55.495.351.9.5
– 1,412 mS/cm; 1000 ml 55.495.352.9.5
–12,856 mS/cm; 946 ml 55.495.353.9.5
– 47,6 mS/cm; 1000 ml 55.495.354.9.5

3 Basic safety information

� Read these operating instructions before using the OTT CTD for the first time!
Become completely familiar with the installation and operation of the OTT CTD
and its accessories! Retain these operating instructions for later reference.

� The OTT CTD is used to measure groundwater levels, the water temperature
and the specific conductivity of the groundwater. Only use the OTT CTD as
described in these operating instructions!
For further information, ➝ see Chapter 4, "Introduction".

� Note all the detailed safety information given within the individual work steps.
All safety information in these operating instructions are identified with the
warning symbol shown here.

� Ensure the electrical, mechanical, and climatic specifications listed in the
technical data are adhered to.
For further information ➝ see Chapter 11, "Technical data".

� Handle the pressure probe cable carefully: Do not kink the cable or pull it
across sharp edges!

� Do not make any changes or retrofits to the OTT CTD. If changes or retrofits
are made, all guarantee claims are voided.

� Have a faulty OTT CTD inspected and repaired by our repair center. On no
account carry out repairs yourself!
For further information ➝ see Chapter 19, "Repair".

� Dispose of the OTT CTD properly after taking out of service. On no account put
the OTT CTD into the normal household waste.
For further information ➝ see Chapter 20, "Notes about the disposal of old units".

Replacement
parts/
Consumable
materials
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4 Introduction

The OTT CTD groundwater datalogger provides precise measurement and record-
ing of groundwater levels and temperatures, as well as the specific electrical
conductivity of the groundwater. The OTT CTD also calculates the salinity and a
TDS value (Total Dissolved Solids) based on the specific conductivity.

The pressure probe uses the hydrostatic pressure of the water column above a
relative pressure measuring cell to determine the water level. A pressure compen-
sation capillary in the pressure probe cable gives the measuring cell the current
ambient air pressure as a reference. Erroneous measurement results due to atmos-
pheric air pressure fluctuations are thus eliminated. The OTT CTD measures the
specific electrical conductivity using a 4-electrode conductivity sensor with inte -
grated temperature sensor. The measurement electrodes are made of graphite.

The temperature compensation process for the conductivity measurement and the
reference temperature used can be chosen as well as the calculation method for
the salinity.

The OTT CTD is available with five water level measuring ranges:
� 0 … 4 m water column (0 ... 0.4 bar)
� 0 … 10 m water column (0 ... 1 bar)
� 0 … 20 m water column (0 ... 2 bar)
� 0 … 40 m water column (0 ... 4 bar)
� 0 … 100 m water column (0 ... 10 bar)

With the help of a reference value that is input during startup, the OTT CTD’s
standard setting provides measurement results in the form of depth values. Alter-
natively, measured values can be levels or pressures. The measurement intervals
(sample intervals) can be preselected as necessary.

The operating parameters are adjusted with the "OTT CTD Operating program"
PC software. This software allows the system to be conveniently and flexibly
tailored to a wide range of measurement requirements. The software can be set
to provide a basic or an advanced operator interface. The basic operator inter-
face allows all settings to be adjusted within a single program window. In the
advanced operator interface, the sample interval can be controlled with limit
events, for example. The software also supports the execution of pump tests.

The stored measured values are made available through an infrared interface
(IrDA) for wireless readout by a PC with OTT CTD Operating program or OTT
Hydras 3 or by a PDA with OTT Hydras 3 Pocket.

Together with an OTT ITC intelligent top cap (accessory), remote data transfer
and remote parameter input is possible via the GSM mobile telephone network
(GSM = global system for mobile communications). The remote data transfer can
be optionally carried out by SMS text messages or using the packet oriented
mobile radio transmission service GPRS (general packet radio service).

The OTT CTD is installed simply by hanging it in observation wells of 1" in diame-
ter and larger. Various adapters/suspension brackets are available as accessories
for this purpose. Three 1.5 V lithium batteries (type AA) provide an operating life
of over five years (sample interval: 1 hour; system length: 50 m). Alternatively,
alkaline batteries with a limited working life can be used.

The communication unit of the OTT CTD can withstand temporary flooding (for
details, see chapter 21, "Technical data").
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Top cap
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Fig. 1: Setting up a groundwater measure-
ment station with the OTT CTD.

The OTT CTD essentially consists of three com-
ponents: Communication unit, pressure probe

cable and pressure probe with datalogger.

OTT CTD system length = length of
communication unit + cable length +

length of pressure probe with datalogger.
(The system length is required when
ordering an OTT CTD. When setting

the OTT CTD operating parameters the
system length is not required.)

(The rubber stop attached to the pressure
probe cable prevents the pipe casing from

falling when the communication unit is
open. Do not move the rubber stop!)
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5 Installing, checking, and exchanging batteries

Please note

� Only use the battery types indicated (no rechargeable batteries)!
� Always use brand new batteries! Do not mix used and new batteries!
� Do not mix batteries of different manufacturers!
� Do not mix lithium and alkaline batteries!
� Properly dispose of dead batteries! Do not include in household waste!

Suitable battery types

3 x 1.5 V AA cells (LR6/FR6),
alkaline or lithium design (LiFeS; Energizer L91)

Insert the batteries as follows

� Slide the pipe casing of the communication unit approximately 30 cm in the
direction of the pressure probe cable.

� Insert 3 batteries (LR6/FR6 · AA) in the battery compartment
as shown in Figure 2. Ensure that the polarity is correct!

� Screw the pipe casing of the communication unit back on.

Notes

� The OTT CTD begins measurements within a few seconds of the batteries being
inserted  (there is no on/off switch).

� If the OTT CTD is to be shut off ➝ remove the batteries. This will prevent the
batteries from draining prematurely and will stop any recording of unusable
measurements.

� When bringing back into operation it takes – dependent on how much data is
stored – up to 7 minutes until the OTT CTD begins measurements again.

Pipe casing
communication

unit

Battery compartment

LR6/FR6 · AA
Battery

Backstop

+
+

+

Fig. 2: Installing batteries.
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Battery life

For a 1 hour sample interval an 50 m system length (without ITC).
� Lithium batteries: at least 5 years
� Alkaline batteries: at least 1.5 years (high quality battery types)

Notes

� The operating program has a calculation function that determines the approxi-
mate battery life based on the operating parameters currently set. The basis for
this are lithium batteries!

� Due to their design, at 0 °C, alkaline batteries drop to 50 % of their original
20 °C capacity  and at  –10 °C they drop to approximately 35 %. If ambient
temperatures are expected to drop below 0 °C at the measurement station, it
is recommended that lithium batteries be used.

Check the battery voltage as follows

� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Select the "OTT CTD" menu, "View Instantaneous values" function 1) ➝ the

OTT CTD starts an instantaneous value measurement ➝ the "Observer"
window indicates the current battery voltage and the energy withdrawn from
the batteries so far in Ah.

� If the battery voltage is ≤ 3.6 to 3.7 volts ➝ replace the batteries.
� Click on the "Exit" button.
� Close the operating program.
1) With suitable settings (Menu "File", Function "Options"), the operating program starts with the

"Observer" window.

Replace dead batteries as follows

� Open the top cap/observation well cover.
� Pull the communication unit approximately 80 cm out of the observation well

and hold (a second person would be useful).
� Slide the pipe casing of the communication unit approximately 30 cm in the

direction of the pressure probe cable. (The rubber stop located on the pressure
probe cable (see Fig. 1) prevents the pipe casing from falling. Do not move the
rubber stop!)

� Remove dead batteries.
� Insert 3 new batteries (LR6/FR6 · AA) into the battery compartment as shown

in Figure 2 within 10 minutes. Ensure that the polarity is correct!
� Slide the pipe casing of the communication unit back on until it stops.
� Slowly and carefully place the communication unit back into the observation well.
� Close the top cap/observation well cover.

Notes

� The OTT CTD stores the measured values in a non-volatile memory. This pre-
vents any data loss when replacing the batteries. This also applies to storage
over a long time period with the batteries removed.

� If it takes longer than approx. 10 minutes to replace dead batteries, the time
(and possibly the date) will have to be re-entered (see Chapter 13, "Date and
time settings"). Furthermore, it takes – dependent on how much data is stored –
up to 7 minutes until the OTT CTD begins measurements again.

� When replacing the batteries, we recommend changing the desiccant capsules
at the same time (see Chapter 16.2, "Replacing the desiccant capsules").
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6 Installing the OTT CTD

System length up to 100 meters
The installation of the OTT CTD is carried out by suspending it in the observation well.
In the process, the necessary accessories and type of installation varies depending
on the diameter of the observation well and the design of the top cap:

� 1" observation wells see 6.1
� 2", 3", 4", 5" or 6" observation wells, see 6.2

OTT top caps with recess for adapter plate
� Observation wells beginning at 2" in diameter, see 6.3

top caps without recess for adapter plate
� Special case: Observation wells beginning at see 6.4

2" in diameter without top cap

System length over 100 meters
For installation of an OTT CTD with a system length of more than 100 meters,
there is a special cable suspension unit available (see accessories). This suspension
unit is described separately.

Adapter plate 2"

Adapter plate 4"

Adapter plate 6"

2

3

33

3 2/3

3

1

1

2

1

Fig. 3: Installation accessory set – Part 1.

1 = hole for OTT CTD
2 = hole for contact gauge

3 = recess for screws on the top cap



11

Adapter plate 3"

Adapter plate 5"

33

33

1

1

2

2

Fig. 5: Adapter plate accessories 3" and 5".

1 = hole for OTT CTD
2 = hole for contact gauge

3 = recess for screws on the top cap

Suspension bracket

Adapter ring 1"

Fig. 4: Installation accessory set – Part 2.
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6.1 Installing in 1" observation wells 

� Required accessories: Adapter ring for 1" observation wells.

Install the OTT CTD as follows

� Preliminary work: If not already done, install batteries (see Chapter 5).
� Open the observation well cover.
� Determine the current depth with a contact gauge and make a note of it.
� Slide O-ring from the communication unit onto the pressure probe cable.
� Place adapter ring over the pressure probe cable and slide it until it comes

to rest against the communication unit.
� Slide O-ring back onto the communication unit.
� Place the pressure probe in the observation well.
� Slowly and carefully lower the pressure probe with the pressure probe

cable!
� Feed the communication unit into the observation well until the O-ring sits on

the observation well (see Figure 6).
� Raise and lower the pressure probe in quick succession approx. 30 cm ➝ this

removes any air bubbles in the conductivity sensor.
� Set operating parameters (see Chapter 7).
� Close the observation well cover carefully. Caution: Do not damage the

infra-red interface (maintain correct spacing)!

Adapter ring 1"

O-ring

Communication unit

Observation well cover 
(example)

Infrared interface

 1" Observation well

Fig. 6: Installing the OTT CTD
in 1" observation well.



13

6.2 Installing in 2", 3", 4", 5" or 6" observation wells,
top cap with adapter plate recess

� Required accessories: OTT top cap with appropriate sized recess and the
matching adapter plate.

Install the OTT CTD as follows

� Preliminary work: If not already done, install batteries (see Chapter 5).
� Open the top cap cover.
� Insert correctly sized adapter plate into top cap.
� Pass pressure probe through the hole in the adapter plate.
� Slowly and carefully lower the pressure probe into the observation well

with the pressure probe cable (see Fig. 8)!
� Raise and lower the pressure probe in quick succession approx. 30 cm ➝ this

removes any air bubbles in the conductivity sensor.
� Pass the communication unit through the hole in the adapter plate until the

O-ring sits on the adapter plate (see Fig. 7).
� Determine the current depth with a contact gauge and make a note of it.
� Set operating parameters (see Chapter 7).
� Close the top cap.

Adapter plate 2"

Communication
unit

Recess

O-ring

OTT Top cap

Fig. 7: Installing the OTT CTD in 2",
3", 4", 5" or 6" observation wells.

Example: 2" observation well



14

Recess

Top cap

Communication unit

O-ring

Adapter plate

Fig. 8: Installing the OTT CTD.
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6.3 Installing in observation wells beginning at 2" in diameter,
top cap without adapter plate recess

� Required accessories: Top cap with attachment screw for the top of the top cap.
Suspension bracket.

Caution: There must be sufficient space in the top cap for the infrared interface
to not be damaged when the top of the top cap is closed!

Install the OTT CTD as follows

� Preliminary work: If not already done, install batteries (see Chapter 5).
� Open the top cap cover.
� Remove the upper part of the top cap (see Fig. 9).
� Place the suspension bracket on the screw (see Fig. 9).
� Reattach the upper part of the top cap (see Fig. 9).
� Pass the pressure probe through the holes in the suspension bracket.
� Slowly and carefully lower the pressure probe into the observation well

with the pressure probe cable!
� Raise and lower the pressure probe in quick succession approx. 30 cm ➝ this

removes any air bubbles in the conductivity sensor.
� Pass the communication unit through the holes in the suspension bracket until

the O-ring sits on the suspension bracket (see Fig. 10).
� Determine the current depth with a contact gauge and make a note of it.
� Set operating parameters (see Chapter 7).
� Close the top cap.

Suspension
bracket

Screw

Top cap 
upper part

Fig. 9: Installing the suspension bracket in
observation wells beginning at 2" diameter

with a top cap without a recess.

Example: 4" observation well



16

Caution: For top caps with installed suspension brackets, never completely
remove the screw in the top cap! Otherwise, the suspension bracket and the
OTT CTD will fall into the observation well!

O-ringSuspension
bracket

Communication
unit

Top cap 
upper part

Screw

Infrared
interface

Fig. 10: Installing the OTT CTD in obser-
vation wells beginning at 2" diameter

with a top cap without a recess.

Example: 2" observation well
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6.4 Installing in observation wells beginning at 2" diameter
without a top cap

For this installation case, an individual solution to fasten the OTT CTD must be
found depending on the measurement station. Example: fix a suspension bracket
with an M6 hex bolt/nut laterally at the upper end of the observation well.

� Required accessories: Suspension bracket; for example: M6 hex bolt, plate
and M6 hex nut.

Install the OTT CTD as follows (example)

� Preliminary Work: If not already done, install batteries (see Chapter 5).
� Make a hole (Ø 6.5 mm) laterally at the upper end of the observation well.
� Attach the suspension bracket with an M6 hex bolt and M6 hex nut (both

stainless steel) to the observation well (see Fig. 11).
� Pass the pressure probe through the holes in the suspension bracket.
� Slowly and carefully lower the pressure probe into the observation well

with the pressure probe cable!
� Raise and lower the pressure probe in quick succession approx. 30 cm ➝ this

removes any air bubbles in the conductivity sensor.
� Pass the communication unit through the holes in the suspension bracket until

the O-ring sits on the suspension bracket (see Fig. 10).
� Determine the current depth with a contact gauge and make a note of it.
� Set operating parameters (see Chapter 7).

Suspension
bracket

Hex nut

Plate

Hexagon bolt

Observation
well

Fig. 11: Example installation of an
OTT CTD in an observation well

beginning at 2" diameter.

Proceed similarly for
other local conditions!
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7 Setting OTT CTD operating parameters

To set the OTT CTD operating parameters you need the PC software "OTT CTD
Operating program" (WBSPL0.exe). This software is contained on the "OTT CTD
Software" CD-ROM (accessory).

Hardware and software requirements: see CD insert.

7.1 Installing the OTT CTD operating program

Install the OTT CTD operating program as follows

� Insert the OTT CTD Software CD-ROM into the drive of the PC.
� Start the "setup.exe" file in the "\Software\Deutsch" 1) directory (e.g. double

click on the file symbol) ➝ the Setup Assistant opens and guides you through
the installation.

� Follow the installation instructions on the screen.

1) Alternatively: "\English" or "\Français" or "\Español"

7.2 Establishing a communication link from PC to OTT CTD 

In the following chapters, establishing a communication connection between the
OTT CTD and a PC is a pre-requisite for the subsequent steps. The following
description illustrates the various methods of setting up this communication link.

The communication between the OTT CTD and a PC is established without contact
via invisible infrared light (IrDA interface).

Required accessories:

� OTT Duolink reading head 1) or
� OTT IrDA-Link USB reading head
1) with PCB version "b": see label on the connection line

Note

� Together with a modem and the OTT ITC intelligent top cap, it is possible to
establish a remote communication connection. See online help.

How to establish a communication link

� Start the OTT CTD operating program.
� Change the language for the OTT CTD operating program as required:

Press function key "F3" (multiple times) until the required language appears.
� In the start window, press the "Setup device" button ➝ the operating program

displays the "Basic operation" window. No operating parameters for the
OTT CTD are visible yet.

– Setting up a communication link with the OTT Duolink reading head:

� Connect the OTT Duolink reading head to a serial PC interface (COM1, etc.).
� Place the OTT DuoLink reading head on the OTT CTD infrared interface

(see Fig. 12).
� In the OTT CTD operating program, select the communication path "IrDA –

OTT DuoLink" and the serial interface used (COM1, etc.).
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– Setting up a communication link with the OTT IrDA-Link USB reading head:

� Connect the OTT IrDA-Link USB reading head to a USB interface on the PC.
(USB interface drivers must be installed, see separate installation instructions.)

� Place the OTT IrDA-Link USB reading head on the OTT CTD infrared interface
(see Fig. 12).

� Select the communication path "IrDA – OTT IrDA-Link" in the operating
 program.

Notes

� The integrated infrared interface of a PC (standard for many notebooks) can
only be used with the Windows 95 and Windows NT operating systems!

� The OTT CTD infrared interface has a radiation angle of approx. ±15 °.
� Caution: OTT CTD connected to OTT ITC: Establishing a communication

 connection can take up to a minute! (This is always the case if the OTT CTD
attempts to communicate with the OTT ITC (e.g. SMS message) and the OTT ITC
is open at the time.)

Fig. 12: Establishing a communication
link PC/OTT CTD.
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7.3 Setting OTT CTD operating parameters

How to set the OTT CTD operating parameters

� Click the "Read" button (alternatively: Menu "OTT CTD", function
"Read") ➝ the operating program reads the current operating parameters of
the OTT CTD.

� Adjusting operating parameters (see overview on page 21).
� If necessary: „Set up cyclical data transfer with SMS text message in combi -

nation with an OTT ITC intelligent top cap“ or „Set up cyclical data transfer
using GPRS in combination with an OTT ITC intelligent top cap“ – see below.

� Set time: adjust the proposed PC date/time or individually set date/time using
"Set date/time" (see also Chapter 13).
Caution: The operating program automatically corrects any summer time PC
adjustments.

� Click the "Program" button➝ "Warning: Reset the OTT CTD and delete data
memory additionally?" Confirm with "Yes" (recommended for initial installation
and reinstallations).
Caution: All measured values collected until now will be permanently lost!

� Check the level of the adjusted measured value (pressure sensor). See Chapter 8.
� Remove OTT DuoLink.
� Close the top cap/observation well cover.

If necessary: Set up cyclical data transfer with SMS text message
in combination with an OTT ITC intelligent top cap 1)

� Activate check box "Modem/ITC connected".
� Activate check box "SMS data transmission active".
� Click on the "ITC settings" button ➝ the operating program starts an Assistant

for setting all the necessary operating parameters.
� Enter the receiver phone no. for the data SMS. (phone number of a large

account or for a PC with GSM modem.)
� Click on the "Next" button.
� Enter SIM PIN (4-digit) of the SIM card.
� Click on the "Next" button.
� Set or enter the SMS-C phone no. of the network operator. (Phone number of

the SMS service center. The SMS-C phone number is normally already saved
on the SIM card ➝ in this case, set to "SIM card".)

� Click on the "Next" button.
� Select the SMS transfer mode.
� Click on the "Next" button.
� Set the interval for transmission of the storage values.
� Click on the "Next" button.
� Set the offset time for the transmission interval.
� Click on the "Exit" button.
� Check the settings afterwards and correct as necessary.
� Click on the "OK" button.

If necessary: Set up cyclical data transfer using GPRS in com -
bination with an OTT ITC intelligent top cap 1)

� Activate check box "Modem/ITC connected".
� Activate check box "GPRS data transmission active".
� Click on the "ITC settings" button ➝ the operating program opens a window

with several tabs for setting all the necessary operating parameters.
� Make the required settings in the "General", "Operator", "FTP" and "Time

sync." tabs. Caution: The SIM PIN for the SIM card used should be deactivated!
Otherwise enter the SIM PIN in the "Modem/ITC" tab (advanced operation
mode).

� Click on the "OK" button.

1) For further information, refer to the online help
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OTT CTD
� Number Station number, 10 characters (alphanumeric)
� Name Station name, max. 40 characters (alphanumeric)

Water level / Pressure + Temperature + Conductivity
� Number Sensor number, 4 characters (alphanumeric)
� Name Sensor name, max. 40 characters (alphanumeric)
� – Water level: Depth or level pressure

– Conductivity 0.001 … 2.000 mS/cm · 0.10 … 100.00 mS/cm
– Salinity: 2 … 42.00 PSU · 2 … 60.00 ppt

� Units – Pressure sensor: m, cm, feet, inch / bar, psi
– Temperature: °C · °F
– Conductivity: mS/cm · μS/cm
– Salinity: PSU · ppt
– TDS: mg/l

� Decimal places fixed specification, depending on the units and measuring range
– m: 3 or 2; cm: 1 or 0; feet: 2 or 1, inch: 1 or 0
– bar: 4  or 3, psi: 3 or 2
– °C: 2 or 1, °F: 2 or 1

� for the depth output type: � input contact gauge value
for the level output type: � enter staff gauge value (generate reference to the level zero)
for the pressure output type: � input reference pressure

� Sample interval 5 s … 24 h; time delay at which the OTT CTD records measured values and stores them
(store only if sample interval = mean interval). The sample interval setting is at a fixed
time raster (e.g. sample interval of 10 minutes, time raster …, 00:10, 00:20, 00:30, …).

� Storage interval 5 s … 24 h; time delay during which the OTT CTD calculates an arithmetic mean from
the sample interval values and stores it. The storage interval must be equal to or larger
than the sample interval. The sample interval must divide exactly into the storage inter-
val (e.g. sample interval: 10 minutes; storage interval: 1 hour ➝ the OTT CTD stores an
arithmetic mean from 6 sample interval values each hour).

Meas. type/Meas.range

Pressure value – set newly
Water level – set newly
Depth to water – set newly
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Additional settings for conductivity, salinity and TDS

� the mathematical algorithm on which the calculation
of the specific conductivity at a defined reference
temperature is based. Possibilities: "Freshwater";
Saltwater"; Standard method 2510"; "ISO
7888/EN 27888"; "---" (none). For the "Standard
method 2510", the reference temperature can be
selected: 20 °C or 25 °C.

� the mathematical algorithm on which the calculation
of the salinity is based. Possibilities: "Standard
method"; "USGS 2311". With the calculation
method USGS 2311, the unit is "ppt"; with the
standard method the unit "PSU" is fixed.

� With the check box activated, the datalogger saves
the values. With the check box deactivated, the
instantaneous values are still visible in the observer
window.

Other displays in the "Basic operation" window

� Measuring range Measuring range of the pressure probe – see Fig. 1
� System length Cable length including communication unit / pressure

probe (see Fig. 1)
� Date/time Internal date/time of the OTT CTD

Detailed information on the "Advanced operation" function can be found in the
online help.

Factory settings

OTT CTD
� Number Serial number
� Name OTT CTD 1

Water level/Pressure Temperature
� Number 0001 0002
� Measurement type Water level Temperature
� Type of output Water level/depth
� Unit m °C
� Decimal places 3/2 2
� Sample interval 1 h 1 h
� Storage interval 1 h 1 h

Conductivity Salinity TDS
� Number 0004 0005 0006
� Name Specific Conductivity Salinity TDS
� Unit mS/cm PSU mg/l
� Decimal places 2
� Measuring range 0.10 …100.00 mS/cm 2 … 42.00 PSU
� Temperature compensation Fresh water
� Calculation method Standard method
� Sample interval 1 h 1 h 1h
� Storage interval 1 h 1 h 1h

� deactivatedModem/ITC
connected

Store salinity
Store TDS

Calculation method
(Salinity)

Temperature compen -
sation (Conductivity)
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7.4 Saving/loading OTT CTD configuration

The functions "Load" and "Save" are provided to archive the OTT CTD configuration
on a PC. For example, you can provide multiple OTT CTDs with the same confi -
guration.

To store a configuration
� Select the "Save configuration" function in the "File" menu (or use the button)

➝ the operating program stores the configuration under the name and number
of the OTT CTD. When changes are made to a configuration that has already
been saved, confirm the window that appears: "Warning, this configuration
name already exists! Overwrite?" with "Yes" (otherwise save the configuration
under a different station number).

To load a configuration, proceed as follows
� Select the "Load configuration" function in the "File" menu (or use the button).
� For an already opened configuration, confirm "Ignore changes?" message with

"Yes" (if necessary, save configuration previously).
� In the "Saved OTT CTD Configurations" window, select the configuration by

double-clicking it ➝ the operating program loads the configuration.

7.5 Importing/exporting an OTT CTD configuration

To transfer an OTT CTD configuration, via diskette or E-mail for example, the func-
tions Import/Export are available. Likewise, a configuration can be sent via Export
as an XML file to the OTT Hydras 3 user software. In the process, the OTT Hydras 3
user software completely applies all of the measurement stations / sensor configu-
rations to an OTT Hydras 3 operating range.

Available export/import formats

� Export ("BIN" file)
� Export to a text file
� Export for the OTT Hydras 3 user software

� Import ("BIN“ file)

The operating program stores all the necessary data of a configuration depending
on the export type in its own "*.BIN", "*.TXT" or "*.XML" file.

Export a configuration as follows ("*.BIN" file)
This export type is required to transfer an OTT CTD configuration as a "*.BIN"
file. The configuration can be read back into the OTT CTD operating program via
the "Import configuration" function.

� Select the "Export configuration" function in the "File" menu.
� In the "OTT CTD   export configuration" window, edit the file name if necessary,

select the memory location and click on "Save" ➝ the operating program
stores the configuration in a  "*.BIN" file.

Note

� The file name of the "*.BIN" file is arbitrary. The operating program suggests a
combination of station number and station name.
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To export a configuration (text file)
This export type is required to transfer an OTT CTD configuration for documentation
purposes as a "*.TXT" file. This "*.TXT" file can be opened with any text editor or
text processing program.

� Select the "Export text file" function in the "File" menu.
� In the "OTT CTD   export configuration" window, edit the file name if necessary,

select the memory location and click on Save ➝ the operating program stores
the configuration in a  "*.TXT" file.

Note

� The file name of the "*.TXT" file is arbitrary. The operating program suggests a
combination of station number and station name.

To export a configuration (OTT Hydras 3)
This export type is required to transfer an OTT CTD configuration to the OTT
Hydras 3 user software. This "*.XML“ file is read in via the Hydras 3 function
"File", "Import Station Configuration (XML)".

� Select the "Export Hydras 3 (XML)" function in the "File" menu.
� In the "OTT CTD   XML configuration" window, check the file name, select the

memory location and click on Save ➝ the operating program stores the config-
uration in a  "*.XML" file.

Note

� The file name of the "*.XML" file is arbitrary. To avoid affecting later data
transfer, it should not be changed. The operating program proposes a combi-
nation of measurement station number and measurement station name along
with the ending "*.STATION.XML".

To import a configuration
� Select the "Import Configuration" function in the "File" menu.
� In the "OTT CTD   Import Configuration" window, select the appropriate "*.BIN"

file and click on Open ➝ the operating program reads in the configuration
from the *.BIN" file. (Prior to this, save any configuration that is already open).

Note

� The standard factory configuration can be found on the CD-ROM "OTT CTD
Software".
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8 Determining and displaying instantaneous values
(observer function)

The operating program has a so-called "Observer" to enable the determination
and display of instantaneous values. The observer also makes it possible to enter
a manually determined measurement, e.g. contact gauge value, into the datalog-
ger (observer registration).

Various options can be set concerning the observer:

� Selection possibility in the start window of the OTT CTD operating program:
– direct and sole call of the observer, or
– calling a window to set the operating parameters 

� Effect of an optionally entered observer registration (pressure sensor):
– observer registration is used solely as a check value, or
– observer registration leads to a change in the value (setting offset)

� Suppress the display of the instantaneous value (pressure sensor) prior to the
input of an observer registration

Set the observer options as follows

� Start the OTT CTD operating program.
� Select the "Options" function in the "File" menu. (If the option dialog cannot

be called, a password must first be entered. See Chapter 12)
� Activate the check box(es) for the observer option(s) required:

– Only observer mode
– Do not calculate manual input value with scaling

(only check value/no value change)
– Suppress previous instantaneous value display

� Click on the "OK" button.

The combination of "Only observer mode" with a password protects the operating
program against unauthorized input of operating parameters.

The "Advanced operation ..." option displays an additional button in the window
for setting the operating parameters.

Fig. 14: Input window to establish
options for the observer.

For further information on protecting
the OTT CTD operating program with

a password, see Chapter 12.
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Call the observer function as follows

� Start the OTT CTD operating program.
� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Depending on the option set: In the start window of the OTT CTD operating

program, either select "View Instantaneous Values" or "Setup device" and in
the subsequent window select the "View Instantaneous Values" function in the
"OTT CTD" menu ➝ the OTT CTD starts an instantaneous value measurement
and the "Observer" window opens:

� If necessary: Input observer registration into the entry field of the pressure
 sensor and click on the "Save" button.

� If necessary: Start new instantaneous value measurement: click on the "Refresh"
button ("� Automatic refresh" automatically starts an instantaneous value
 measurement every 5 seconds).

� End the observer function: click on the "Exit" button and close the OTT CTD
operating program.

Notes

� The OTT CTD stores each time the observer function is called in an info channel
with the date and time of day. After reading in and accepting into the OTT
Hydras 3 user software, this information can be displayed in the evaluation
window of a sensor using the "Info Data | Station | Displays" function
("Observer registration general"). They are likewise visible via the "View data",
"Table" function of the OTT CTD operating program.

� If the "Do not calculate manual input value with scaling" check box in the
"Options" window is activated, the OTT CTD also stores the input check value,
as well as the current instantaneous value. After reading in and accepting into
the OTT Hydras 3 user software, this information can be displayed in the evalu-
ation window of a sensor using the "Info Data" | "Sensor" | "Displays" func-
tion ("Observer registration with check value"). They are likewise visible via the
"View data", "Table" function of the OTT CTD operating program.

Fig. 15: Display/input window "OTT CTD
operating program – observer".

The window displays the current instanta-
neous value for all measurements.

Furthermore, the window displays the
window sensor number/name, the

current battery voltage, the amount
of power used from the batteries up

to now, and the date and time.
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9 Reading out data

Read out data as follows (on location)

� Start the OTT CTD operating program.
� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Press the "Download Data" button in the start window ➝ the operating pro-

gram shows the available sensors and the possible read period. If these para-
meters are not visible: press the "Connect" button.

� Select the required sensors or "All sensors".
� Select the required read period or "All".
� Click the "Read out" button ➝ the operating program copies the measured

values from the OTT CTD to the PC. The data are then available in the program
directory of the operating program.

� If necessary: Display measurements via the "View/export data" function
and/or export to a software application.

� Click on the "Back" button.

Alternative possibilities for readouts:

� With the OTT CTD operating program and an OTT ITC
In conjunction with a modem and the OTT ITC intelligent top cap, it is also
possible to establish a remote communication link. See online help.

� With the PC application "OTT Hydras 3 (Basic)"
(Select the required station in the tree display by double-clicking, make the
required settings in the subsequent window and click on the "Start" button). For
further information, see the online help for the OTT Hydras 3 (Basic) software.

� With a Pocket PC and the "OTT Hydras 3 Pocket" software.
For further information, see the OTT Hydras 3 Pocket operating instructions.

Fig. 16: Read out data.
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10 Exporting data

After reading out into the OTT CTD operating program, the measurement and
information data can be found in the "RAWDATA" sub-directory of the program
directory (standard setting: "C:\Program files\OTT\OrpheusMini_CTD\RAWDATA").
To transfer to an external application, you can export the data in various formats:

� CSV – structured text file in CSV format (Comma-Separated Values)
� Excel – Microsoft Excel spreadsheet program
� OTT Hydras 3 – raw data format for the OTT Hydras 3 user software
� OTT MIS – OTT-specific file format for automatically importing into the

measurement database of the OTT Hydras 3 user software

Using the "Export Options" dialog window, you can set the location for saving
and, with CSV format, various export parameters also. The data remain in the
sub-directory after export. If necessary, you can specifically delete them.

Info data can only be exported to the OTT Hydras 3 user software.

How to export the data

Step 1 – Make export settings:

� Click on the "View/export data" button in the start window.
� In the "View/export data" window, click on the "Export Options" button (see

Figure 17).
� Enter the path to the storage location of the required export format (standard

setting: "C:\Program files\OTT\OrpheusMini_CTD\Export"). No path can be
set for the "Excel" format: the operating program automatically opens Microsoft
Excel during the export and displays the data in a new worksheet. In format
"Hydras 3" the "?" button can be used to automatically find the installation
directory of OTT Hydras 3.

� In format "CSV": set the "Field separator", "Dec. separator", "Date format"
and "Time format". For the date and time formats, the typical windows place-
holders can be used.

Step 2 – Exporting data:

� Select the required station/sensor in the list (multiple selection possible).
� Click on the "Export ..." button.
� Confirm message about successful export with "OK".
� If necessary, delete the exported data: click on the "Delete" button.
� Confirm the message with "Yes".
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11 Displaying data

After reading out into the OTT CTD operating program, the measurement and
information data can be found in the the "RAWDATA" sub-directory of the pro-
gram directory (standard setting: "C:\Program
files\OTT\OrpheusMini_CTD\RAWDATA"). For an initial check, you can display
the data graphically and numerically and print them out if necessary.

How to display the data graphically

� Click on the "View/export data" button in the start window.
� Select the required station/sensor in the list (multiple selection possible – info

data can only be displayed numerically).
� Click on the "Graphic" button ➝ the operating program displays the window

with the graphical view of the selected data;
– Show ruler: function key "F10"; Move ruler: arrow keys ← →;
– Zoom in: draw the required area by dragging with the mouse;
– Zoom out: function key "F12".

� Print graphic: Select the "Print" function in the "File" menu.
� Close graphic: Select the "Exit" function in the "File" menu (or �).

How to display the data numerically

� Click on the "View/export data" button in the start window.
� Select the required station/sensor in the list (multiple selection possible).
� Click on the "Table" button ➝ the operating program displays the window with

the numerical view of the data in the OTT data protocol;
– Only display measured values: select "Values";
– Highlight special areas (only with information data): Select "Observer &

operation", "Alarm & limit", "Communication & error", "Error & service log".
� Print numerical display: Select the "Print" function in the "File" menu.
� Close numerical display: Select the "Exit" button (or �).

How to delete the data

� Select the required station/sensor in the list (multiple selection possible).
� Click on the "Delete" button.
� Confirm the confirmation message with "OK".

Fig. 17: Display/export data.
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12 Protecting the OTT CTD and OTT CTD operating
program with a password

To prevent any unauthorized input of operating parameters, you can

� protect the OTT CTD and
� OTT CTD operating program

with a password for each.

How to protect the OTT CTD operating program with a password

� Start the OTT CTD operating program.
� Select the "Options" function in the "File" menu.
� Enter a maximum eight-digit password in the "Password" input field. Permitted

characters 0 … 9, A … Z. (This password is independent of the OTT CTD
password.)

� Activate check box "Only observer mode".
� Click on the "OK" button.
� Close the operating program ➝ the operating program is now protected: the

"Setup device" button in the start window is no longer visible.

Caution:

� If the password is lost, you can no longer configure or parameterize the
OTT CTD on this PC. If this occurs, contact the OTT HydroService.

� The password assigned here only pertains to the OTT CTD operating program
installed on this PC. The OTT CTD itself is not protected by this!

How to release a password-protected OTT CTD operating program

� Start the OTT CTD operating program.
� Select the "Options" function in the "File" menu.
� Enter the password in the "OTT CTD" window.

� Click on the "OK" button.
� Deactivate the "Only observer mode" check box.
� Remove the entry in the "Password" field.
� Click on the "OK" button ➝ the operating program is released.

Fig. 18: OTT CTD operating program
release – password input window.

Fig. 17: Protecting the OTT CTD operating
program with a password – input window

to establish a password.

A password-protected OTT CTD operating
program only makes sense if the operating
program starts in observer mode (activate

check box "Only observer mode")!
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How to protect the OTT CTD with a password:

� Start the OTT CTD operating program.
� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Click on the "Setup device" button in the start window.
� Click on the "Advanced operation …" button.

(Button not visible? ➝ activate the check box "Advanced operation ..." in the
"Options" function in the "File" menu.)

� Click on the "Read" button.
� In the tree view, select "Communication Interface".
� Enter a maximum eight-digit password in the "Password" input field. Permitted

characters 0 … 9, A … Z. (This password is independent of the OTT CTD
operating program password.)

� Click on the "Program" button.
� Warning: "Reset OTT CTD and delete data memory additionally?" Confirm

with "No" ➝ the OTT CTD is now protected against unauthorized operation.

Caution: If the password is lost, you can no longer configure or parameterize
the OTT CTD. If this occurs, contact the OTT HydroService.

How to release a password-protected OTT CTD

� Start the OTT CTD operating program.
� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Click on the "Setup device" button in the start window.
� Select the "Enter password" function in the "OTT CTD" menu.
� Enter password.
� Click on the "OK" button.
� Confirm message "Password accepted! OTT CTD unlocked" with "OK".
� Click on the "Read" button.➝ the operating program reads in the current

OTT CTD operating parameters.

Fig. 20: OTT CTD release – 
password input window.

Fig. 19: Protect the OTT CTD
with a password – input window

to establish a password.
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13 Date and time settings

The internal clock of the OTT CTD is a high-accuracy, realtime clock. It runs as
soon as batteries are installed in the OTT CTD. After the batteries are removed,
the clock will continue to run for approximately 10 more minutes. For longer periods
of power interruption, the OTT CTD loses the date and time. When batteries are
re-installed, the OTT CTD assumes the date and time of the last stored measured
value, with one minute added to the stored time. The date and time are set using
the OTT CTD operating program.

Set the date and time as follows

� Start the OTT CTD operating program.
� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Click on the "Setup device" button in the start window.
� Select the "Date/time" function in the "OTT CTD" menu ➝ the operating

program reads the date and time out from the OTT CTD and opens the
"OTT CTD – date/time" window.

� If necessary: click on the "Refresh" button ➝ the OTT CTD reads out the date
and time again.

� If necessary: set the values required in the two input fields.
� Click on the "Set date/time" button ➝ the operating program sets the OTT CTD

date and time to the PC time/date or the values set.

Caution: If the PC is on summer time mode (ID: PC (DST)), the operating pro-
gram automatically uses the standard time without summer correction (winter
time). To receive continuous time series, it is a good idea not to use summer time
in the OTT CTD.
In connection with a GPRS remote data transfer and the "Time synchronization"
function, it is necessary to refer the time to UTC/GMT and to set the time zone of
the station in the "Advanced operation" | "OTT CTD" window. (see online help)

� Click on the "Exit" button. The "OTT CTD – date/time" window closes.

Fig. 21: OTT CTD date and time settings.
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14 Deleting data memory

Caution: The stored measured values in the OTT CTD are permanently lost when
deleting the data memory! If necessary read out measured values before deleting!

Delete the data memory as follows

� Start the OTT CTD operating program.
� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Click on the "Setup device" button in the start window.
� Select the "Delete data memory" function in the "OTT CTD" menu.
� Acknowledge the warning "Are you sure you want to delete data memory?"

with "Yes "➝ the operating program deletes the complete data memory of the
OTT CTD (all measurement channels including the info channel). Afterwards the
OTT CTD determines and saves the water level, the water temperature and the
specific conductivity again in accordance with the sample interval set.

15 Update OTT CTD firmware

If necessary, you have the possibility to update the OTT CTD firmware (operating
system). This makes sense if, for example, devices delivered at different times are
to receive the same operating system version. Updating is carried out via the
OTT CTD operating program. According to availability, an updated version of the
OTT CTD firmware can be found on the internet site "www.ott.com".

How to update the firmware 

� Download the new version of the firmware (file: e.g. "OTT_CTD_V1.00.3.bin")
from the Internet site.

� Copy the file "OTT_CTD_VX.XX.X.bin" to the directory in which the OTT CTD
operating program is located.

� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Select the "Firmware update" function in the "OTT CTD" menu.
� Confirm message with "Yes" ➝ the operating program copies the new

firmware to the OTT CTD. Afterwards the OTT CTD determines and saves the
water level, the water temperature and the specific conductivity again in accor-
dance with the sample interval set.
Caution: During the update, avoid breaking the communication link (e.g by
accidentally removing the OTT DuoLink from the infrared interface of the
OTT CTD.) If the communication link is broken, the firmware will no longer run!
In the same way, no other programs should be started or files opened during
the copying process!

Notes

� If there are multiple ".bin" files in the directory, you will have to manually select
the required file.

� The measurements saved in the OTT CTD are not lost after an update.
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16 Maintenance work

16.1 Cleaning the pressure probe

Recommended interval: every 12 months
with difficult local measuring conditions (heavy deposits):
as required every 4 to 6 months.
(Measurements that are inaccurate or not plausible
indicate a soiled pressure sensor.)

How to clean the pressure probe
� Open the top cap/observation well cover.
� Completely remove the OTT CTD from the observation well.
� Remove the black protective cap.
� Clean the pressure sensor carefully using a brush and water.

Clean graphite electrodes and temperature sensors for the conductivity sensor
with  soapy water and cotton buds. Lime scale deposits can be removed using
a common household scale remover. Make sure to follow the use and safety
instructions of the scale remover!

� Rinse the pressure probe thoroughly with clear water.
� Reattach the black protective cap.
� Recommendation: Calibrate the conductivity sensor (see Chapter 16.4).
� Reinstall OTT CTD (see Chapter 6).
� Determine current reference value with a contact gauge and enter it 

(see Chapter 7.3 or 8).
� Close the top cap/observation well cover.

Fig. 22: Cleaning the pressure probe.

Black
protective cap

Pressure Sensor

Pressure probe with
conductivity sensor

and datalogger

Conductivity
sensor

Graphite
electrodes

Temperature sensor
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16.2 Replacing the desiccant capsules

Recommended interval: Depending on the level of air humidity at the station
every 12 to 24 months and when replacing the batteries.

How to replace the desiccant capsules
� Open the top cap/observation well cover.
� Pull the communication unit approximately 80 cm out of the observation well

and hold (a second person would be useful).
� Slide the pipe casing of the communication unit approximately 30 cm in the

direction of the pressure probe cable. (The rubber stop located on the pressure
probe cable (see Fig. 1) prevents the pipe casing from falling.)

� Remove used desiccant capsules.
� Install 2 new desiccant capsules.
� Slide the pipe casing of the communication unit back on until it stops.
� Slowly and carefully replace the communication unit into the observation well.
� Close the top cap/observation well cover.

16.3 Checking/replacing the batteries

See Chapter 5

16.4 Calibrating the conductivity sensor

The goal of the calibration is to determine the so-called "cell constant" for the con-
ductivity sensor. To do this, it is necessary to check the zero point and to carry out
a conductivity measurement with a standardized calibration solution.

The cell constant – as well as the unchanging geometric measurements, the mate -
rials used and the construction of the conductivity sensor – takes account of the
aging process of the electrodes.

Recommended interval: every 12 months (after every cleaning)
with difficult local measuring conditions (heavy deposits):
as required every 4 to 6 months

Required accessories: standardized calibration solution, calibration container
(see Chapter 2, "Order numbers")

Fig. 23: Replacing the desiccant capsules

+

Pipe casing
Communication unit +

+

Dessicant capsules

Backstop
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Caution: For an optimum calibration process, the OTT CTD and the calibration
solution must be at the surrounding temperature!

How to calibrate the conductivity sensor
� Carefully clean the pressure probe and dry well (see Chapter 16.1).
� Start the OTT CTD operating program.
� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Press the "Setup device" button. (Button not visible? ➝ deactivate the "Only

observer mode" check box in the "Options" function in the "File" menu and
restart the operating program.)

� Select the "Calibrate conductivity sensor" function in the "OTT CTD" menu.
� Press the "Start zero point test" button. The operating program starts an instan-

taneous value measurement and updates this every 5 to 6 seconds. If the mea-
surement result displayed (blue triangle) is not in the green area ➝ clean the
conductivity sensor again and dry it well.

� Press the "End zero point test" button.
� Select the calibration solution used. Alternatively, select "Other ..." and enter

the appropriate conductivity value.
� Add the calibration solution to the calibration container (filling height approx. 3/4).
� Place the OTT CTD into the calibration container (screw-on cover in place) and

tighten the screw-on cover by hand. Caution: There must not be any air bub-
bles in the slot of the conductivity sensor! If necessary, lightly shake the calibra-
tion container.

� Press the "Start calibration" button. The operating program starts the instan -
taneous value measurement again and continuously updates it.

� Wait until the values for conductivity and temperature do not change for sever-
al updates. The operating program displays the current and newly calculated
cell constant. Caution: Temperature values shown in red ➝ the conductivity
sensor is not at the temperature of the calibration solution! New cell constant
shown in red ➝ the cell constant lies outside the valid range.

� Press the "End calibration" button.
� Confirm the resulting question: "Save new cell constant?":

– cell constant is within the tolerance range ➝ "No"
(conductivity value is in the green area)

– Cell constant is outside the tolerance range and within the valid range ➝
"Yes" (conductivity value is in red area + current cell constant is shown in
black)

If the cell constant is outside the valid range ➝ error message.
� Close the OTT CTD operating program.
� Rinse the pressure probe thoroughly with clear water!
� Reinstall OTT CTD (see Chapter 6).
� Determine current reference value with a contact gauge and enter it 

(see Chapter 7.2 or 8).
� Close the top cap/observation well cover.
� Dispose of the used calibration solution!

Notes

� Only use the calibration solution once!
� Always store the calibration solution in a closed container! (The carbon dioxide

in the surrounding air and evaporation can change the conductivity value.)
� Avoid water entering the calibration solution! Always dry the calibration con-

tainer carefully after calibration.
� Calibration solution can be disposed of in the normal public sewer system!
� The OTT CTD saves the last three cell constants in a history (see "Advanced

operation ...", channel "Conductivity").
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17 Error messages

If erroneous measurements occur, or if an operating fault occurs, the OTT CTD
stores one of the following error messages in the data memory instead of a
measured value.

� Err 00 internal error (automated measurement)
� Err 01 internal error (AD conversion error)
� Err 03 Exceeded measuring range
� Err 05 An input value required for the measurement calculation is not in the

valid range (example: the temperature value needed for the calculation
of the salinity (standard method) is outside of the valid range :
0 °C ≤ t ≤ 35.0 °C)

� Err 06 An input value for the measurement calculation is missing
� Err 10 Measured value (still) not recorded

Internal errors indicate a device defect if they occur repeatedly.

18 Troubleshooting/fault correction

No communication possible (operating program/OTT CTD) 

� Password programmed?
➝ input correct password.

� Batteries installed?
➝ install batteries.

� Battery voltage lower than about 3.6 V?
➝ insert new batteries.

� Battery contacts corroded?
➝ carefully clean the battery contacts.

� Pressure probe cable damaged?
➝ send OTT CTD to the factory for repair.

� Infrared interface dirty?
➝ clean the infrared interface carefully with a damp, soft cloth.

� Setting measured value not possible?
➝ scaling module missing. Check configuration*

(for advanced operation, see online help).

Communication starts and then breaks off

� Battery voltage lower than about 3.6 V?
➝ insert new batteries.

� Distance from readout unit/IrDA interface to OTT CTD too small/large?
➝ maintain correct distance (see Chapter 7.2).

Erroneous measured values

� Temperature values erroneous
➝ check configuration* (for advanced operation, see online help).

� Pressure sensor values erroneous
➝ check configuration* (for advanced operation, see online help).
➝ check the pressure compensation capillary in the communication unit

(blocked?). If necessary, clean.
➝ check pressure sensor for contamination. Clean if necessary.

* The standard factory configuration is located on the "OTT CTD software" CD-ROM .



� Conductivity values erroneous
➝ check configuration* (for advanced operation, see online help).
➝ check conductivity sensor for contamination. If necessary, clean and then

recalibrate
� Calculated salinity values erroneous (Err 05)

➝ check configuration* (for advanced operation, see online help).
➝ input value is outside valid range:

– salinity by standard method
1.0 °C ≤ t ≤ 35.0 °C for salinity 2.0 PSU ≤ salinity ≤ 42.0 PSU

– Salinity by "USGS 2311" method
0 °C ≤ t ≤ 30.0 °C for salinity 2.0 ppt ≤ salinity ≤ 60.0 ppt

� Observer does not display calculated salinity values
➝ values lie outside the valid range:

– salinity according to standard method
2.0 PSU ≤ salinity ≤ 42.0 PSU

– salinity according to "USGS 2311" method
2.0 ppt ≤ salinity ≤ 60.0 ppt

No measured values in database

� Configuration incorrect?
➝ check configuration* (for advanced operation, see online help).

� Battery voltage lower than about 3.6 V?
➝ insert new batteries.

* The standard factory configuration is located on the "OTT CTD software" CD-ROM .
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19 Repair

� With a problem with the device, use Chapter 18, Troubleshooting/fault correction
to see if you can resolve the problem yourself.

� In case of device defects, please contact the repair center of OTT:

OTT MESSTECHNIK GmbH & Co. KG
Repaircenter
Ludwigstraße 16
87437 Kempten · Germany
Telephone +49 831 5617-433
Fax +49 831 5617-439
repair@ott.com

Caution: Only have a defective OTT CTD checked and repaired by the OTT
repair center. Under no circumstances carry out any repairs yourself.
Any repairs or attempted repairs carried out by the customer will result
in the loss of any guarantee rights.

20 Notes about the disposal of old units

Within the member countries of the European Union
In accordance with the European Union guideline 2002/96/EC, OTT takes back
old devices within the member countries of the European Union and disposes of
them in an appropriate way. The devices concerned by this are marked with the
symbol shown aside.

� For further information on the return procedure, please contact your local sales
contact. You will find the addresses of all sales partners in the internet on
"www.ott.com". Please take into consideration also the national implementation
of the EU guideline 2002/96/EC of your country.

For all other countries
� Dispose of the OTT CTD properly after taking out of service.
� Observe the regulations valid in your country for the disposal of electronic

devices.
� Never put the OTT CTD into the normal household waste.

Materials used
See Chapter 21, Technical data
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21 Technical data

Water level
Measuring range 0 …  4 m water column (0 ... 0.4 bar) 

0 … 10 m water column (0 ... 1 bar) 
0 … 20 m water column (0 ... 2 bar) 
0 … 40 m water column (0 ... 4 bar)
0 … 100 m water column (0 ... 10 bar)

Resolution* 0.001 m; 0.1 cm; 0.01 ft; 0.1 inch
0.0001 bar; 0.001 psi

Accuracy (linearity + hysteresis) ± 0.05 % full scale 
Long-term stability (linearity + hysteresis) ± 0.1 %/a full scale 
0-Point ± 0.1 % full scale 
Overload safe without permanent mechanical damage

0 ... 0.4 bar 4 bar
0 ... 1 bar 10 bar
0 ... 2 bar 15 bar
0 ... 4 bar 25 bar
0 ... 10 bar 40 bar

Units m, cm, ft, inch, bar, psi
Pressure sensor ceramic; temperature-compensated
Temperature-compensated operating range –5 °C … +45 °C (ice free)

Temperature
Measuring range –25 °C … +70 °C
Resolution 0.01 °C
Accuracy ± 0.1 °C
Units °C · °F

Conductivity
Measuring ranges 0.001 … 2.000 mS/cm

0.10 … 100.00 mS/cm
Resolution

0.001 …2.000 mS/cm 0.001 mS/cm
0.10 …100.00 mS/cm 0.01 mS/cm

Accuracy
0.001 …2.000 mS/cm ±0.5 % of measured value (at least ±0.001 mS/cm)
0.10 …100.00 mS/cm ±1.5 % of measured value (at least ±0.01 mS/cm)

Units
0.001 …2.000 mS/cm mS/cm · μS/cm
0.10 …100.00 mS/cm mS/cm

Power supply 3 x 1.5 V batteries (LR6 · AA, FR6 · AA)
alkaline or lithium design
(LiFeS; Energizer L91)

Current consumption 
active, measurement 55 mA
active, communication 65 mA
passive 23 μA

Lifetime (1 h sample interval; 50 m system length; w/o ITC)
with lithium batteries at least 5 years
with alkaline batteries at least 1.5 years (high quality battery types)

Clock
Design real time clock
Accuracy ±1 minute/month (at +25 °C)
Buffer period for battery replacement approx. 10 minutes

Interface Infrared (IrDA)

Storage temperature –40 °C … +85 °C

* at a value range of ±32.750 m; ±3275.0 cm; ±327.50 ft; ±3275.0 inch; ±3.2750 bar; ±32.750 psi
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Data memory
Measurement memory 4 MB
Number of measurements approx. 500,000
Number of logical channels 9 + 1 Info channel
Physical channels (input signals) Water level/pressure

Temperature
Conductivity
Supply voltage

Sample interval 5 seconds … 24 hours
Storage interval (mean interval) 5 seconds … 24 hours

Individually configurable functions – Simple or advanced operation
– 5 extended sample intervals with start/stop time indication, support of

pump tests
– Selection of units
– Pressure/level measurement or depth measurement
– With consideration of the local gravitational acceleration
– Compensate for water density using salinity and temperature
– Temperature compensation for conductivity. Options: Freshwater;

Saltwater; Standard method 2510 (reference temperature: 25 °C or
20 °C); ISO 7888 / EN 27888; none

– Salinity (standard method or USGS 2311)
– Display of instantaneous values with level monitoring function
– Password protection
– Measured value processing: Calculation of mean; delta storage; scal-

ing function; extreme value storage; limit control of the sample interval
– Virtual sensor/virtual terminal
– Together with OTT ITC: alarm management; remote data transfer

Mechanical Data
Can be installed in observation wells 

– with adapter ring 1"
– with adapter plates for top caps 2", 3", 4", (4,5"), 5", 6"

with recess (OTT, HT)
– with suspension brackets for top caps ≥ 2"

without recess/universal installation
Dimensions

Communication unit L x Ø 400 mm x 22 mm
Pressure probe (L x Ø) 317 mm x 22 mm
System length (cable length including 1,5 … 200 m ±1 % ±5 cm
communication unit/pressure probe)

Weight
communication unit (incl. batteries) approx. 0.410 kg
pressure probe approx. 0.430 kg
Pressure probe cable approx. 0.082 kg/m

Material 
Pressure probe housing ABS, POM, stainless steel 1.4539 (904 L)
Cable jacket PUR
Communication unit ABS, PC, stainless steel 1.4539 (904 L)/ 1.4462 (UNS S31803)

Protection class
Communication unit IP 67 (submersion depth max. 2 m; submersion duration max. 24 h)
Pressure probe IP 68 

EMC limits
– Resistance to electrostatic discharge (ESD) complies with EN 61000-4-2 (4 kV contact discharge)
– Resistance to electromagnetic fields complies with EN 61000-4-3 (10 V/m)
– Resistance to transient fields (burst) complies with EN 61000-4-4 (2 kV)
– Resistance to surge complies with EN 61000-4-5 (4 kV)
– Resistance to HF, asymmetric complies with EN 61000-4-6 (10 V)
– Line-borne and radiated interference complies with EN 55022 Class B (30 … 1000 MHz)
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Appendix A – Declaration of conformity for OTT CTD
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